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Preface 

Tt,e Apple Macintosh is more than just another computer. It was created out of a 
genuine need -a need for simpler and easier-to-understand computers. 

It all started in the late 1970s, when Apple engineers began examining the then 
current crop of personal computers. What they found didn't please them. Imme
diately, they saw three inherent limitations in all computers. 

First, to run the typical personal computer, the user has to learn a complex web 
of commands and instructions, both for the machine itself and for the programs 
that are run on it. 

For instance, to delete a line of text in WordStar, a popular word processing 
program that's available for a variety of ~~older-fashioned" computers, it's 
necessary to press certain keys in a strictly prescribed sequence. The sequence 
follows no logical order, and there's no way to retrieve accidentally lost text should 
you take out too much. 

Cutting a line of text is but one of over a hundred different instructions you must 
learn in order to use WordStar-after you've learned how to get WordStar working 
with your particular computer. This commitment to learning is more than many 
potential computer users are willing to invest. 

Second, for many, computers seem impossibly hard to comprehend, and often 
their first encounter with a personal computer tends to reinforce that J?erception. 
So, it's easy to see why potential computer owners continue to be afraid of the 
"technology of the 80s" (and why the use of computers isn't more widespread). 
After all, who wants to try to learn about computers only to give up, feeling stupid 
for failing to grasp the simplest concepts? 

Third, most would-be buyers have correctly perceived that it takes a con
siderable investment of time to learn and master the typical computer system. In 
fact, recent studies have shown that it takes from 20 to 30 hours to learn the basics 
(the basics, mind you) about the average personal computer. And from 20 to 30 
hours to learn each software package that's run on it. 

For someone who buys a computer to write and balance the books for a small 
business, for example, the investment in learning time could be as much as 100 
hours-almost two full weeks! 
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APPLE'S SOLUTION 

The first task for Apple was to rethink the role that the computer plays in the 
life of the computer user. The turning point came when the people at Apple con
ceived of computers as nothing more than amplifiers: amplifiers for the mind -to 
stretch insights into reality. From that point on, in the minds of the Apple engineers, 
the user came first; the technology within the inanimate body of the computer 
second. 

Apple's first attempt at an easy-to-use computer, after three years and more 
than $50 million in research and development, wasn't the Mac. It was the Lisa. 

As Apple envisioned, the Lisa made things much easier. The Lisa and its special 
programs were designed to be intuitive, not complex. What's more, all the Lisa 
programs were designed around one model. So, with a handle on one Lisa pro
gram, it was a snap to learn to use all the others. 

And instead of 20 or 30 hours to learn the basics about the Lisa, it took less than 
one. For a Lisa program, depending on its complexity, it took from one to four 
hours. With the Lisa, the simple job of learning how to put a business's books on 
computer was reduced from 100 hours to less than five. 

Alas, though the Lisa was easy to use, its original $10,000 price wasn't easy to 
swallow. Though that $10,000 included a series of business programs, and good 
ones at that, the steep price proved much too high for most buyers. 

A year later, in january, 1984, Apple unveiled the Mac. In reality, the Mac is a 
slightly trimmed version of the Lisa, with the same easy-to-learn and easy-to-use 
features. Though the Mac shares much of the Lisa's personality and power, it 
doesn't share its high price. When the Mac was unveiled, it was priced at a quarter 
of the Lisa's $10,000. (Since the Lisa's initial showing, its price has been lowered, 
too, and it's been redesigned. But the Mac continues to be the less expensive of the 
two.) 

While the Mac may be a redressed and toned-down version of the Lisa, it has a 
distinct personality all its own. Few personal computers can claim the versatility, 
speed, and power of the Apple Macintosh. And fewer still are fun to use. In fact, 
once you sit down behind a Mac, you'll be enjoying yourself so much, you'll 
wonder why Apple didn't come out with this ultimate adult toy sooner. 

See for yourself. Turn the page and begin learning all about the Apple 
Macintosh. Happy computing! 

Leslie 5. Smith 
San Diego, Calif. 1984 



Introduction 

Welcome. 
Welcome to the exciting world of personal computers. Welcome to the charged 

excitement of the new and growing computing industry. Welcome to the gateway to 
the future. But most importantly, welcome to the Apple Macintosh. 

You hold in your hand a book that can unlock the power and potential within 
the Macintosh, one of the newest personal computers and one of the most revolu
tionary to come along in years. Use this book well: Read it to learn how to use the 
Macintosh in your everyday endeavors, and then return to it for timely reference as 
you grow with the Mac. . 

From the beginning, the Macintosh (also playfully known as "Mac") was 
designed to be easy to use, to be a computer that works just ~swell for the novice 
as for the seasoned pro. The Mac doesn't care how much you know about 
computers-all the techno-babble about bits and bytes is, for the most part, unim
portant. After all, you don't need to know how the internal combustion engine 
works to drive a car; likewise, there's no need to know what happens to informa
tion inside a computer to use a Macintosh. 

With this in mind, we've written MacGuide as an easy-to-follow and completely 
nontechnical guide to using the Apple Macintosh. To help you better understand the 
Mac and get the most out of it, there are plenty of clear and concise illustrations~-. as 
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well as a wide assortment of "Mac Tips" scattered throughout the chapters. Refer to 
the illustrations to better visualize how the Mac does its magic, to the MacTips to 
learn how to better use the Macintosh. 

I 
Maclip 1-1 

This is a sample MacTip. The purpose of a MacTip is 
to provide supplemental or timely information. 

What's a Macintosh? Good question. It's just one of many that are answered in this 
book. Others are how to get the Macintosh up and running, how to use the Macin
tosh, and how to apply two popular Mac programs-MacWrite and MacPaint-to 
your daily routine. Here's a brief rundown of what you'll find in this book: 

In Chapter 1, "The Magic of the Macintosh," you'll be introduced to what 
makes up the basic Mac and the unique way Mac goes about its job. The Mac isn't 
a typical computer. This chapter explains how and why. 

So much for quick introductions; it's time to get down to business. That's the 
purpose of "Bringing Home the Macintosh," Chapter 2. Here you'll learn about 
how to hook up the Mac and how to turn it on and make sure everything works. In 
addition, the chapter provides an introduction to the Mac's electronic desktop as 
well as the Mac's Finder, the built-in program that makes using the Mac so easy. 

A mechnical device called a mouse is used as one of the communications links 
between you and the Mac. Chapter 3, "Mousing Around," goes into great detail on 
using this strange. contraption. Read this chapter carefully. The Mac relies on its 
mouse heavilyv and you'll need to be completely familiar with it to do anything 
constructive. 

Not content with just a mouse, the Mac uses other and even more bizarre 
elements-thumbnail sketches called icons and portholes in the screen called win
dows. Both are the subject of Chapter 4, "About Icons and Windows." 

Chapter 5, "Advanced Topics: More About Icons, Windows, and Commands" 
pic;ks up where Chapter 4 leaves off and provides lucid detail on getting the most 
out of windows and icons and using the Mac's readily accessible commands. 

Finishing off the in-depth discussion of using the Macintosh is Chapter 6, 
"Desktop Accessories and How to Use Them." The Mac is shipped from Apple 
with several handy tools-qesktop accessories-to make computing even easier. 
Two such accessories are the four<function calculator and the eight-page note pad. 
This chapter details all of the accessories currently available-what they are and 
how to use them. 

Computers are useless without good programs to run on them (programs are 
otherwise known as· software). The Mac has plenty to choose from. One program is 
MacPaint, offered as an option by Apple. Chapter 7, "An Introduction to 
MacPaint," reveals how to use this amazing program to create computer-assisted 
drawings. 

If you think the Mac works well with pictures, wait until you read Chapter 8, 
11An Introduction to MacWrite." Words are second nature to the Mac, and Apple's 
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optional word processing program, MacWrite, is one of the best ways to get your 
thoughts down on paper. 

Chapter 9, "An Introduction to Multiplan," shows you what the Macintosh can 
do in the way of handling spreadsheet functions. Read this chapter to get started 
organizing and manipulating numbers. 

Though this book is aimed at the nontechnical Mac user, some readers may 
want the inside scoop on how the Macintosh performs its magic. In Chapter 10, 
"The Macintosh Unveiled," these readers get their wish. The chapter introduces 
the Mac's 16/32-bit Motorola MC68000 microprocessor, its internal memory, and 
more. If this kind of thing bores you, skip it. 

For a complete and easy-to-follow rundown of the Macintosh, see Appendix A. 
"Macintosh Quick Reference Guide." Refer to the reference guide whenever you 
need to refresh your memory. It's organized in a logical, functional order, to'help 
you find what you want fast. 

Appendix B, "Alert Boxes," includes pictures and explanations of some of the 
more cryptic warnings the Mac provides when you do (or are about to do) 
something with potentially undesirable consequences. 

The Macintosh can produce, on screen and on paper, many different type 
styles (called fonts). The currently available fonts are listed in Appendix C, "Fonts." 

Appendix D, "Macintosh Specifications," offers a quick glimpse of the Mac, in
cluding its size, weight, and electrical specifications. . 

The Macintosh is probably the least technical computer you can buy. Still,· 
there may be words associated with the Mac that seem alien to you. The 
"Glossary," located at the end of the book, lists all the words you'll need to know 
in your endeavors with the Macintosh. 



CHAPTER 1 

The Magic of the Macintosh 

lhere it sits, an Apple Macintosh, resting peacefully on a desk in front of you. You 
pull out a ruler to measure its small and unimposing body: Only 13 by 9 by 11 in
ches. Disappointing, right? After all, how powerful could this little computer be? It's 
no larger than a toaster oven. Just wait! 

Turn the Macintosh on, and you're suddenly swept into a completely new 
world of computing. The Mac offers a whole new way of using a computer. Instead 
of sitting behind a bland video screen, communicating with a mindless machine by 
way of a string of confusing code words, you interact with the Mac in English, using 
easy-to-understand symbols and plain and simple commands. 

This chapter introduces the Mac's component pieces, its unique brand of 
visual ''what you see is what you get" computing, and its electronic desktop. You'll 
also see how using a Macintosh can be fun, not frustrating. 

MAC: OUT OF THE BOX 

Pull a Mac out of its shipping box and you'll find three major components, 
shown in Figure 1-1. 

The first and most obvious is the main cabinet. It houses all the Mac's 
computing electronics, connectors to attach the Mac to various accessories 

5 
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Fig. 1-1. The three major components of the Macintosh: main cabinet, keyboard, and mouse. 

(a lso called peripherals, or add-ons), and the 9-inch video display tube, that shows 
sharp, clear black and white text and graphics. 

Also in the main cabinet is the Mac's single disk drive mechanism (another disk 
drive can be attached to the Mac via one of the connectors on the back). The disk 
drive (Figure 1-2), stores and plays back programs and data on small magnetic 
disks. 

Unlike many other personal computers that use disks 5\4 inches in diameter, 
the Macintosh uses disks that are 3Y2 inches in size. The disk, housed wi thin a pro
tective case (Figure 1-3), is coated with a magnetic film, which captures the elec
trical pulses that combine to create the programs and data the Macintosh uses. 
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Fig. 1-2. Close-up of the Macintosh 
internal d isk drive, which accepts 3\lz-inch microfloppy disks. 

MacTip 1-1 

More and more computers are being made to accept 
3112-inch disks. Though the disks themselves can be used in 
any of these computers, the contents recorded on the 
disk can't be shared among computers. For example, the 
Macintosh can' t use a word processing disk meant 
for computer brand XYZ. The two computers speak dif
ferent languages and record data on the disk in different 
ways. 

Because of the added protection provided by their hard shell, the Mac's 
3 Vz-i nch disks (also called microdisks) are hardy enough to be mailed in a standard 
business envelope or carried in a shirt pocket without worry of damaging the disk 
and losing precious data. 
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Fig. 1-3. Standard Slf.!-inch and new JV2-inch computer disks. 
Note that with the JV2-inch version, a metal shutter protects the magnetic disk itself. 

A SPECIAL Kl N D OF KEYBOARD 

An integral part of the Mac, but a separate component, is the 58-key detached 
keyboard, shown in Figure 1-4. The keyboard connects to the cabinet by means of 
a coiled cord. The cord plugs into the front of the Mac, using the same kind of con
nector found on the latest modular telephones. Note: Do not hook up a telephone 
to the Mac, or the keyboard to the telephone line, as some early M ac users have 
done. You run the risk of shorting some circuits and causing considerable damage 
to the Macintosh or the keyboard. 

Like the Mac's main cabinet, the keyboard looks a bit small for the job. Don't 
be fooled: The keys are spaced the standard % inch apart , and all the important 
keys are there. The keys on the Mac keyboard feel sol id . The positive feel of the 
keys aids considerably in touch typing. 

Incidentally, if you're something less than a superfast and superaccurate typist, 
don' t be concerned. The Mac can be adjusted to suit your needs. For example, you 
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Fig. 1-4. Fifty-eight keys make up the Macintosh keyboard. 
Cursor control keys found on most other computers have been replaced by the Mac's mouse. 

can adjust the sensitivity of the keys as well as the repeat rate (how long it takes the 
keys to go into repeat mode when they are held down). 

These options and more are set by using a handy Mac accessory called the con
trol panel. Read more about the control panel, along with the Mac's other buil t-in 
goodies, in Chapter 6, "Desktop Accessories." 

MacTip 1-2 

The Mac's keyboard lacks a separate numeric 
keypad, which comes in handy if you work with numbers a 
lot. But an optiona l keypad can be added to the Mac. The 
keypad attaches in line' with the regular keyboard. 

For the most part, the Mac's keyboard has the same keys found on a standard 
electric typewriter. There are a few extras: the Option, Enter, and the funny-shaped 
:Jg , or Command, key. You'll get to know precisely what these keys do soon 
enough, but here's a quick rundown. 

The Enter key is very much like the Mac's Return key, which in itself, does 
the same job (more o r less) as the Return, or ca rriage return, key on a typewriter. 
That is, you press it to say " I have finished" (with this line, this command, or 
whatever). 

The Return and Enter keys can often be used interchangeably. There may be 
some instances, however, when a program requires that the two keys not be the 
same. The manual that accompanies the program wi ll provide the details. Read it to 
be sure. 
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The Option Key is used the same way as the Shift key: you hold it down while 
pressing another key to change the effect of that key. But there is a difference. 
Holding down the Shift key makes capital letters; holding down the Option key 
totally changes what the key prints out. 

For example, if you press the Option and G keys together, the Mac spits out a • 
symbol. The Mac has about five dozen special characters. All are created by pressing 
either Option or Option and Shift while tapping on another key (see Figures 1-5 and 
1-6). As you may have guessed, both Option keys do the same thing. 

The Mac has room for several more special characters. Some programs may 
create their own. In addition, the Option key is sometimes used for more than 
creating alternate characters. Some programs use the Option key for special effects. 

Fig. 1-5. Mac's built-in special characters. Press the Option key to use them. 

Fig. 1-6. More built-in special characters. Press both the Option and Shift keys to get them. 

The X Key (or Command key) is nestled to the left of the Spacebar. The Com
mand key is somewhat like the Option key: you hold it down while pressing 
another key. But the Command key doesn't print out alternate characters; it does 
as its name implies. It commands the Macintosh to do something. 

In many respects, the Command key is like the Control key found on the 
typical computer (the control key is usually marked "CTRL"). The control key is 
often used to talk directly to the computer rather than to type text. 

Likewise, the Mac's Command key lets you talk directly to the Mac. If you've 
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looked closely at Figure 1-2, you may have noticed that the Mac's disk drive lacks 
any type of door or ejection mechanism. You must ask the Mac to eject the disk for 
you. This is done with the help of the Command key. (There are several additional 
ways of doing this; you'll learn them all later.) 

MacTip 1-3 

The Mac's Shift and Caps Lock keys are much like their 
typewriter counterparts, but not exactly the same. Holding 
down the Shift key and pressing another key does one of 
two things: it prints out a capital letter or it prints out the 
character on the top of a keyface. For example, if you type 
Shift-k, the Mac creates a K. Type Shift-7, and the Mac creates 
an & symbol. 

The Caps Lock key, on the other hand, works with the 
alphabet keys only. Unlike the Shift Lock key found on most 
typewriters, it does not affect all the keys. When you press the 
Caps Lock key, it stays down. Then, when you type on the 
alphabet keys, you get only capital letters, but all other keys 
are unaffected. • 

To print the character on the top of a number or symbol 
key, depress the Shift key. You don't need to release the Caps 
Lock key first. 

THE MOUSE THAT ROAMED 

If you're even a little bit familiar with computers, you've probably noticed that 
the Mac lacks a few of the keys normally found on computer keyboards. Go back 
and look closely at Figure 1-4. 

Where are the cursor control keys? How do you control the Mac's on-screen 
cursor-that stubby, blinking line that indicates where the computer's attention is 
focused -without cursor keys? The answer lies in the third part of the Mac, the 
mouse. 

The Mac's mouse, shown up close in Figure 1-7, is tethered to the Macintosh via a 
single, thin cable. On the top of the mouse is a single button; on the bottom is a rubber 
ball. Inside the mouse are small sensors than are activated when the ball moves. 

For example, place the mouse on a table and inch it to ttfe right. Here's what 
happens: 

1. The ball rolls. 

2. The internal sensors pick up the motion. 

3. The mouse sends the electronic results of the motion to the Mac. 

On the screen, the Mac's special cursor imitates the motion of the mouse. 
Move the mouse to the left; the cursor moves to the left. Move the mouse 
anywhere in any direction, and the cursor follows. 
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Fig. 1-7. The Macintosh mo use. 

The mouse is used for more than positioning the M ac's cursor -which is more 
accurately ca lled the " pointer," because of the arrow shape it normally takes on. 
It's also used to draw intricate designs; to sweep over text to be deleted or 
modified; to select a series of numbers to be included in a complex mathematical 
formula; and much more. 

The mo use permits you to "point and shoot. " It makes telling the Mac what to 
do as simple as placing the pointer over someth ing on the screen and pressing the 
mo use button once or twice. Everything on the screen is less than a second away. 

With the average computer (which the Macintosh is not), you m ust press one 
or more arrow keys to position the cursor. Depending on where the cursor is to 
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begin with, you could spend four or five seconds just maneuvering it to the spot 
where you want it. 

Apple's choice of a mouse has raised some eyebrows-not to mention a 
number of objections. One is that you must move your hand off the keyboard to 
move the mouse. If you're an efficient typist, you may find the Mac's mouse a mild 
inconvenience in some applications. 

Rather than tapping a set of cursor keys with your pinky, you must physically 
move your right or left hand off the keyboard, push the mouse, then resume 
typing. Once you get used to the Mac's keyboard/mouse system, however, you'll 
find this isn't such a problem after all. (Remember that for decades, typists 
using manual typewriters moved their left hand from the keyboard to whip the 
carriage back to the left margin, but eventually we all got used to the Return 
key.) 

Another complaint is that, in general, mice take up desk space. It would appear 
that most computer users have no place on the work surface to put a mouse, let 
alone push it along to move the on-screen pointer. 

Apple foresaw this, fortunately, and designed the Macintosh to take up very lit
tle room -mouse included. Most computers are wider than they are tall. The IBM 
PC, for example, is about 20 inches wide. The Mac itself is less than 10 inches wide; 
the keyboard is 13 inches wide. Add a seven-inch by seven- inch roaming space for 
the mouse, and you get 20 inches across. In fact, when all things are considered, 
the Macintosh takes up less space than the typical computer, even the portable 
variety. 

EASY: THE MAC'S MIDDLE NAME 

Though it's been said before, it's worth saying again. The Macintosh was 
designed from the inside out to be an easy-to-use computer, one that can be used 
by someone with little or no computer knowledge. 

Why is the Macintosh so easy to use? You've been introduced to one of the 
elements already, the mouse. There are four more: icons, windows, pull-down 
menus, and something called the Finder. Let's see what each of these is. 

MORE THAN 1,000 WORDS 

From the very start, the Mac was designed around the concept of an electronic 
desk. The image displayed in the Mac's video tube is a light grey representation of 
the surface of a desk-you're looking down from the top. Like any desk, the Mac's 
is used to hold things while you're working. 

The Mac's desktop is always present. When you turn the Mac on and insert a 
disk into the disk drive, the desktop is the first thing you see. You do all the stand
ard computing chores while stationed at the desktop, you start programs from the 
desktop, and you leave the Mac through the desktop. 

When the desktop first appears, as in Figure 1-8, so do two strange-looking 
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symbols. One looks rather like a Mac disk, the other looks like a trash can. (The 
Mac makes heavy use of symbols like these-otherwise known as icons.) 

MacTip 1-4 

If you don't like the shade of the desktop, don' t worry. 
There's an easy way to change it. Refer to Chapter 6, "Desk
top Accessories," to see how the control panel is used to 
change the pattern of the desktop surface. Probably, 
however, like most people, you' ll find that the gray tone is 
the most pleasing. 

As you may have guessed, the trash can is used to throw unneeded Mac pro
grams and documents away. The disk icon represents the disk that' s been inserted 
into the Mac disk drive. The di sk icon can be "opened" (via a process covered in 
detail in the next chapter). Opening the disk icon (see Figure 1-9) reveals the files 
contained on the disk. 

r a File Edit Uiew Special 
., 

Fig. 1-8. The desktop, complete with trash can and disk icons and pull-down menus. 

There are icons for a great many things, all representing either an action (such 
as throwing away files into a trash bin) or a thing (a disk, for example). Icons are pic
tures of the actions or items they represent, so it's easy to identify what they mean. 

For example, there are icons for documents that are created by programs
these look like pieces of paper. There are icons that represent programs -
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their shape varies, but they usually look like a hand drawing or painting on a sheet 
of paper (Figure 1-10). More about icons in the next two chapters. 

,. • File Edit Uiew Special 
., 

Font Mov•r Disk Copy Fonts 

DO 

Fig. 1-9. The disk directory window, open for business. 

----------·-----------------
ProgrDm Folder Document 

Fig. 1-10. A sampling of icons: a program, a folder (used to store 
other icons), and a document (a collection of pictures, words, numbers, or other items). 

THE MAC DOES WINDOWS 

Another of the elements that contribute to the Mac's ease of use is windows. To 
understand what a Mac window is, take a moment to picture how the average 
computer di splays images on its video monitor. There, staring right at you, is a 
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complete screenful of information. It could be text, such as a letter to the boss, or 
even a picture. When you want to look at something else, you must cancel the first 
image, and replace it with another. 

With the Mac, you can view more than one picture or block of text at a time. 
Each block of text or graphic image is displayed in its own frame, a window. Strictly 
speaking, a window is a porthole into the Mac- an almost physical partition in the 
Mac's video screen. Inside any window, text, pictures, icons, or a number of other 
things can appear. See for yourself in Figure 1-11. 

Commission 

500 Mar 
Apr 

May 
400 Jun 

Jul 
Au9 

300 Sep 

Sales Oct 

200 

100 

0 
Jan Feb Mar Apr May Jun Jul 

Month 

fig. 1-11. You can use Macintosh windows as you would piles of paper on a desk. 

In one window, as shown here, can be a group of numbers. In another might 
be a chart, based on the numbers in the first window. Both are on the screen at the 
same time; each is handled independently. This not only makes it easier to see the 
relationships between the two, but it also helps to speed up the analytical process 
and makes using the Mac more like working at a desk (where you'd compare 
numbers and charts side by side, too). 

With windows, you can literally bring someth ing out onto the desktop to work 
with it, and then put it away when you're finished. You can have more than one 
thing on the desktop at once. In fact, as Figure 1-12 shows, a nearly infinite number 
of windows can be placed on the Mac's screen. Like icons, windows are more fully 
discussed in the following chapters; discussions include how to change their size 
and how to move them around the desktop. 
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Empty Folder 

Kind: folder 
Size: contents total 0 bytes 
Where: System Oisk, internal driue 
Created: Wednesday, May 2, 1984 at 8:1 0 AM 
Modified: Thursday, June 21, 1984 at 12:44 AM 

0 locked 

Fig. 1-12. The Mac can display many windows on its screen (shown here stacked one on top 
of another). though you'll want to limit the number to half a dozen or so to keep things simple. 

MacTip 1-5 

There's a practical limit to the number of windows that 
should be on the desktop. For best results, keep the number 
under six. Get in the habit of closing windows you no longer 
need. 

FINDERS KEEPERS 

Now for the Finder. If you' re familiar with computers, you've probably heard 
the term "operating system" or " DOS." Both represent an intricate program 
that the computer uses to help it perform computations, to allow it to make use of 
its component parts intelligently and efficiently, and to talk to you, its user. 

The operating system is usually compared with a fast-th inking traffic cop, given 
the thankless assignment of directing the flow of ca rs at a congested intersection. 
It's an overused analogy, but it serves our purposes wel l. 

The Mac's Finder does the same job, but it' s more refined than the operating 
systems found in other computers. At its most basic level, the Finder is very much 
the butler of the Macintosh, ensuring that everything goes smoothly, th at the Mac is 
operating on an even keel, and that all your requests are taken care of. The. Finder 
is your English-speaking link to the Macintosh - always attentive and wanting to 
help out. 
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Here's a way to visualize what the Finder does. Imagine the Finder as an inn
keeper; the Mac's electronic desktop is the lobby (Figure 1-13). You enter the lobby 
of the inn and are greeted by the Finder, who asks you what you'd like to do. 

~ 
Font Movtr 

~ 
HaoPaint 

Fig. 1-13. Imagine the Finder as an innkeeper 
and the Mac's electronic desktop as the lobby inside the inn. 

You may, for example, want to use the Mac to write a short memo. For this, 
you'd use a word processing program, such as MacWrite. Just tell the Finder you 
want to use Mac Write, and before you know it, you're led to the room that con
tains MacWrite. There's MacWrite, ready for you to use. 

When you've finished with MacWrite, tell the Finder that you're through. On 
your way out of the MacWrite room, the Finder will ask you to give a name to the 
document you just created, in case you want to use it again. There, visible on the 
desktop, as shown in Figure 1-14, is the icon of the MacWrite document you just 
created. Underneath it (as with all icons) is the name you gave the document. 
Besides being an accommodating innkeeper, the Finder is an efficient secretary. 

The Finder acts as your servant while you use the Mac. It performs many of the 
menial, housekeeping tasks that most other computers insist you do yourself. It 
even keeps track of all the documents you create, noting which program they link 
to. To work on almost any other computer, "you need to do all the file keeping 
yourself. For example, you might call a word processing document REPORT.TXT, 
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Write/Paint 
5it .. s 295IC in disk I 041( availabl• 

0 0 
Emptv foldtr Systtm foldtr 

font Movtr Moc'Yrttt Brand New Document 

Fig. 1-14. The Finder does most of the mundane and routine computing work for you. 

for a document named " Report," which is a text (TXT) file. The TXT code helps you 
identify the document later as a word processing document (of course, which word 
processing program it goes with is anyone's guess) . 

With the Mac, just name the document "Report" and let the Finder discover 
which program the document requires. The Finder is full of other tricks. Learn 
about them in the fo llowing chapters. 

MacTip 1-6 

Unlike most other computers, the Mac lets you give the 
documents you create very descriptive names. There's 
nothing wrong w ith naming a document "First Annual 
Stockholders Report." Just keep the name under 63 
characters. You may want to limit names to under 20 
characters, however, so they don't cl utter up the desktop or 
overlap onto other icons and names. 

ALLIN A MENU 

Just as the Macintosh doesn't require that you remember which documents go 
to wh ich programs, neither does the Mac require you to remember how to use the 
machine. If you forget the sequence of events to perform a certain function, such 
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as starting a program, don't worry. Help is no farther away than the pull-down 
menus of Mac's own video screen . 

A vital feature of the Macintosh, and one that contributes greatly to its ease of 
use, these pull-down menus appear not only w hile you're stationed at the Mac's 
desktop, but also while you're working with a program. The pull-down menus 
change, depending on the program you're using, but the way they' re used is 
always the same. The Finder makes sure of that. 

The menus are housed in the menu bar, which appears at the top of the screen. 
To choose a menu item, you move the mouse so the pointer is over one of the 
menus (File, for instance). Press the mouse button and move the pointer down the 
screen, and a menu rolls down from the top·, as shown in Figure 1-15. 

Fig. 1-15. The File pull -down menu, displaying all of its commands. 

Once the pull-down menu is in view, a command can be selected, or you can 
let go of the mouse button wi thout moving the mouse, and the menu rolls back up 
and disappears, with no command invoked. 

Some of the more common menu commands can also be invoked by pressing 
a letter key along with the Command key. The mouse makes the Mac easy to learn 
and use, but it can sometimes slow things down; the Command-key-equivalent 
feature can come in handy. 

Just remember, if you should ever forget a Command key sequence, just pull 
the menu down -the keys to push are always d isplayed alongside the command 
itself (for example, the Eject command, found in the File menu, has a ~ E alongside 
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it. Pressing the Command key and E does the same thing as using the mouse to 
choose Eject from the File menu.) 

MacTip 1-7 

From now on in this book, we'll use a kind of shorthand 
to indicate commands. When you see something like 
File//Eject, it means "the Eject command, found in the File 
menu." 

POWER TO BURN 

Any computer can be easy to use. But ease of use can mean a weak-muscled 
computer. The Mac is anything but weak! 

Put a program disk in the Mac and you're off preparing financial reports, figur
ing next year's budget, or writing the Great American Novel (for a semitechnical 
discussion of the insides of the Mac, and why it's a powerful computer, see Chapter 
9, "The Macintosh Unveiled"). The rest of this chapter describes some jobs the 
Mac is particularly good at. 

Writing 

Slip a word processing program such as MacWrite into the disk drive, and the 
Mac becomes a supersophisticated electronic typewriter. Write, edit, and print 
documents-all with an ease that makes you wonder if you'll ever be able to use a 
pen and paper again. 

The Mac is the ideal computer for word processing. Using a Mac to write a 
memo or report is not very different from writing with a typewriter, and it's about as 
easy. Word processing with the average computer means learning a complex set of 
commands, and a whole new way of writing. The Mac uses a combination of pull
down menus, icons, and simple mouse movements to accomplish the same results 
with less strain on the brain. 

At any rate, word processing programs let you make easy changes to already 
written text. The program automatically takes care of the appearance of the written 
page. There's no need to worry if you need to take out a word or two: the program 
will adjust the paragraph as necessary (see Figure 1-16). 

With the Macintosh, what you see on the screen is what you get on paper (of 
course, you must have a printer hooked up to the Mac to get a printed copy). 
What's more, the Mac can create not only plain, dull typewriter-looking text, but 
fancy print in myriad sizes. 

Let's say you want to write a flyer for a neighborhood-wide garage sale. You 
could write the details in a straight, no-nonsense typestyle. Then, for emphasis, add 
the words "Garage" and "Sale" in large, bold, italic type, as shown in Figure 1-17. 

You could go way out, creating a "ransom note" flyer (Figure 1-18), by using 
the San Francisco typestyle, one of the Mac's other built-in fonts. Let your imagina
tion wander. The Mac will do the rest. 
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,. • File Edit search Format Font Style 
., 
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This is an eHample of MacWri te's easy 
editing features. Just take out a word or 
two and the paragraph Is automatically 
adjusted. Unlike working with on old
fashioned typewriter, there's no tell-tole 
sign of corrections. 

(A) 

This is on eHomple of MocWrite's easy 
editing features. Unlike working with on 
old-fashioned typewriter, there's no tell
tole sign of corrections. 

(B) 

mm 

I 

: [ 

Fig. 1-16. Word processors make the process of writing (and rewriting) almost automatic. 
Delete words or even complete sentences; the appearance of the page is adjusted for you. 
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GA.HA G.B SALE!! 

Neighborhood garage sale. 
Everything goes--

bikes, dishwasher, typewriter, clothes, lawn 
mower, IBM PC (will trade for an Apple 

Macintosh), China, and much more. 

Fig. 1-17. Use a word processor such as MacWrite to create garage sale flyers, for example. 

Be at the corner of Ellm and 
WirSt thiS aat urday and sunday 
for a giant 

Bring ann your money, becauSe 
you·nn want to Spend it On the 
bikeS, diShwaSherS, Iv·s cllotheS, 
and other goodieS you·nn find. 

Fig. 1-18. For added emphasis, use one or more of the Mac's built-in special fonts. 

Drawing 

The Mac is as comfortable with pictures as it is with words. Slip the MacPaint 
program from Apple into the Mac, for example, and you can draw simple sketches, 
complex interweaving designs, and just about anything in between. MacPaint pro
vides several 11tools" for drawing and creating shapes, 38 preprogrammed pat
terns, and an assortment of paintbrush tips (see Figure 1-19). If you've got a knack 
for art, or just like doodling, the Mac and MacPaint are perfect companions. 

The Mac is equally creative with sedate and conservative business graphics, 
too. Microsoft's Chart program is what's known as a "presentation graphics" pro
gram. It creates charts-such as pie, bar, and line graphs-from numerical data. A 
typical chart might show the sales of a business for the past eight months (see 
Figure 1-20). 
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Fig. 1-19. Pictures or words, the Macintosh doesn't 
care. It does both equally well. Here, Apple's MacPaint. 
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Fig. 1-20. Microsoft Chart lets you create your own business graphs. 
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The Mac can integrate pictures and text into the same document and print it all 
out together. For example, you could produce a chart detailing a forecast for clam
shell jewelry for the next three years. Then, you could write a memo expressing your 
thoughts about clamshells with a word processing program like MacWrite, pull the 
chart into the MacWrite document, and print it out as a whole (Figure 1-21 ). There. 
No cutting or pasting required. And the results look sharp and professional. 

Numbers 

The Mac needs a lot of power to create its fancy fonts and pictures. In fact, the 
Mac was designed to have over twice the raw computing power of the IBM Per
sonal Computer, and over four times that of some weaker-bodied computers. This 
makes it a natural for crunching numbers using electronic spreadsheet software 
such as Microsoft's Multiplan, for example. 

Multiplan is very much a computerized version of a bookkeeper's ledger (see 
Figure 1-22). The intersections of a series of rows and columns make up cells, 
which are discrete bins that hold numbers or formulas. 

You might, for instance, have a single column of numbers. The cell immediately 
below the stack contains a formula indicating what you want to do with the num
bers. You can add them up, average them, find the standard deviation, and so on. 

Electronic spreadsheet programs permit rapid and easy changes to both for
mulas and numbers. Instead of manually recalculating a whole set of figures, you 
need only key in the change- such as a higher or lower interest rate- and the pro
gram automatically recalculates all the figures that are affected by the change. 

Communications 

Though the Macintosh is complete by itself, you may someday want to connect 
it to another computer. Through the phone lines, you can connect to another Mac, 
or to any other computer for that matter, and converse electronically. You can 
also tap into the computers of a service bureau, such as CompuServe, Dow jones 
News/Retrieval, or The Source, and have access to millions of bits of useful 
information. 

For example, you could call up CompuServe and connect with its electronic 
news service. From there, you could flip through reports on the latest world 
developments, reading each article. Or you could query for specific information, 
such as grain embargoes, or the hottest sports reports. 

The price for such information at your fingertips? In many areas, the phone call 
to the CompuServe computers (which are located in Ohio) is free. CompuServe 
bills for its service by the hour at about $6 an hour, so if you take 15 minutes pulling 
out the latest scoop on world events, it'll cost all of $1.50. More than a newspaper 
would cost, yes, but lots more fun and with a lot more information. 

As it does when it's working with words, pictures, and numbers, the Mac needs 
a special program to communicate with other computers. Apple MacTerminal is 
one example. 
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I nteroffite Memo 

Date: denuory 21 

To: John 

From: Fred 

Rs you suggested, I looked into the future of clamshell jewelry. You 
got a good tlpl I see en incredible future in this. Thought you'd like to 
see my figures ••• 

Clamshtll Jfwtlry 

80 

70 

50 

50 
Hilions Of 

40 ClamshtUs 
30 

20 

10 

0 
1984 1985 IQ86 1987 1988 1989 

VHT 

Rs you con see, the market for tlemshell jewelry Is eHpected to be 75 
millitln pieces by 1 989. Rt $1 a piece, clamshells look uery good. We 
might be able to tie It Into our restaurant chains (we'll definitely haue 
to charge a deposit for steamed tlems, or patrons might take the 
empty shells home and go Into business for themselues). 

Let me know your thoughts. 

Fred 

Fig. 1-21. The Macintosh lets you integrate words and pictures for added dramatic emphasis. 
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Fig. 1-22. Do "what-if" projections and calculations w ith 
an electronic spreadsheet program such as Microsoft's Multiplan. 

Information 

Computers are perfect for storing loads of information. And since the Macin
tosh can process data much faster than most computers, it's perfect for a variety of 
data management tasks. 

Data management is simply the process of recording and retrieving blocks of 
information. A pocket address book is a sample of manual data management. Each 
name, address, and phone number is placed on a line. To help you find the right 
numbers, the information is organized in alphabetical order. When it comes time 
to drop someone a line, just look them up in the book- all the information is there. 

The Mac does things a little differently than the little bl ack book, but the end 
result isn't much different. You might collect the names of all your cl ients, and 
enter them into a data management program such as Haba's Habadex (shown in 
Figure 1-23). With many data management programs, you can create a " template" 
for easy data entry. The job is complete when all the blanks have been filled in . 

How the Mac stores all the names and addresses is of no concern to you, but 
how you can retrieve the data is. You can ask a program such as PFS:File to search 
for a particular name, or for a specific group; for example, all those clients living in 
Los Angeles. If you'd like, you can get very specific, and indicate several searching 
priorities; for example, all clients who live in Los Angeles AND whose names begin 
with B. 
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TIME FOR WORK 

So much for the 10-cent tour of the Macintosh. You've learned about the com
ponents of the basic Mac, its electronic desktop (including the mouse, icons, win
dows, Finder, and pull-down menus), and some of the jobs the Mac can do. 

Now, on to bigger and better things: how to get the Mac up and running and 
on its way to doing something worthwhile. 

r • 

Neme 
Address 
City 
Stete 
ZIP Code 
Phone Number 

Print 

e Doto in this Field ? 

MoHimum Field Length (1 -40) ? 

Field 7 
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@No 
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0 Integer 
Q Reel # 

Q Uote 

., 

Fig. 1-23. Habadex, from Haba Systems, is a fancified version of the popular Roladex fi le 
(hence its catchy name). Use it, or any other data management program, to help you track 
information such as phone numbers, appointments, magazine articles, and many other kinds 

of information. 



CHAPTER 2 

Bringing Home the Macintosh 

You're excited: you bring the Mac home from the dealer's and the first thing you 
want to do is tear open the box, put the pieces together, and get started. No one 
would blame you for being impatient, for wanting to start playing with the Mac as 
soon as possible. But take fair warning: the Mac isn't indestructible. You could con
ceivably damage it- either in trying to put the pieces together or by putting it in the 
wrong place in your home or office. 

In this chapter you'll learn how to safely assemble the Mac, where best to put 
it, and how to make sure it works the way it should. 

UNPACKING 

Every Macintosh from Apple comes with the following: 

• Macintosh main unit 

• Keyboard 

• Keyboard cable 

• Mouse (the cable is already attached) 

• Power cord 

29 
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• User's manual 

• Blank disk 

• System disk (marked System) 

• Guided Tour disk 

• Guided Tour cassette tape 

• Programmer's switch 

It's a good idea to check your Mac before you take it home from the store to be 
sure you're getting a complete system. You need everything but the blank disk, the 
programmer's switch, and the Guided Tour materials to get you through -the Mac 
won't function without the other elements. If you're short, get replacements while 
you're at the store. 

The Macintosh can plug into any standard electrical outlet, but it should be 
plugged into an outlet that has a third (grounding) prong on the plug. The ground 
plug helps maintain the Macintosh's built-in shock prevention features and 
shouldn't be bypassed. 

If your electrical outlet is the older, two-prong type, don't cut the round 
ground plug off the Mac's power cord. Rather, buy a three-to-two-prong adapter, 
available at most hardware stores. To use the adapter correctly, follow the direc
tions packed with it. 

The Mac's power cord is only seven feet long, which means that you'll have to 
place the Mac near an outlet-or use an extension cord. Apple suggests that you 
don't use an extension cord, but there's nothing wrong with doing so if you follow 
these "rules." 

• Use a three-prong grounded extension cord only; don't use a cheap two
prong lamp extension cord. 

• Use an extension cord rated for at least 15 amps. Look for the rating on the 
tag or label when you buy it (or if it's not new, look for the rating stamped 
somewhere along its length). 

• Stash the extension and Mac power cords out of the way so they won't be 
walked on or tripped over. 

Because the Mac is so small, it fits comfortably on just about any desk or table. 
But you'll want to place the Mac on a surface that allows enough space for the 
mouse. A 7-by-7-inch square area will do -either on the left or right side of the 
keyboard (Figure 2-1 ). 

The rolling surface for the mouse should be as smooth as possible. The rougher 
the table, the less accurate the mouse will be. Avoid the use of desk blotters, par
ticularly the felt kind. The blotter doesn't make a very good rolling surface for the 
mouse, and individual cloth fibers can get caught in the mouse's mechanism. 

Finally, if you're going to be putting the Mac in an enclosed workstation, give 
some thought to the Mac's breathing space. Apple designed the Macintosh with 
few electronic parts; so few in fact, that the Mac doesn't need a fan to cool the in-
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171nches 

-----) 
7 inches 

Fig. 2-1. Give the mouse at least a 7-by-7-inch area for movement. 

sides. Instead, the Mac's electronic circuitry is cooled by convection. Air is brought 
in through ventilation slots on the bottom and passed out through slots on the top. 

MacTip 2-1 

For the best results, purchase a plastic mouse pad, 
available at most computer stores. Or you can make your 
own pad. Cut a 1-foot-square piece of acrylic plastic. For 
feet, use rubber pads (available at electronic specialty stores) 
or pieces of felt. 

Some enclosed workstation designs can inhibit the free flow of air around the 
Mac, essentially suffocating it. The Mac won't turn blue when it runs out of air, but 
it will overheat and stop working. (Overheating the Mac is to be avoided, because 
excessive heat can destroy electronic components.) 

The same rules hold for placing objects-such as books, papers, or accessories 
-beside or on top of the Mac, where they could cover up the vent slots. For peace 
of mind, keep at least one inch of clearance all around the Mac. 

If you've ever used a computer before, you know how light can wash out the 
video screen. Before setting up your new Macintosh, give some thought to the light 
that may fall on the face of the machine. 

Sunlight causes the most problems. It not only completely washes out the 
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screen, but can heat up (and even melt) the Mac's plastic cabinet. Overhead 
lights-from fluorescent fixtures and standard desklamps-can be as annoying. 

MacTip 2-2 

Most Mac users put the disk drive on the right side. 
Though there's nothing wrong with putting the drive on the 
left side, take care to keep the drive away from the Mac. The 
left side of the Mac gets the hottest, so the vents on that side 
should have an extra measure of breathing room. 

Experiment by moving the Mac, without its keyboard and other attachments, 
around the room. If you have windows that face south, east, or west, be sure to 
think about ho'Y sunlight may stream through at certain times of the day. 

HOOKING UP THE PIECES 

With a space ready for the Mac and a power outlet nearby, it's time to hook 
everything together and test it for proper operation. 

Begin by placing the main Mac cabinet, with the back facing you, on the desk 
or table. Find the battery compartment, which is located on the upper right corner 
of the back. Pop it open with your finger, as shown in Figure 2-2. The battery cover 
comes completely off, so don't lose it. 

For starters, be sure that a battery is there (it should be: Apple places a battery 
in every Mac before it leaves the factory). A Mac will work without a battery, but 
the built-in dock/calendar won't keep time when the Mac is turned off. 

To get everything in working order, place an Eveready number 528 battery (or 
equivalent) into the compartment, positive (+)end down. The 528 battery is about 
the same size as a standard AA battery, but only a number 528 will do (for one 
thing, an AA delivers 1.5 volts, whereas the 528 delivers 4.5 volts). After inserting 
the battery, or if the battery is already in place, finish this step by replacing the com
partment cover. 

Plug the female end of the power cord into the receptacle on the Mac. The 
cord fits only one way. Don't plug the Mac into the wall socket just yet. 

Unwrap the mouse from its special box and plug the cable into the mouse con
nector on the back of the Mac, as shown in Figure 2-3. The mouse connector is the 
one on the far left (back facing you), and is marked with a symbol (icon) of a mouse 
(a Mac mouse; not a real mouse). 

The mouse-to-Mac connection should be a tight one (the same goes for every 
accessory added to the Mac). Press the plug into the connector until it's seated 
snugly. Finish by twisting the thumb-screw knobs until they are finger tight. Don't 
overtighten -you may break something. 

Turn the Mac around so the front is facing you. If you're right-handed, you'll 
probably want to place the mouse to the right of the Mac. Place it on the left if 
you're a lefty. You are, of course, free to change the position of the mouse at any 
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fig. 2-2. Check inside the battery compartment 
to make sure the battery is correctly installed. 

time. The proper orientation of the mouse is with the cable (tail) leading away 
from you . 

Now it's time to plug in the keyboard. Open up the separate keyboard ship
ping box and you' ll find one keyboard and one coiled keyboard cable. Before 
attaching the keyboard to the Mac, inspect it for damage and loose keys . Push 
loose keys back into position by lightly pressing down on them. Snap one end of 
the coi led cord into the keyboard; the other end into the Mac (Figure 2-4). 
Although the keyboard cable looks the same as that used for telephones, phone 
cords usually don't work because of connector size and wire incompatibil ities. 

Never hook the keyboard into a telephone line and never plug a telephone line 
into the Macintosh. For one thing, phone lines carry more than 50 volts of elec
tricity, which can seriously injure your Mac. And for another thing, the telephone 
line does absolutely nothing for your Mac, and vice versa. 

With the battery, power cable, mouse, and keyboard in place, it' s time to plug 
the Mac into the wall and try it out. Make sure the on/off switch is in the off (or "0" ) 
posit ion, and plug the Mac in. Then flip the power switch up (to the " 1" position). 
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Fig. 2-3. Plug the mouse cable into 
the mouse connector, and then tighten the thumb screws for a sure fit. 

MacTip 2-3 

If you ever need to remove the keyboard cord, press 
down on the plastic tab located on the top of the cord's con
nector, and pull the connector loose. 

If all is well with your Mac (which it should be), you'll hear a long but pleasant 
" beep." In a few seconds, the screen will light up, displaying a small picture of a 
disk with a question mark inside it. 

If your Mac doesn' t beep when you turn it on , or does beep but the screen 
doesn't light up, it probably doesn' t mean your Mac is defective. Probably things 
just aren't hooked up or adjusted properly. If the Mac doesn't seem to work, the 
most likely fault is that it isn't getting power. Double check the power cord by mak
ing sure it's snugly in place- both in the Mac and in the wall outlet. If you've plug-
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' 
Fig. 2-4. The keyboard uses a telephone-like cord. Fit one end into the back of the keyboard 
unit, the other into the keyboard connector on the Mac (lower right corner, front facing you). 

ged the Mac in via an extension cord, try plugging it directly into an outlet (you may 
have to move it to do this). 

If the outlet is the kind that's controlled by a separate wal l switch, make sure 
the outlet is switched on. 

MacTip 2-4 

It's a good idea to find an unswitched outlet for the Mac. 
Otherwise, there will be a time when you're diligently work
ing with the Mac and someone will accidentally hit the 
switch, cutting off power to the Mac, and erasing all of your 
hard work . 

If the Mac beeps but the screen remains blank, check the brightness control 
that' s located on the lower left panel (under the front lip) . Turn it clockwise to 
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increase brightness, the other way to decrease brightness (Figure 2-5). There is no 
user-adjustable contrast control. 

If, after all this, the Mac still doesn't work, take it back to the store for a 
checkup. It's possible that the internal fuse is blown, or that some component 
within the Mac has malfunctioned. Both are problems that only a qual ified service 
technician can handle (mostly because technicians are the only ones with the 
special tools needed to remove the cover from the Mac, and because taking the 
cover off poses a serious shock hazard, even when the Mac is unplugged). 

STARTING UP 
With the Mac on and the screen glowing brightly, it's time to insert a disk into 

the disk drive and put the Mac through its paces. All that's required is to pop a disk 
into the drive-the Mac will do the rest. 

While there's no science involved when inserting disks, they can 't be plugged 
into the drive just any old way. Disk can only be inserted metal end fi rst, label side 
up (the disk's hub will be on the bottom), as shown in Figure 2-7. 

Fig. 2-5. Adjust the brightness control , if necessary, fo r the best picture. 
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Fig. 2-6. If you want to install the programmer's switch, plug it 
into the bottom three ventilation slots at the rear of the far left side of the Macintosh. 

MacTip 2-5 

You don 't have to use the Programmer's Switch, but it's 
included in case you want it (at the very least, it provides a 
way to turn the Mac on and off without reaching around to 
the back of the machine to find the power switch). Insert the 
Programmer's Switch, lettering side up, into the bottom 
three slots at the rear of the left vent, as shown in Figure 2-6. 

Use only the side of the switch that says Reset. Press it to 
reset the Mac-that is, to cycle it off and on. Be careful with 
this button and don't press it accidentally. Doing so will 
erase whatever you have in the computer's memory (the 
contents of the disk will remain intact, of cou rse). 

Don't bother with the button that says Interrupt. It 
doesn't do anything worthwhile for you. 
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Fig. 2-7. Insert disks label side up, metal end first. 

It should also be noted that only disks that have the Mac's operating system on 
them can be used to start (or "boot") the computer. The disk marked " System" can 
be used to start the Mac; so can most program disks (the ones for MacWrite and Mac
Paint, for example). For our examples, you'll use the Startup disk named " System." 

Once the System disk has been inserted, the Mac retrieves the programs it 
needs to start, and you're off and running. You' ll know everything is going fine 
when you see an icon of a smiling Mac in the center of the screen . 

Once the drive has accepted the· disk and the Mac has read the operating 
system from it, the Mac's unique electronic desktop wi ll appear. It may take up to a 
half minute for the Mac to read the operating system. A small watch icon will 

· appear-Mac's way of saying "wait a minute, please" -while the program is being 
loaded (see Figure 2-8). If the disk hasn' t been used by someone else already, the 
desktop shou ld look like the one in Figure 2-9. 

A gray desktop, a disk icon, a trash icon, and a pointer make up the Mac's basic 
desk. If the desktop doesn't appear this way, there's no cause for alarm. The Mac 
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MacTip 2-6 

If a disk that lacks the operating system is used to start 
the Mac, the drive will spit the disk out, the sc reen will 
usually turn black, and the icon in the center will turn from a 
disk with a question mark to a frowning Mac. At this point, 
the on ly way to rectify matters is to turn the Mac off and then 
on and try again . 

If the Mac can't properly read the disk for one reason or 
another, the disk "icon will appear X'ed. In this case there's 
no need to cycle the Mac off to retry, but you wil l have to use 
another disk to get the Mac up and running. 

··==~= ·!···· • • ••• • • • • • • • • • • •• • ••• •• • • • • • • •••••• 111111 •••••• 
Fig. 2-8. The watch icon tells you to "wait a minute, please." 

Fig. 2-9. The opening desktop consists of several main elements: 
a disk icon, a trash icon, a pointer (upper left corner), and a menu bar. 

., 
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works the same no matter how the desktop looks. We'll show you how to get the 
desktop back into its original shape in the following chapters. 

The gray desktop is the Mac's working surface. The Mac's desk is colored a 
medium gray, to make it less distracting and easier on the eyes than black or white 
would be. You can change the desk to any shade you want by using one of the 
Mac's desk accessories, covered in Chapter 6, "Desktop Accessories." 

The disk icon represents the disk currently loaded into the disk drive (Figure 
2-10). "Hidden" inside this icon are the contents of the disk. Shortly, you'll learn 
how to open this icon to see what the disk holds. 

System Disk 
Fig. 2-10. A disk icon. This one is named "System Disk." 

The trash icon is the Mac's means of throwing away unneeded files (programs 
and program documents) see Figure 2-11. Since the Macintosh is icon-oriented, 
there's no need to type in a code such as "ERA REPORT.TXT" to delete a file. Just 
drop the icon that represents the unneeded "REPORT" document into the trash. 
You'll learn more about this in the following chapters. 

The pointer indicates where the Mac's mouse is currently positioned (Figure 
2-12). When the mouse is rolled, the pointer moves. 

CHECK-OUT TIME 

Perform the following tests to make sure everything on the Mac is working pro
perly. We'll be using several of the Mac's shortcuts during the tests. Don't worry 
about remembering them -all the shortcuts will be reintroduced in the following 
chapters. 

To begin, push the mouse around the desk (don't touch the mouse button yet). 
The pointer should move in all directions, following the movement of the mouse. 
You'll notice that the pointer won't move completely off the electronic desktop. If 
you run out of rolling room for the mouse before the pointer reaches the place you 
want it to be, simply lift the mouse off the surface and move it to a new position. As 
long as the mouse is not in contact with the surface, the pointer stays stationary. 

So far so good. Finish checking the mouse by placing the pointer (actually, the 
tip of the arrow) over the trash can icon. Tap the mouse button once (don't move 
the mouse while pressing on the button). The icon will turn black, like the one in 
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I 
Trash 

Fig. 2-11. A trash icon. Use it to throw things away. 

Fig. 2-12. The pointer. It comes in many shapes, 
but the arrowhead is the most common pointer shape. 

Figure 2-13. This indicates that the icon is "selected." If you give a command now, 
it will act on the trash icon. 

I 
Fig. 2-13. When you select the trash icon, it turns black. 

With your finger off the mouse button, move the pointer from the trash icon by 
pushing the mouse. With the pointer resting on any portion of the gray surface of 
the desktop, tap the mouse button once again. The trash icon will turn white, indi
cating that it has been "de-selected". 

Now, to open the disk icon, move the pointer over the icon of the disk. Be sure 
the tip of the arrow rests on the body of the icon, as shown in Figure 2-13, not on the 
name underneath (tapping on the mouse button when the pointer rests on the name 
does something special, covered in "About Icons and Windows," Chapter 4). 
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Fig. 2-14. When you select the disk icon, it, too, turns black. (Make sure you 
position the pointer over the body of the icon before you tap on the mouse buttons. 

Instead of tapping on the button once, tap twice in rapid succession. Again, 
take care not to move the mouse wh ile you're pressing on the mouse button. If 
you've done it right, the icon will zoom out and form a box, otherwise known as a 
window (Figure 2-15). Notice that the disk icon is no longer a sol id white or black. 

Font Movtr Disk Cop~ Fonts s .. ttlo 

LJLJ 

Fig. 2-15 . Opening the disk icon reveals the disk directory window. 

You may need to try this mouse button maneuver several times before you 
master it. The secret is making sure you hit the button twice, as quickly as possible, 
with a minimum amount of time between taps. Incidentally, opening the disk icon 
this way is the shortcut method, used here for simplicity. Another way is covered in 
Chapters 3 and 4. 
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Inside this window-properly called the disk directory window-are even 
more icons. These represent what's on the disk. 

On the System disk, the one that's been loaded into the drive, there are icons 
marked "Empty Folder," used to create file folders to hold other icons; "System 
Folder," containing computer-readable files that contribute to the Mac's operating 
system; and "Font Mover," a "utility" program used with certain other programs. 

Depending on when you bought your Mac, there may be other icons, too. One 
may be called "Disk Copy" and another "Fonts." You'll learn how to use these as 
well later in the book. 

CHECKING OUT THE KEYBOARD 

It's time to check out the keyboard. To do it, you'll have to write some text. We'll 
use one of the Mac's special features, the information window, to write the text. 

Make sure the opened disk icon is still selected (black). If it isn't, place the 
pointer inside the disk directory window (but not on an icon) and tap the mouse 
button once (or, place the pointer on the "opened" disk icon and tap the button). 

Press the Command key down and keep it down. Without releasing the Com
mand key, press the I key (don't worry about whether it's uppercase or lowercase; 
just hit the key). 

Within a few seconds, another window should appear on the screen. This is an 
information window, shown in Figure 2-16. It provides details about the icon that's 
currently selected (and since the icon of the disk is selected, the information win
dow is about the disk icon). 

On the bottom of the window is a large rectangular box, used for comments 
about the icon. A stubby flashing line appears in the box. This is the insertion point, 
sometimes called a cursor, which indicates where text will be placed when typed 
from the keyboard. 

Without moving the mouse or pressing the mouse button, type a line or two of 
text into the comment box in the bottom of the information window. Type any
thing-"Now is the time for all good Macs to come to the aid oftheir country." -is 
a nice start. When you get to the right edge of the box, don't press the Return key; 
the Mac will drop to the next line automatically (see Figure 2-17). 

If you make a mistake, press the Backspace key. The insertion point will move 
over the character immediately to the left and erase it. 

Now hit each key on the keyboard; the characters should print out in the com
ments box. If the box fills up and you run out of space, press the Backspace key a 
few times to erase some characters. If all the characters print in the comment box, 
the keyboard is working properly. 

While we're here, let's take a look at something very important. Use the mouse 
to move the pointer into the comment box. While inside the box, the pointer 
appears as a strange "1-beam" rather than an arrow, as shown (in Figure 2-18). The 
pointer will take on this shape whenever it lies over an area where text can be 
entered. The pointer has many personalities-the arrow and the 1-beam are just 
two of them. 
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Information about System Disk 

System Disk ~ 
Kind: disk 
Size: 97280 bytes auailable, 303104 bytes used 

Where: internal driue 
Cret~ted: Tuesday, May 22, 1984 at 9:40 AM 
Modified: Tuesday, June 19, 1984 at 7:42 PM 

D I.O( l<t~ti 

II 
Fig. 2-16. The information window for the System disk. 

El Information about System Disk 

system Disk ~ 
Kind: disk 
Size: 97280 bytes auailable, 303104 bytes used 

Where: internal driue 
Cret~ted: Tuesdt~y, Mt~y 22, 1984 nt 9:40 AM 
Modified: Tuesday, June 19, 1984 at 7:42 PM 

D to( kP.li 

Now is the time for all good Mats to come to the aid 
of their country~ 

Fig. 2-17. The words you type appear in the comments box. 
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Information about System Disk - -- -

Kind: disk 

System Disk ~ 

Size: 97280 bytes ouoiloble, 303104 bytes used 
Where: internal driue 
Created: Tuesday, May 22, 1984 ot 9:40 RM 
Modified: Tuesdoy, June 19, 1984 at 7:42 PM 

0 !.<H l<t~!i 

Now is the time for oil good Macs to come to the oid 
of their country. I 

Fig. 2-18. When the pointer is resti ng over a place 
where text can be entered, it takes on an " 1-beam" shape. 

Notice also that the pointer (whatever its shape) and the flashing insertion point 
are separate. Move the mouse: the pointer moves, not the insertion point. More 
about this in later chapters. 

Enough playing around. We've got work to do. Erase what's been written by press
ing down and holding the Backspace key. Before long, all the text wi ll be erased. 
(There's a shortcut method to erase lots of text, of course. You' ll learn about it in 
Chapter 5, "Advanced Topics.") 

To get rid of the information window, place the tip of the arrow in the smal l 
" close" box located in the window's upper left corner, as show n in Figure 2-19. Hit 
the mouse button once. The window w ill disappear. 

Do the same on the disk directory window. The disk window disappears by 
zooming back into the icon of the disk. The Mac's desktop should look as it did 
when you first started the system : just two icons and an arrow-shaped pointer. 

FINISHING UP 
So much for your first test drive of the Macintosh. But you still have to remove 

the disk and turn the Mac off. If you haven' t noticed it al ready, you soon 
wi ll - there's no eject button and no door to open to remove the disk. The Mac 
doesn't need either one; the Mac takes ca re of ejecting disks. As with the rest of the 
Mac's operations, there are a couple of ways to get the Mac to release the disk. For 
now, we' ll use the shortcut method. 
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I nformotion about System Disk 

Kind: disk 

System Disk bJ 
Size: 97280 bytes auoilable, 3031 04 bytes used 
Where: internal driue 
Created: Tuesday, May 22, 1984 at 9:40 RM 
Modified: Tuesday, June 19, 1984 at 7:42 PM 

0 lo< k•~d 

Fig. 2-19. Place the pointer in the close box (upper left corner) 
and tap on the mouse button to put the information window away. 

Press the Command key. While you hold it down, depress the "E" key. The 
Mac's disk drive will then whir into action, and within a few seconds the disk will 
come popping out. Remove the disk, and reach behind the Mac and turn it off. 

MacTip 2-7 

System disks shipped with the very first Macs had a dif
ferent version of the Finder, which required you to select the 
disk icon before you could eject the disk from the drive. 

If the drive doesn't relinquish the disk when you give the 
eject command, move the pointer over the disk icon, tap the 
mouse button once (the icon will turn black), and try ejecting 
again. 

JUST THE BASICS 

We've covered only the basics in this chapter; there's still plenty to learn. Sur
prisingly, however, the concepts in this chapter comprise more than 50 percent of 
the Mac's operation. What lies ahead is refining the ways you interact with the 
Mac -learning all the tricks. 



CHAPTER 3 

Mousing Around 

T;,e Macintosh mouse is used for many things: to move the on-screen pointer, to in
voke commands, to select text, to draw pictures, and much more. Apple designed 
the Mac with a mouse to make it an easier computer to use. The mouse has its very 
own lingo, its own special way of working, and its own do's and don'ts. 

This chapter details how to use the mouse and defines its five basic actions
moving, clicking, double-clicking, dragging, and pressing. There's also a brief intro
duction on how to use the mouse to give commands to the Mac, and how to care 
for it and clean it. 

WHY THE MOUSE? 

Any complete discussion of the Mac's mouse must include a few words about 
why Apple chose to use a mouse for the Macintosh. There are three basic reasons: 

1. To make the Mac an easier-to-use computer. 

2. To enable the Mac to draw complex pictures without relying on cursor con
trol keys or another input device. 

3. To provide some means for the user to interact with the computer's win
dows and icons. 

47 
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The Mac's mouse does the job of four cursor control keys, which allows the 
Macintosh keyboard to be simpler not only in appearance, but also in use. Even in 
its appearance the Mac seems friendlier than the average computer with 80 to 120 
keys on its keyboard. 

More than making it easier to move a cursor or pointer around the screen, the 
mouse allows pointing at icons. Icons are objects, and it's easier to refer to them by 
pointing than by name. 

Pointing is natural for everyone. For example, we might point to indicate the 
kind of donut we want in a bakery- it's far easier to point and say " that one" than 
to explain " I want the medium-size, sugar-glazed, raspberry-filled raised donut." 

Moving the Mac 's windows is another job that 's well suited to the mouse. A 
typed command to move a window across the screen would have to be complex, 
perhaps something like "WIN 1 04; 150,200" for " move window number 104 to 
coordinate 150 by 200. " 

The Mac is a graphics-intensive computer, able to produce ultrahigh-resolution 
pictures, charts, and drawings. Creating a picture is as simple as moving the mouse. 
For example, you can move the mouse as you would a paintbrush to draw a line on 
the screen, or use the mouse to drag pictures of office furniture around a scaled 
floor diagram (Figure 3-1). 

The mouse isn't the only device in the computer world that can be used to 
move a pointer, point at objects on the screen, or draw intricate designs. There are 
touchscreens, light pens, and graphics tablets that do more or less the same thing. 
All of these involve more complex circuitry than the mouse, however, which 
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Fig. 3-1. The mouse is used for more than working with icons. Among other things, it can 
be used to move furniture around an electronic floorplan proyided by MacDraw, from Apple. 
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would make the Mac more expensive. What's more, devices such as light pens and 
graphics tablets require you to grasp and lift a stylus, which can be cumbersome 
and time consuming. And touch screens don't allow very precise resolution of the 
point touched. 

It takes some time to get used to the mouse, not only because it's different, but 
because linking the motion of your hand guiding the mouse to the motion of the on
screen pointer is not intuitive. But as with most activities, practice makes perfect. 
Within 30 to 45 minutes you should be wielding the mouse like a seasoned pro. 

MacTip 3-1 

Hardware manufacturers may soon introduce alternative 
input devices for the Macintosh, including graphics tablets 
and light pens. A graphics tablet add-on would be particularly 
helpful for artists, for example, who need more control than 
the mouse can provide. Consult your dealer for information 
about Macintosh accessories-present and future. 

MOUSE-USE AND CARE 

There are right and wrong ways to handle the mouse. For starters, go easy on 
moving the mouse around the desk or table. It's no delicate piece of china, but it 
doesn't like abuse either. Don't press down on the mouse when you move it. Just 
slide it along, allowing the ball mounted in its underbelly to roll without undue 
pressure (Figure 3-2). 

The same caveat holds for the mouse button. You don't need much more than 
a slight tap to activate the button. When pressing on the button, use a gentle, easy 
stoke, almost a dabbing action. 

As mentioned in the last chapter, use the mouse only on a smoooth surface, 
preferably formica or finished wood (but not heavily waxed wood) or even a piece 
of plastic. The mouse will respond more accurately than on a rougher surface, and 
you won't run the risk of rolling the mouse over a surface (such as cloth) that could 
contaminate its delicate innards. 

You'll want to clean the mouse every now and then, not only to keep it in good 
working order, but to maintain its spunky personality. 

MacTip 3-2 

Cleaning is easy: just turn the mouse over and twist the 
dark-colored baseplate counterclockwise, as shown in 
Figure 3-3. Rotate the baseplate so the small nub aligns with 
"0," for Open. 

Using your other hand to catch the baseplate and roller 
ball as they fall, turn the mouse over again (bottom down). 
Blow out the inside of the mouse with your breath, or use a 
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Fig. 3-2. Slide the mouse around the desk; don't push or shove. 

can of compressed air for better results (compressed air is 
available at most photographic and computer stores). 

Follow by wiping off the roller ball with a clean, lint
free cloth (again, an item often found at photo stores). 
Do not use any kind of cleaner on the ball, even the "mild " 
household types. Cleaning solutions tend to harden the 
rubber. 

If there is a lot of wax or oil built up on the internal 
rollers, purchase some commercial audio cassette tape head 
cleaning solution, and use it to wipe the rollers clean . Use a 
cotton swab to apply the solution, but be sure that no lint 
from the swab gets tangled with the roller (see Figure 3-4). 

Reassemble the mouse by popping the rubber ball back 
in and replacing the baseplate. To get the baseplate back on, 
align the nub with the "Q" and then twist it clockwise until it 
locks (the nub wi ll line up with the " L"). 
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Fig. 3-3. To clean the mouse, start by removing the baseplate. 
To do this, turn the baseplate so the small nub lines up with the "0." 

THE MOUSE AND THE MAC 
You'll be doing five things with the mouse: moving, clicking, double-clicking, 

dragging, and pressing. Several of these were already briefly introduced in Chapter 
2, " Bringing Home the Macintosh." But it'~ worth covering them again. 

To follow along, start the Mac as described in the last chapter: Turn the Mac 
on, insert the disk marked " System," and wait as the Mac does the rest. Before 
long, the Mac's electron ic desktop will appear on the screen. 

Now, here are the five mouse-actions: moving, clicking, double-clicking, drag
ging, and pressing. 

Moving 
Moving the mouse is the simple process of push ing it along the surface of the 

desk, as you did in the last chapter. Moving only relocates the pointer; it doesn' t in
voke any commands or cause the Mac to behave in any particular way. When 
moving, you must not press the mouse button down. 
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Fig. 3-4. Use a swab moistened with rubbing alcohol or tape-head cleaner to clean the inside 
of the mouse. Be sure the sensor rollers are located at the top and left edges of the cavity before 

you reclose the mouse. 

An example of moving the mouse would be to reposition the pointer from the 
trash can icon to the disk icon . The instruction, if you were to read it in the manual 
for a program, might be something like " Move the pointer over the di sk icon. " 

To do just this, slide the mouse up the table or desk without pressing the but
ton . The pointer wil l move up. Stop when the pointer rests over the icon of the 
disk. As you can see, there's nothing much to mouse moving. 

If you're moving the mouse around the desk and suddenly run out of room, don't 
be afraid to pick the mouse up and move it to a spot where you have more space. 
When the mouse is lifted, the pointer wi ll stop moving until you set it down again. 

Clicking 

Pushing on the mouse button makes th ings happen. Clicking is tapping quickly 
on the button once (press and release). 
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Usually, clicking the mouse button selects or activates something. As an exam
ple, select the trash icon: move the pointer over the icon of the trash can and cl ick 
the mouse button. When the trash can icon is clicked, it turns black. An icon is 
usually selected to prepare it for a command. We'll cover this in more detail before 
the end of this chapter. 

It's important not to move the mouse wh ile clicking. That could cause some 
unwanted confusion. Moving the mouse while pressing the mouse button is a 
legitimate mouse action, however, called dragging. It's covered later in this 
chapter. 

Double-Clicking 

Double-clicking is sim ilar to plain clicking, but instead of tapping on the mouse 
button once, you depress it twice in rapid succession. " Rapid" means that the 
clicks must occur no more than about 3/.1 of a second apart. Double-clicking takes 
some practice, but you' ll soon get the idea. 

You' ll often use double-clicking to "open" an icon into a w indow, as you did 
in Chapter 2. Let's do it again. Move the pointer over the disk icon. Without mov
ing the mouse, press and release the mouse button twice quickly (the instruction 
for this group of actions would be " double"click the disk icon"). 

If you've done it right, a window will zoom out of the icon, as shown in Figure 3-5. 
Practice some more. Move the pointer over to the trash icon. Double-click the 

., 
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Fig. 3-5. When you double-click, you open icons. 
If you double-click on the disk icon, the disk directory appears. 
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Fig. 3-6. If you double-click on the trash icon, the trash window appears. 

trash icon. A window will zoom out. The trash window (Figure 3-6) should be 
empty, since you haven't placed anything in it yet. 

Maclip 3-3 

If you' re having trouble getting used to double-clicking, 
keep tryi ng. If your best effo rts fail, you can use the control 
panel to increase the time the Macintosh expects between 
clicks. Refer to Chapter 6, "Desktop Accessories," for more 
information on changing the double-click speed. 

Dragging 

The mouse provides a way to move objects, such as icons, on the Mac's elec
tronic desktop. Moving objects on the desktop is ca lled dragging, which means 
holding down the mouse button while moving the mouse. 

Dragging is both easy and fun. To try dragging, move the pointer over the icon 
labelled " Empty Folder" (i t's inside the disk directory window). Press the mouse 
button and keep it pressed. 

With the mouse button still held down, move the mouse. As shown in Figure 
3-7, moving along with the pointer will be an outline of the Empty Folder icon (the 
original icon stays put for the time being). 

Drag the outline of the Empty Folder outside the disk directory window and out 



Mousing Around 55 

onto the gray desktop. Release the mouse button. The icon of the Empty Folder w ill 
appear where you rel ease the button (Figure 3-8). 

Practice dragging by taking each icon out of the disk directory and putting it 
back in when you've finished (just don't stack them on top of one another or place 
them in the trash window.) Don't worry if the arrangement of the icons looks a bit 
messed up when you get them back in the window. In Chapter 5, "Advanced 
Topics," you'll learn how to neaten up the arrangement of icons within windows. 

Font Mov•r Disk Copy Fonts 

Trash 
OK in Tnsh 

Fig. 3-7. You can drag icons onto the gray portion of the desktop to help you better work with 
them, or drag them into other windows. When an icon is dragged, only its outline moves. 

Font Movor Disk Copy Fonts 

LJ 
Syst•m Fold•r 

it~ms OK in Tnsh 

Fig. 3-8. When dragging is complete 
and you release the mouse button, the whole icon snaps into its new place. 

Icons aren 't the only things that can be dragged about the desktop. Let's move 
a window. We'll use the information window, unveiled in the last chapter, to see 
how this is done (we cou ld use one of the two windows already open, but let' s not 
disturb th ei r placement just yet). 

Look at the Empty Folder icon. If it' s not already black, select it by clicking it. 
Follow this by pressing the Command key and the I key together (press the Com
mand key, hold it down, and press 1). Within a second or two a new window w ill 
appear on the desktop. It will be a window offering information about the Empty 
Folder icon (see Figure 3-9). 
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Kind: folder 

Empty Folder LJ 
Size: contents total 0 bytes 
Where: System Disk, internal drlue 
Created: Wednesday, May 2, 1984 at 8: I o RM 
Modified: Thursday, June 21, 1984 at 12:44 RM 

0 locked 

Fig. 3-9. The information window for the Empty Folder icon. 

., 

(Don't worry if the data in the window shown here does not match yours exactly.) 

The lined bar at the top of the window, the one that contains the title " Information 
about Empty Folder," is the title bar. You'll use it to move the information window. 

Place the pointer over any area of the title bar (except the box on the left) . Press 
the mouse button and move the mouse to drag the window. An outline of the win
dow will follow (see Figure 3-1 0). When the mouse button is released, the window 
wi ll snap to its new position. 

Close the information window by cl icking with in the square on the left edge of 
the title bar. 

Pressing 

If you hold down the mouse button but don' t move the mouse, you' re press
ing. Most often, you' ll press to tell the Mac that you want to continue an action 
the type of action depends on what the pointer is resting on. 

You' ll also press to invoke a command by means of the Mac's pu ll-down 
menus. So far, we've commanded the Mac using shortcuts. Just about everything 
we've practiced can also be done with a pull-down menu command. 

We'll take a look at one of those menus now, and practice pressing at the same 
time. Move the pointer to the top of the screen, over the word " File" (the tip of the ar
row should be somewhere on the word). Press the mouse button and keep it pressed. 

The File menu, shown in Figure 3-11 , wi ll appear. As long as the button is held 
down, the menu will stay. If you release the button , the menu will spring shut. 
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Empty Folder 
. ..... . ........ 

Kind: folder 
Size: contents total o bytes 
Where: system Disk, internal driue 
Created: Wednesday, May 2, 1984 at 8: I 0 
Modified: Thursday, June 21, 1984 at 12:44 

0 locked 

Fig. 3-10. You also drag a window to move it. 

Open 
Duplicate 3€0 
Get Info 3€1 
Put Back 

Close 
Close All 
Print 

Eje£:t 3€E 

Fig. 3-11. Pull menus down by pressing on the title of the menu. 

The Mouse and the Menu Bar 

., 

As we've just seen, the Mac holds its various menus in the menu bar, located in 
the top portion of th e screen . The mo use is used to gain access to these menus and 



58 MacGuide 

the commands contained in them. There will be a menu bar involved in just about 
everything you do, whether you're working at the desktop, as you are now, or us
ing a program such as MacPaint or MacWrite. 

The menus may change from program to program -look at the ones in Figures 
3-12 and 3-13, for example- but the way the menus are used remains the same. 

,.. 
File Edit Uiew Special 

Fig. 3-12. Here's the menu bar for the desktop. 

,. 
File Edit Search Format Font Style 

Fig. 3-13. The menu bar for MacWrite. 

This is what makes learning new programs on the Mac a snap. Once you 
master using pull-down menus, you're half way to learning to use any Mac pro
gram. And while you're learning, if you're unsure how to do something, just start 
pulling down menus and looking at each available command. 

With other computers there are no unifying command conventions. Each pro-
gram is different and therefore it's a lot harder to learn to use several programs. 

To use any Mac menu, do the following: 

1. Position the pointer over the name of the menu. 

2. Press and hold the mouse button. 

3. Select the desired command by dragging the pointer down to the name of 
the command. 

4. Let the mouse button go. 

Practice this using the File menu. Place the pointer over File and press the 
mouse button. Hold the button down and drag the pointer down the items in the 
menu. Stop when the pointer is over Close All, as shown in Figure 3-14 (Close All 
will appear highlighted). 

Now let the button go. The Close All command will automatically close the two 
open windows (disk directory and trash). Only the icons of the disk and trash can 
should be on the screen. 

Reposition the pointer over File once again and press the mouse button (see 
Figure 3-15). 



Mousing Around 59 

Look closely. You'll notice that some of the menu items appear in bold print; 
some others are dimmed. The Mac is a smart enough computer to know what it 

Open 
Duplicate XD 
Get Info XI 
Put Back 

Close 

ect XE 

Fig. 3-14. Choose a menu item (command) by holding down the mouse button and drag
ging down the menu. When the command you want is shown highlighted (black 

background), let the mouse button go. 

Edit Uiew Special 

0Ui)Uf:<l1 e '\~~'0 "J'' 

Get Info •• 
Put l~tltk 

1: lose 
{ IOS(i flU 
Print 

ect 8£E 

Fig. 3-15. When there are no windows to close, the Close and Close All commands are dim
med, showing you that they aren't active. Other currently inactive commands in the File 

menu are Duplicate, Put Back, and Print. 
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can and can't do at any particular moment. At this time, for example, there are no 
windows to close, so Close and Close All are dimmed. If you drag the pointer down 
over them, they won't be highlighted -they aren't available commands. 

This system of dimmed and bold menu items prevents you from becoming 
frustrated trying commands that aren't possible. 

MacTip 3-4 

To release a pull-down menu without choosing a com
mand, slide the mouse off the menu before releasing the but
ton. You can also move the pointer back to the menu title 
and then release the button. 

If you want to view the contents of all the menus, place 
the pointer in the menu bar and drag the mouse back and 
forth. Each menu will pull down in turn. 

SHORTCUTS, TOO 

You'll also notice that some of the items in the File menu have a strange nota
tion beside them. The item called Get Info has a X I symbol next to it. This indi
cates that the Get Info command (or more correctly, the File//Get Info command) 
has a shortcut. It's one that we've used twice in this book already. Selecting the Get 
Info command from the File menu by using the mouse is the same as pressing the 
Command and I keys together. 

To prove it, we'll try it the menu way. Click the disk icon to select it (it should 
now be black). Place the pointer on File in the menu bar and drag down to the Get 
Info command. let the mouse button go and within a second or two, the informa
tion window detailing the disk icon appears on the screen. 

Instead of closing the information window by clicking in the square box, use 
the Close command from the File menu. Once again, place the pointer over File, 
but this time drag down to the Close command. The information window will 
disappear. 

ALL THE REST 

You're probably wondering what the other menus contain. We'll cover all the 
desktop commands from each of the menus in the following chapters, but here's a 
quick rundown. 

The • (Apple) menu, shown in Figure 3-16, contains the Mac's built-in 
desktop accessories, which include a four-function calculator, an eight-page note 
pad, a scrapbook for saving pictures and text, and an alarm clock. Each accessory is 
called up as any other command would be, and each is contained in its own win
dow. Desktop accessories are covered in Chapter 6. 

The File menu, as you've already seen, provides the means to close windows 
and to get information about icons. It's also used to open icons into windows (or to 



File Edit Uiew Special 
Rbout the Finder ... 

Scrapbook 
Rlarm Clock 
Note Pad 
Calculator 
Key Caps 
Control Panel 
Puzzle 

fig. 3-16. The Apple menu. 
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start programs if the icon represents a program), to make copies of files, to print 
files, and to eject the disk (in the previous chapter, we used the Command-E short
cut method). 

The main purpose of the Edit menu is to give you a way to cut and copy text and 
place it anywhere, even in programs (see Figure 3-17). The Edit menu is one that's 
nearly the same for every program you'll use, so it's important to learn how to use it. 
Look for all you need to know about the Edit menu in Chapter 5, "Advanced Topics." 

The View menu, seen in Figure 3-18, is used to change the listing of files from 
icons to straight text. As you can see in Figure 3-19, the View menu gives you the 

r j File Uiew Special 
Undo ~J((l 

cut XH 
Copy XC 
Paste XU 
Clear 
Select Rll 818 

Show Clipboard 

fig. 3-17. The Edit menu. 
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choice of organizing the files by icons or as text. There's more on the View menu in 
Chapter 5, "Advanced Topics." 

The Special menu, shown in Figure 3-20, contains four miscellaneous, but 
nevertheless important, commands: Clean Up, Empty Trash, Erase Disk, and Set 
Startup. Once more, Chapter 5, "Advanced Topics" gives all the details. 

~ 
Siz• 

6K 

OK 

13K 

56K 

9K 

2151< 

,. J. 
• File Edit Special 

~ 

Disk Copy 

Emptg Fold•r 

Font Hov•r 

FODts 

S•~ttl• 

Sgst•m Fold•r 

------------------~bylcon 

by Name 
by Date 
by Size 
by Kind 

Fig. 3-18. The View menu. 

System Disk 
Kind 

application 

foldtr 

application 

Font Mover doO\Jt'Mnt 

Font Mover document 

folder 

~ ~-.... . ~~~ ~ ·- . . . -.... --~-. 

\o/tdl May 21 1984 

'w'td, May 2 1 1984 

'w'H 1 May 2, 1994 

'w'td1 May 2 1 1994 

'w'td 1 Apr 251 1994 

Sat1 May 26 1 1984 

Fig. 3-19. Names only; no icons. 

,. J. 
• File Edit Uiew 

Clean Up 
Empty Trash 
Erase Disk 
sf_) t S1 <n1 up 

Fig. 3-20. The Special menu. 
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THE MOUSE IS THE LINK 

We've seen the importance of the Mac mouse, and how it's used to select 
things, move things, and invoke commands. The mouse is the centerpiece of the 
Mac; nothing can be done without it. In the following two chapters, ''About Icons 
and Windows" and "Advanced Topics," you'll learn how to apply the mouse to 
get full power out of the Mac. 



CHAPTER 4 

About Icons and Windows 

Icons and windows are to a Mac what the surf and sun are to Southern California: 
There's a certain luring attraction to icons and windows, besides an undeniable 
usefulness about them. The Macintosh is a 11Visual" computer. Icons and windows 
are important contributors to this feature. 

There are certain tricks to using both icons and windows. Here in this chapter 
you'll learn exactly what icons and windows are and how to use them to their best 
advantage. You'll also learn the details about giving new names to icons and how 
to start a Macintosh program from the desktop. 

THE SECRET BEHIND ICONS 

In case you missed it the first time, let's re-examine what icons are and the role 
they play. Simply put, icons are symbols for ideas and things. An icon can represent 
a specific thing, such as a stack of papers. The stack of papers would be a complete 
document, one created by a word processing program such as MacWrite, for 
example. The papers of the icon are actually computer data-you don't see them 
as characters on sheets of paper. 

Likewise, an icon can represent a concept. The trash can always present on the 
Mac's electronic desktop represents a concept. A literal trash bin doesn't exist 

65 
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inside the Macintosh, but because of the way computers work, documents and pro
grams no longer needed on a disk can be "thrown away," simply by recording over 
them. Putting a document or program in Mac's trash can tells the machine that the 
space occupied by that document or program is now available for recording. 

Maclip 4-1 

Documents and programs are collectively called files. A 
file is anything the computer can make sense of, so just 
about every icon on the Macintosh desktop can represent a 
file. The exceptions are folders (discussed below), which 
hold other files. Even so, for the sake of simplicity, we'll con
sider folders as files, too. 

To you, it doesn't matter whether an icon represents a thing or an idea. The 
end result is the same. The Mac's Finder allows you to work with icons as you do 
concrete objects: pens, pads of paper, disks, file folders, and so forth. Icons are 
simply tools at your disposal. 

To be sure, the Mac doesn't have a corner on the icon market. You've probably 
noticed that icons are playing an increasingly prominent role in roadsigns. Gone are 
the signs that say "Gas, Food, Lodging Ahead." In their stead are picture signs. One 
shows a gas pump, another a place setting, and the third a comfortable bed. 

Icons help if you don't know the language, but their real benefit lies in a proven 
scientific phenomenon: it takes much less time for the brain to interpret a picture 
than to read and interpret a word. 

You can test this yourself. Flip through a catalog that lacks pictures and then one 
that makes heavy use of illustrations. It's far easier to spot the product you need 
simply by looking for a picture of it (which is one reason few catalogs lack pictures!). 

SEVERAL TYPES 

The Macintosh uses several kinds of icons. Because icons usually picture what 
they stand for, they're easy to identify. 

The first and most important icon is the disk icon, shown in Figure 4-1, which 
represents the disk currently loaded into the Mac's drive. 

System o;sk 
Fig. 4-1. An icon of a disk. 
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The disk icon is much like a file drawer. If you open the disk icon, you'll see the 
contents of the disk (drawer), which invariably include documents, folders, and 
programs. The disk icon is easy to spot, it looks just like a Mac JV2-inch disk. 

The program (or application) icon, represents programs that run on the Macin
tosh. Two examples of programs are MacWrite and MacPaint, whose icons are 
shown in Figure 4-2. MacWrite, represented by the icon on the left, is a word pro
cessor, used to write, edit, and print all types of written documents. MacPaint is 
m,uch like MacWrite, but it deals with picture documents instead of word 
documents. 

Fig. 4-2. Two program icons. 

Most programs look like a hand drawing on a piece of paper. But programs can 
take any form -their shape is controlled by the software programmer. If you see a 
strange-looking icon on the screen, odds are it represents a program. 

Document icons are the third major type of icon; they are distinguishable by 
their dog-eared paper appearance (see Figure 4-3). With the aid of the right program, 
the Mac can create any kind of document: text, picture, number, you name it. 

--------------------------------------
Fig. 4-3. A document icon. 

MacTip 4-2 

Documents can't usually be shared among programs. 
For example, a MacWrite document can't be used by Mac
Paint. If you try to use a document with the wrong program, 
the Mac will tell you that an application can't be found to 
open that document. 
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A bunch of icons scattered around the Mac's desktop would look untidy and 
make the Mac harder to use. To the rescue: file folder icons. As you may have 
guessed, file folder icons are used to hold other icons-documents or programs. In 
fact, they can even hold other file folders. You could conceivably have file folder 
within file folder within file folder. 

File folder icons are more effective, however, if you use them as you would real 
file folders. That is, put like items together within a file folder for easier handling 
(see Figure 4-4). 

Fig. 4-4. Use folders to store other icons. 

The Mac can create an unlimited number of file folders, all from the one 
named "Empty Folder." You'll learn the details in the Chapter 5. 

There are plenty of miscellaneous icon types, most of which are self
explanatory by their appearance alone. For example, there's the trash can (there's 
only one per Mac), and the system files, shown in Figure 4-5, most of which look 
like tiny Macs. 

Unless you do some programming, you won't have cause to work with a Mac 
system file icon. System files are housed in the System Folder, and needn't ever be 
bothered with. (There is one instance in which you may have contact with them, 
however-when making a Startup disk. Look for details in Chapter 5, "Advanced 
Topics.") 

ANATOMY OF AN ICON 

Icons have different appearances, but all icons are made up of the same two 
ingredients: body and name. The body of an icon is the actual graphic picture-file 
folder, disk, or piece of paper, for example. The name is the title that always 
appears underneath, identifying the icon, such as "System Disk" or "MacWrite" 
(see Figure 4-6). 
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Fig. 4-5. A system file used by the Macintosh. 

•(----- Body 

MacWrite .. (----Nome 

Fig. 4-6. Icons have two parts: body and name. 

MacTip 4-3 

Whenever you discover a strange icon, you can easily 
tell what it is (document, application, or whatever) by select
ing it and calling up its information window. 

It's important to think of icons as having two discrete components, because it's 
possible not only to provide new names for icons, but to delete the graphic portion 
altogether and leave only the name. 

Changing icons into names only is a job for the View menu, covered in detail in 
the next chapter. Here we'll discuss how to change icon names. 

Unlike most other computers, which require you to use a confusing command 
to change the name of a file, changing the name of a Mac file is a simple matter of 
selecting the icon that represents the file and typing in a new name. All you need to 
do is to select the icon to be renamed by clicking it and to type any character from 
the keyboard. The original name will immediately disappear, and the typed 
character will take its place (see Figure 4-7). For disks, you can type any name up to 
27 characters long. 

Feel free to use any character you like in the name, even blank spaces ("This is 
my first Mac disk," is an acceptable, if somewhat long, name for a disk). There is one 
character the Mac's Finder won't let you use, however-the colon. The Finder 
reserves that character as a code to differentiate between disks in its drives. It's also 
a good idea to avoid periods at the start of the name. 

The same naming rules hold for file icons, except you're given up to 63 
characters for each file name. Realistically, you'll want to keep file names as short 
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System Disk 
6 items 303K in dislc 

~ ~ 
Disk Copy s~attle 

LJ 
Syst~m Fold~r • New Narn£- for Empty Fold£-~ 

Fig. 4-7. To rename an icon, select the icon and start typing. 

as possible, since they have a tendency to overlap one another on the Mac's screen 
if they get too long (see Figure 4-8 for an example). It's conceivable that an overly 
long icon name could completely obscure the name of an icon next to it. 

MacTip 4-4 

Because of the way the Mac works, it's important not to 
touch the keyboard while a desktop icon has been selected. 
Exceptions are when you're issuing commands with the 
Command key. Should you accidentally strike a key when an 
icon is selected, you'll erase the name of the icon, and you'll 
have to type it back in. 

MacTip 4-5 

The Mac won't let you give two icons the same name. 
The reason for this is obvious: the Mac must be able to sort 
through its files without confusion. Give all icons-disks, 
documents, programs, and folders -different and mean
ingful names. 

By the way, there are more elaborate ways to edit icon names by means of the 
Mac's built-in text-editing features. Editing is covered in depth in Chapter 5, 
"Advanced Topics." 
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stem Disk 
6 itMRs 303K in disk 

Font Mover Disk Copy Fonts Seattle 

Fig. 4-8. Avoid using long names; they can overlap onto other icons. 

OPENING NIGHT 

We've al ready discovered how the disk and trash icons can be opened into 
w indows by double-clicking on them. You can also open icons by selecting them 
and then choosing the File//Open command. 

What happens when one of the other types of icons is opened depends on the 
kind of icon it is. If the icon is of a fi le folder, it, too, will open into a window. Inside 
the window, as shown in Figure 4-9, wi ll be the icons of files contained in the folder. 

If the icon is of a program or document, however, something different hap
pens. Double-clicking a program document icon such as MacWrite, for instance, 
starts MacWrite. After a few moments, sta ring back at you is MacWrite, complete 
with an empty page, ready for you to start w riti ng. 

0 System Folder 
1481( in fo ld~r 

System Findt>r lmagewriter Clipboard File Nott> Pad Filt> Scrapbook Filt> !<) 
K;ll IQ QJ 

Fig. 4-9. Inside the System Folder are more icons. 
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Opening a document icon does essentially the same thing, but with a slight dif
ference. When you open a MacWrite document icon, the Finder starts MacWrite and 
then automatically puts the document on the writing page. It's ready for you to edit. 

MacTip 4-6 

With single-disk-drive Macs, document and program 
must be on the same disk. If you have a two-disk Macintosh, 
however, it's perfectly acceptable to have the program in 
one drive and the document in the other. 

WINDOW MAGIC 

Any real desk lets you scatter papers about. There's probably scientific proof 
around somewhere that shows it's healthy to spread your work around. For some 
of us, at least, it seems to make it easier to work and to be productive. 

With the help of the Finder and its multiple-window capability, the Mac lets 
you spread work over its electronic desktop, too. You can fit an infinite number of 
windows on the Mac's screen. Actually, infinite may be an overstatement. Almost 
infinite is better. Nevertheless, you can place so many windows on the Mac's elec
tronic desktop that you'll overcrowd the screen and lose your way. 

The Mac is capable of creating several kinds of windows. Some are completely 
adjustable: you can alter their size, move them around the screen, open and close 
them at will, and more. These are the windows you'll encounter when working 
with desktop icons such as the trash, disk, and file folders. We'll call these, for the 
lack of a better term, full-featured windows. More about these in a second. 

Others are more limited, perhaps allowing you to move them around the desk, 
but not to change their size. Windows that fall into this category include the Mac's 
desktop accessories, covered in detail in Chapter 6, "Desktop Accessories." 

Finally, there's the kind of window that you have no real control over. You 
can't move or resize these windows, and their presence is controlled more by the 
Mac than by you. These are called alert and dialog boxes, and they are discussed at 
the end of this chapter. 

MOVING AROUND 
Most full-featured windows are made up of the same ~~parts' (we say most 

because there are always exceptions). The typical full-featured window is shown in 
Figure 4-10. This one was created by opening the disk icon. 

You've already been introduced to some of the more important components of 
the window. It wouldn't hurt to take a more serious look and to practice working 
with windows in the process. 

If you read the last chapter, you know that windows can be moved around the 
desktop by dragging them by their title bar-placing the pointer anywhere within 
the title bar (except in the square box at the ieft), and then dragging the mouse (see 
Figure 4-11). 
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stem Dislc 
7 ittoms 303K in disk 97K ~nil~b Ito 

~ ~ ~ ~ 
Fon~ Mover Disk Copy Fon~s Seat~le 

CJ CJ 
Sys~em Folder Emp~y Folder 

Fig. 4-10. The typical Macintosh wi ndow. 

Fig. 4-11 . Drag a window by tugging at its title bar. 
Place the pointer anywhere except inside the close box. 

As is true for icons, the window itself doesn' t move. W hat you see trailing the 
pointer is an outl ine of the w indow. W hen the mouse button is released, the w in
dow will jump to the position of the outline. 

Practice dragging the disk directo ry window all over the desktop. Don't worry 
about covering up either the d isk or trash icons. Nothing will happen to them 
under the w indow. 

You' ll notice that it' s impossible to move a window completely off the desktop . 
At least some porti on of its title bar w ill rem ain visible. Try pushing the window all 
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the way off the left edge. A tiny strip of the title bar will still peek through, enough 
so that you can grab it with the mouse and pull the window back into view. 

SIZE COUNTS 

There may be times when you don't want the entire contents of a window 
displayed. (The contents will still lie behind the window, but the viewport will be 
smaller, so you won't be able to see everything at one time.) Or the window may 
be too large for its contents and may waste precious desktop space. In either case~ 
you'll want to shrink the window to make a better fit. 

On the other hand, there may be times when the window is too small to do 
much good. You'll want to enlarge it as required. Resizing-both shrinking and 
enlarging-is done with the aid of the size box, located in the lower right corner of 
the window (Figure 4-12). 

Windows can take just about any shape you can think of: tall and thin, short 
and fat, and everything between. This flexibility can come in handy; you can resize 
windows to best fit their contents. 4: 

To resize a window, drag the size box; an outline of the window will appear as 
its size box is dragged (see Figure 4-13). When the window is the right size and 
shape, let the mouse button go. The window will spring into the shape provided by 
the outline. 

MacTip 4-7 

In most cases, window size and placement on the 
desktop are remembered by the Macintosh and recorded 
onto the disk. If you make a change, the next time you open 
the window it will be as you arranged it. 

PANORAMIC VIEWS 

If some part of a window's contents is blocked from view, and you want to see 
the whole picture, you must either resize the window to reveal everything that lies 
behind it, or use the scroll bars to move the contents back and forth. 

Most windows have both horizontal and vertical scroll bars. With a horizontal 
scroll bar, located at the bottom of the window, you can move the contents of the 
window right and left. With a vertical scroll bar, located at the right of the window, 
you can move the contents up and down. Notice that in both cases, the contents 
are moved, not the window itself. 

Scroll bars usually don't appear unless there's something more to see. When 
the window has more to offer, one or both of the scroll bars will appear shaded. 
Within the shading will be a box. 

There are several ways to use the scroll bars. The easiest is by using the mouse 
to press the scroll arrows, located at the ends of the bars. The contents of the win
dow scroll one text line at a time in the direction of the arrow. 
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Fig. 4-12. Close-up of the size box. 
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Fig. 4-13. Drag the size box to alter the size and shape of the window. 

Try this out. If necessary, resize the directory window so that at least the 
horizontal (bottom) scroll bar becomes shaded. 

Place the pointer on the right scroll arrow as shown in Figure 4-14 and press the 
mouse button. Keep it pressed. Quickly, the window will scroll to the left, revealing 
any icons that may be to the right of the window's field of vision. 

Press the left scroll arrow. The window will scroll back to its original position. 
As you're scrolling, the box within the scroll bar scuttles back and forth. This box is 
called the elevator (with the Mac, elevators go up and down and side to side). The 
scroll arrows are used to move the contents of the window one line at a time. The 
elevator scrolls large blocks at a time. 

To use the elevator, drag it along the length ofthe scroll bar. The position ofthe 
elevator indicates the view of the window (see Figure 4-15). For example, an 
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Fig. 4-14. Press inside one of the scroll arrows to pan the contents of the window. 
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Fig. 4-15. Pressing an elevator does the same thing as pressing a scroll arrow. 

elevator on the left side of the horizontal scroll bar indicates that you're looking at 
the leftmost portion of the window's contents. 

MacTip 4-8 

To scroll by the windowful, click within the shaded por
tion of the scroll bar. Each time you click, the window will 
scroll forward or backward. 
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OPEN (AND CLOSE) SESAME 

In the previous chapters, we've opened and closed windows using a variety of 
techniques. Let's cover these techniques one last time to make sure we understand. 

Since most windows are created from icons, they are opened either by double
clicking the icon or by clicking (selecting) the icon and choosing the Open command 
from the File menu. Windows that enclose desktop accessories aren't opened this 
way. Rather, you call up desktop accessories by selecting them from the *menu. 

Once a window is displayed and on screen, it can be closed in either of two 
ways. The easier way is to click in the small box-the close box-located in the 
upper left corner of the window (Figure 4-16). 

7 item 
fig. 4-16. Close-up of the close box. 

The other way, as you've already seen, is to choose the Close command from 
the file menu. 

ACTIVE SERVICE 

The Mac can display several windows at any time, yet only one at a time can be 
"active." Any window can be active; you choose which one simply by clicking 
anywhere within it. 

Test this. Open the trash window by double-clicking the trash icon. As in Figure 
4-17, on the bottom of the desktop will be a wide, squat window, with nothing inside. 

Look at the directory window. It's changed. The title bar no longer has stripes 
in it, and the close box is missing. This indicates that the directory window is no 
longer active. Active status has gone to the trash window, which does have stripes 
in its title bar, as well as a close box. 

Move the pointer anywhere within the directory window and click the mouse 
button. Automatically, the trash window goes dormant (but is still visible, of 
course), and the directory window is reactivated. 

Let's open up another icon, the one marked System Folder. Double-dick the 
System Folder icon, and yet another window appears on the desktop. (Its place
ment may not be exactly like that pictured in Figure 4-18, but that doesn't matter.) 
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Since the System Folder was just opened, it becomes the active window. Both 
the trash and disk directory windows go dormant. Click in each window in turn 
and watch how easy it is to make another window active. 

., 

Font Movtr Disk CoPIJ Fonts s .. m. 

CJCJ 
Syst•m Fold•r Empty Fold•r 

Fig. 4-17. One active and one inactive w indow. 
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f ig. 4-18. When you add another wi ndow, it becomes the active one. 
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Deactivated windows lack a close box, and choosing the File//Ciose command 
closes only the active window. To close a dormant window, you must either acti
vate it and then close it, or choose the Close All command from the File menu. 

Selecting File// Close All closes every window on the desktop, so make sure this 
is what you want to do. File II Close All is handy when you have lots of windows on 
the desktop, and don't want to have to close each one in turn. 

MacTip 4-9 

Normally, moving a dormant window activates it. If 
you don't want to activate a window when you move it, 
press the Command key while dragging the window. It will 
remain inactive. 

MILE-HIGH WINDOWS 

As shown in the figures above, Mac's windows needn't be placed side by side. 
There's nothing wrong with stacking windows on top of one another. In fact, you 
can stack window on top of window on top of window. 

Stacking is helpful when you don't need to see the contents of the window, yet 
you want to keep it handy for quick reference. Stack up three or four windows in 
the upper left corner of the desktop, for example, and go back to them only when 
necessary. 

The active window always appears on the top of the stack. You can activate 
another window and bring it to the top of the heap if at least some part of it can be 
clicked with the mouse. The previously active window slips down one level, right 
under the newly activated one. 

If the window you want isn't visible-that is, the windows on top are just too 
big-you'll have to drag windows around to uncover the one you want. 

MacTip 4-10 

You can bring a window to the top of the stack by finding 
its icon and double-clicking it. If you're looking for a desktop 
accessory, reselect it from the Apple menu. That will bring it 
back to the top. 

THE MAC'S OTHER WINDOWS 

just about everything the Mac does is centered around some type of window. 
Even the messages the Macintosh relays to you appear in windows. The Mac has 
two main types of messages: the alert box and the dialog box. 

Alert boxes are just what their name implies. The Mac is warning you 
something terrible has just happened, or more likely, is about to happen if you 
don't take corrective measures. 

A typical alert box is the one you get after using one of the Mac's programs, 
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such as MacWrite. If you try leaving MacWrite without first saving a copy of your 
document on the disk, an alert box appears asking you if you'd like to save the 
document before quitting the program (Figure 4-19). 

Saue changes before quitting? 

( Yes J 
[ No ) ( Cancel J 

Fig. 4-19. A typical alert box (a kind of window). 

To get your attention, most alert boxes appear on the screen accompanied by a 
beep or two. 

As in the MacWrite example, you can "answer" most alert boxes by clicking one 
of the buttons that appear within the window. The meaning of each button is usually 
self-explanatory-"Yes," "No," "OK," "Cancel," and so forth. Just remember that 
with alert boxes, you'll have to answer the question before you proceed. If you try to 
proceed without answering the box, the Mac will beep to remind you. 

Occasionally, whenever the software programmer thought of it, you'll spot a 
button that's been double-outlined (see Figure 4-20). This is the "default" button, 
the choice that will be selected if you merely press the Return key. In addition, 
when there's only one button, pressing the Return key does the same as clicking 
the button with the mouse. 

Yes I 
Fig. 4-20. A double-outlined button. Press the Enter or 

Return key to choose the outlined option, or click on the button. 

Dialog boxes are little different from alert boxes, but they come in many more 
shapes and sizes. Their purpose is to ask for supplementary information about an 
action or command. 
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For example, MacWrite's Print dialog box, seen in Figure 4-21, asks which 
pages you want printed, what print quality (high, standard, or draft) you would like, 
and how many copies you want. To select an option, just click in the round 
pushbutton. When all's done, click the OK button to begin printing. 

Like alert boxes, some dialog boxes have a button with a double outline. To 
choose the outlined option, press Return. Sometimes, but not always, you can tem
porarily ignore a dialog box and merrily continue computing. 

Quality: 0 High ® Stondord 0 Droft QQ 
Page Range: ® Rll 0 From: D To: 0 
Copies: EJ 
Paper Feed: ®Continuous 0 Cut Sheet ( Cancel ] 

Fig. 4-21. A dialog box that offers you several 
"settings" options. Select a setting by clicking within a circle. 

ALL IN A DAY'S WORK 

Congratulations! You've learned more about the Mac in this past chapter than 
most people learn about the "average" computer after reading an entire book. 
What's left? You have yet to hone your skills. Turn the page to Chapter 5, "Advanced 
Topics." 



CHAPTER 5 

Advanced Topics 
More About Icons, Windows, and Commands 

The test of any computer is how flexible it is. With the Macintosh, flexibility is 
provided by the Finder, a computer program always present but hidden from view. 

The Finder does many things -it makes copies of files, moves files from one 
disk to another, edits text, and more. You'll make use of the Finder the most while 
working at the Mac's electronic desktop. 

In this chapter you'll learn the finer points of using the Mac and its Finder-in 
short, how to become an expert on the Macintosh electronic desktop. 

DOING BUSINESS WITH ICONS 
You've already seen how icons can be dragged on the desktop with the aid of 

the mouse. Pushing icons around the desktop is fun, for a while at least. But the 
real magic is what moving icons can do for you. Specifically, icons can be moved 
between windows to deposit files in a folder, for instance, to transfer files between 
disks, or even to throw a file away. 

If you haven't already, turn on your Mac and insert the disk marked "System." 
After a moment, the Mac's electronic desktop will appear, as shown in Figure 5-1, 
and it should display an icon of a disk and an icon of the trash can. 

83 
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Open both trash and disk icons by double-clicking them (alternatively, select 
each one in turn and open it with the File // Open command). When you've finish
ed, your Mac desktop should look something like Figure S-2. 

'" • File Edit Uiew Special 

Fig. 5-1. Once again, the familiar Macintosh opening desktop. 

r • File Edit Uiew Special 
., 
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00 
Svstem Foldtr Emptv Foldor 

Fig. 5-2. The trash and disk windows opened and ready for work. 
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The most basic window-to-window icon operation is throwing unneeded files 
away. We' ll use the one marked Empty Folder for practice. 

Drag the Empty Folder icon out of the disk directory window and into the trash 
window. Remember that when you drag an icon, only its outline appears to move. 
When the mouse button is released, the icon will zip into its new place (see Figure 5-3) . 

., 

F on I Movor Disk Cop<J Fonts s .. ttlr 

Fig. 5-3. Dragging the Empty Folder icon into the trash window. 

What's been done? The Empty Folder icon has been transferred from the disk to 
the Mac's trash bin, in preparation for deleting it-all that by simply moving the 
Empty Folder icon from one window to another. 

As it stands, the Empty Folder icon can still be retrieved, because the trash 
hasn' t been "emptied" yet. We don 't want to get rid of the Empty Folder icon 
(because it's needed to make other fo lders), so let' s move it out of the trash win
dow. Just do the reverse of the exercise above. Drag the icon out of the trash win
dow and into the disk directory window. By the way, you ' ll see how to empty the 
contents of the trash later in this chapter. 

Practice some more to see how easy it is to put icons into folders. First, close 
the trash window (click its close box), and then open the icon marked System 
Folder. For more practice, open the Empty Folder icon (see Figure S-4). 

Displayed within the newly opened System Folder are several system files used 
exclusively by the Mac. If any w indow blocks the others, drag it out of the way (see 
Chapter 4, " About Icons and Windows" if you're unsure how to do this) . 

Drag the system icon marked " Scrapbook" from the System Folder window 
and place it in the Empty Folder w indow. Take a few more system file icons of your 
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Fig. 5-4. For more practice: open the Empty Folder icon . 

choosing into the Empty Folder. The Mac desktop should now look something like 
Figure 5-S. 

At this point, the windows could be closed in the usual manner, and the icons 
would become a part of their respective folders. But let's not do that here. Pull the 
icons back out. 

TRICKS OF THE TRADE 

Folders needn't be open, as they were in the previous exercise, to accept 
icons. They can be closed -still in their icon shape. 

To see how icons can be put into closed folders, make sure all the system 
icons are back in the System Folder, and close the Empty Folder window (you may 
have to react ivate the Empty Folder window- by clicking anywhere within it -to 
close it). 

Drag the Scrapbook icon from the System Folder window over to the icon of 
the Empty Folder. Place it right over the Empty Folder icon, as shown in Figure S-6. 

When the Empty folder icon turns black, you know it's ready to accept the 
Scrapbook file. Let the mouse button go, and th e Scrapbook icon wil l disappear. 
It's been included in the Empty Folder icon. Prove it to yourself by open ing the 
Empty Folder icon. Move the Scrapbook file back to th e System Folder. 

Do the same when throwing unneeded files in the trash. Instead of opening the 
trash icon into a window, keep it closed and simply pop the icon over the can. 
When the trash turns black it 's ready to take the icon. 
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Fig. 5-5. The Scrapbook File (and other files) , in the Empty Folder window. 
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Fig. 5-6. Lay an icon over a folder and let the 
mouse button -go. You drop that icon (and the file it represents) into the folder. 

Maclip 5-1 

If you place an icon on a closed disk, folder, or trash icon 
that doesn 't turn black, take the icon off and try again . The 
" receiving" icon must turn black before it will accept anything. 

DISK TO DISK 
Dragging icons from window to window is only part of the picture. The real fun 

comes when you transfer files from one disk to another. 
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Placing a copy of a file on another disk is much the same as moving icons from 
window to window on the desktop. The procedure differs slightly, however, 
depending on the number of disk drives your Mac has. Even so, the basics are the 
same for both operations. 

Transferring with a Single-Drive Mac 

1. Start by making sure the icon that represents the file you want moved is visi
ble on the desktop, either resting within the disk directory window or out on 
the open desktop (see Figure 5-7). 

stem Disk 
6 it~ms 311K in disk 

Font Mov~r Disk Copy Fonts Seaitl~ 

Fig. 5-7. Pick out the icon to copy to the other disk. In this case, it's the Empty Folder. 

2. Eject the disk by giving the File//Eject command, or by pressing the Com
mand and E keys (you may need to check the disk icon before you can eject 
the disk) (see Figure 5-8). 

3. Insert the second disk-the one that will receive the copy-into the drive. 
This can be either a brand-new disk, or one that you have used before. After 
a short time, the icon of the second disk will appear on the desktop (see 
Figure 5-9). 

4. Drag the icon to be transferred on top of the icon of the new disk. When the 
disk icon turns black, let the button go. The transfer process will now begin. 

5. As the Mac is transferring the file, the Finder will prompt you as to which 
disk it needs. You may have to "swap" the disks up to a dozen times to copy 
a file from one disk to the other. 
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Fig. 5-8. Choose the File//Eject command to get the disk out of the drive. 

Fig. 5-9. Put the new disk in the drive. Note that the System Disk icons are shown 
dimmed. This means that the files the icons represent are not on the disk currently in the drive. 

Transferring with a Two-Drive Mac 

1. Put the two disks (the one with the file to be copied, and the one that will 
receive the copy) in the drives. 

2. Slide the icon to be copied over the icon of the other disk. The rest is handled 
for you. There 's no need to swap disks. 

MacTip 5-2 

Any disk with the System Folder is a Startup disk. To 
make a Startup disk, copy the System Folder. You can use the 
disk named System; in addition, most di sks with applications 
have the System Folder on them. 
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When the transfer is complete, a copy of the file will be on both the first and 
second disks. If you don't plan to keep the original, you'll have to throw it away by 
depositing it in the trash (followed by "emptying" the trash, covered at the end of 
this chapter). 

COPYING ICONS 

Transferring icons from disk to disk automatically makes copies. You can make 
copies of any file on a disk yourself. Just use the File// Duplicate command. 

Start by clicking the icon of the file to be copied. Create the duplicate either by 
pressing the Command and D keys together, or by choosing the Duplicate com
mand from the File menu (Figure 5-1 0). 

Put Back 

[!OS(~ 

[~OS(~ fJJJ 
Print 

Uieu.• Special 

ect XE 

fig. 5-10. The File// Duplicate command. 

MacTip 5-3 

To copy the entire disk, lay the icon of the disk you want 
to copy over the icon of the disk that is to receive the copy 
(old over new). Answer the alert box and swap the disks as 
requested (obviously, you won't need to swap disks if you 
have an external drive hooked up to the Mac). 

For faster single-drive copies, use the Disk Copy utility 
program provided by Apple. For details on this program, see 
Appendix D, "Disk Copy." 

If there's enough room on the disk for the new addition, the Finder will 
duplicate the selected file and give it the prefix "Copy of." So, if you're copying the 
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Empty Folder icon (which you'll do often to make new folders), the clone will be 
named "Copy of Empty Folder" (see Figure 5-11 ). 

Complete the copy by giving a new name to the icon. Use the system of renam
ing icons that you learned in the last chapter. As you'll probably learn sooner or 
later, the Finder won't allow you to choose a name already in use. 

For example, if you already have a folder named "Documents," you can't have 
another with the same name. You'll have to differentiate between the two by giving 
the second one a name such as 11 Documents-1" or "Very Special Documents." Of 
course, the choice is up to you. 

Maclip 5-4 

Programs and files that have been copy-protected can't 
be duplicated or moved. If you try to move a protected file 
from one window into another, or duplicate it, the Mac will 
tell you you're up to no good (see Figure 5-12). 

But a funny thing happens: You may not be able to 
manually move a protected icon back into its original win
dow once it's been taken out! If this happens, choose the 
File//Put Back command, as described later in this chapter. 

A copied file will be the exact duplicate of the original (with the exception of 
the name, of course) and can be handled separately. Once a file has been copied, it 
can be moved into other windows, onto another disk, and so forth. 

If, by chance, there's not enough room on the disk for the copy, the Finder will 

stem Disk 
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Fig. 5-11. The new addition: Copy of Empty Folder. 
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That may not be duplicated or moued. 

Fig. 5-12. This alert box appears when a program can't be copied. 

tell you so in no uncertain terms (see Figure 5-13). The disk simply hasn't the space 
to accept the new addition. You'll have to copy the file to another disk or delete 
some other files to make room. 

As with many Mac commands, you can use the Duplicate command on several 
files at a time, using the multiselect skills covered in Mac Tip 5-5. As shown in Figure 
5-14, if the disk has enough space, the Finder will copy all the selected icons. Each 
will have the prefix "Copy of." 

MacTip 5-5 

There are several ways to select more than one icon at a 
time for copying files, for example. One is to use the 
Edit //Select All command, used to select all the icons in the 
active window. To select all, choose the Select All command 
from the Edit menu (Figure 5-15) or press the Command and 
A keys together. 

Other, more flexible, methods are Shift-clicking icons and 
dragging over icons. To select several icons by Shift-clicking, 
hold down the Shift key and click the icons in turn. Each one 
will turn black. The icons can now be handled together. If you 
do something to one, you do it to them all. For example, if you 
place one in the trash, you put them all there. 

Dragging over icons to multiselect them works when the 
icons are grouped together. To select, place the pointer out
side one corner of the group (but not on an icon) and drag 
over the group. A dotted box will form as you drag over the 
icons. Release the button to select the icons. Once again, the 
icons can now be handled as a group. 

INFORMATION, PLEASE 

You've already been introduced to the information window in past chapters. 
But because of the importance of info windows, they deserve a close, hard look. 

As you'll recall, info windows are brought onto the Mac's electronic desktop 
by selecting an icon, then choosing the File//Get Info command (either by pressing 
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Fig. 5-13. When there's not enough room on the disk for another copy, the Finder tells you so. 
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Fig. 5-14. Copying three files at once. Select all three and give the Fi le//Duplicate command. 

the Command and I keys together or by selecting Get Info from the File menu) (see 
Figure 5-16). 

Here's what every informat ion window tells you: 

• The name of the file. 

• The kind of file (folder, application, and so forth). 

• The size of the file, in bytes (one byte is equal to one letter, number, or other 
character- so a file 6,587 bytes long has 6,587 characters in it). 

• The amount of disk space the file takes up (usually more th an the size of the 
file). 

• The location of the file, whether in the internal drive o r the external drive. 

• The name of the disk w here the file resides. 

• The date and t ime the fi le was first c reated. 
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Fig. 5·15. The Edit//Select All command. 
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Fig. 5-16. The File//Get Info command. 

• The date and time the file was last modified. 

• Whether the file is "locked" or unlocked (more about this in a bit). 

• A brief comment about the file, usually written by you, but sometimes by 
software programmers. 

As you can see, there's a lot to an information window. Some of the info you 
may never care about, but it's nice to know it's there if you need it. 

The purpose of information windows is two-fold: 
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1. They provide more data about a file than can be conveyed in a title or an 
icon. 

2. They remind you of what the files are a month, two months, even a year 
after you create them. Whenever you need more data about a particular file, 
just call up its information window. It will all be there. 

THE LOCK BOX 

The "Locked" box, found in the lower left portion of the information window, 
is like a light switch. An unmarked box means the file is free to be changed or 
deleted. 

Click inside the box (an "X" will appear) and the Finder locks the file against 
erasure or alteration (Figure 5-17). You'll be able to see the file while you work at 
the desktop; and if it's a document, you'll be able to view its contents with the pro
gram that created it. But you won't be able to alter the file. 

To unlock the file (in order to change it or delete it), just click the box once 
more. The X-mark will disappear. Incidentally, the information windows for the 
disk and trash icons display a dimmed "Locked" option. As you may have guessed, 
there's no way to lock these in the normal way. But that doesn't mean you can't 
lock an entire disk from accidental erasure or alteration. Check the following Mac
Tip for details. 

YOUR COMMENTS WELCOME 

The comments box at the bottom of the information window is large enough to 
hold a sentence or two about the file. When the info window is brought out onto 
the desktop, the insertion point (the flashing line) is placed at the start of the com
ments box, indicating that text can be typed from the keyboard. Anything written 
will be placed in the box, as in Figure 5-18. Keep reading this chapter for more 
details about writing and editing text. 

Modified: Wed 

~Locked 

[ 
fig. 5-17. Click the Locked box to prevent accidental erasure or alteration of a file. 
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~ lnformotion obout Empty Folder 

Empty Folder 0 
Kind: folder 
Size: contents total 0 bytes 
Where: System Disk, internal driue 
Crented: Wednesdny, May 2, 1984 at 8:1 0 AM 

Modified: Wednesdoy, June 20, 1984 ot 2:12 PM 

D Locked 

Write ony comments you moy haue here. The Mac 
keeps it until you erase it~ 

Fig. 5-18. The comment box in an information wi ndow 
holds about 30 words, more than enough for an accurate description of the file. 

COMPLETING THE WIN DOW 

Changes made to the information window - locking, unlocking, and com
ments -are saved with the file. In fact, the information window is part of the file. 
When you make copies of the file, the information window, comments, and lock 
status are copied, too. 

AUTOMATIC PUT BACK 

In past chapters, we've talked about all the File menu items except the Put 
Back and Print commands. It' s not that these aren't important. On the contrary, 
they serve important purposes and are used quite often. 

Maclip 5-6 

To lock an entire disk against erasure or alteration, slide 
the tab (located on the underside of the disk) away from the 
hub. To unlock the disk, slide the tab back toward the hub. 

Though it's usually a good practice to lock (also called 
" write protect") disks, some Macintosh programs and 
faci lities won' t work properly with disks that are locked 
(MacPaint won't work properly with a locked disk, for exam
ple) . It 's better to lock the individual files on the disk than to 
lock the disk itself. 
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Mac's Finder is an intelligent rascal-smarter than you may think at first. The 
Finder knows, at all times, where files belong-which folders they fit into, which 
disks they belong to, and so on. 

Suppose you've pulled out four or five icons on the desktop from different 
folders, and now it's time to replace them in their respective folders. There's no need 
to drag the icons back into the folders manually (and possibly place them in the 
wrong ones). Instead, give the File//Put Back command, as shown in Figure 5-19. 

When the File//Put Back command is given, all icons return to their rightful 
folders. If you've used some icons from another disk, the Finder will replace them 
in the proper disk directory (you may need to swap disks in and out of Mac's drive 
as the Finder closes up shop; even so, it's only a slight inconvenience). 

In operation, the Mac marks where files belong-in which folders and on 
which disks. When you move files around, you change the marks, so the Mac 
always has a handle on where things belong. When you put a file into a folder or 
disk window, and close the window, you automatically relocate that file. The same 
holds true when you put a file into a closed folder or disk. 

MacTip 5-7 

The File//Put Back command is particularly helpful when 
you've accidentally thrown icons away (no icons call the 
trash their home, so even though you may have put files into 
the closed trash icon, the Finder remembers where they 
originally came from). 

To get a file out of the trash and put it back where it 
belongs, open the trash icon, select the file, and then issue 
the File//Put Back command. 

Edit Uiew Special 
Open 
Duplicate xo 
Get Info XI 
Put HiH k , 

[lose 
t: lOS<~ flU 
Print 

Eject ME 

Fig. 5-19. The File//Put Back command. 
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PRINT: THE LAST OF THE FILE COMMANDS 

The last important File command, Print, is used whenever you want to make a 
paper copy of a document, whether that document is a letter, a picture, a group of 
numbers, or any of the other myriad images the Mac creates. 

To print, select a document icon, and then choose the Print command from the 
File menu (see Figure 5-20). After a moment, printing will begin (of course, a 
printer-such as the Apple lmagewriter-must be properly connected to the Mac 
for this operation). 

To print out any document, the program that created it must be present on the 
disk. Otherwise, the Finder won't know how to print the document and will give 
you a message like the one shown in Figure 5-21. 

If the program, such as MacWrite or MacPaint, is on one disk and the docu
ment is on another, there are still ways to get a printout. 

Here, as an example, is how you'd get a printout of a document on another 
disk with MacWrite (other programs may be slightly different): 

Edit Uiew Special 
Open 
Duplicate XD 
Get Info XI 
Put Back 

I: lose 
[lOS(~ flU 

t XE 

Fig. 5-20. Use the File//Print command to print documents. 

Rn application can't be round to open 
this Item. 

Fig. 5-21. You'll be greeted by this message if there's 
no program on the disk that matches the document you've selected. 
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1. Begin by starting MacWrite. 

2. Once MacWrite is started, choose the File//Ciose command (this closes the 
MacWrite writing window, but doesn't turn off the program) (see Figure 5-22). 

3. From here, choose the File//Open command. A dialog box wi ll appear, ask
ing you which document you want to open. Since the document you want 
isn't on the current disk, click the Eject button (see Figure 5-23). 

4. After the Mac spits the disk out, replace it with the one that holds the docu
ment you want to print. Once again, the dialog box will ask which docu
ment to print. 

5. Position the pointer over the correct one and click it (see Figure 5-24). If 
many documents are listed, and you don't see the one you want, scroll 
down the list by pressing the down arrow box. 

- ---- ~-
-~----

Fig. 5-22. Once in the program, choose the File //Ciose command. 

J j System Disk 

j [ Ej ect ] 

Fig. 5-23. Click the Eject button to eject the current disk. 

, 
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U I Open ) Write/Paint 

[ Eject ) 

I Cancel ] 

Fig. 5-24. Select the document you want by clicking it. Then click the Open button. 

6. Finish by pressing the Open button. 

7. The document (in this case, "Second Memo") will then be loaded into Mac
Write. Once it's there, choose the File// Print command. 

When printing has been completed, the Finder will instruct you to replace the 
disk with the one that contains the MacWrite program. 

MacTip 5-8 

Owners of two-drive Macs needn't worry about whether 
documents are on the same disks with their programs. It's 
acceptable to have the document in one drive and the pro
gram that created it in the other. 

IT'S ALL IN THE EDIT 

It's a well-known fact that most great works of art aren't the outcome of a single 
brilliant flash of inspiration, but instead are the result of painstaking study, care, 
and work. Whether the medium is shapes, words, or color, true artistry is the ability 
to refine, to improve upon a great concept and to make it even greater. 

The Macintosh lets you do exactly this. But unlike most other forms of art, the 
Mac makes change easy. 

You can write a report for school or office, for example, and then edit it for 
clarity, style, and content. Keep editing until you've said exactly what's on your 
mind. When you've finished, print the result. You may have gone through as many 
as 20 iterations-20 drafts-without realizing it. Editing is no longer a chore, but a 
pleasure, because the Mac makes refining your work painless and easy. 

Unlike most computers, the Mac has editing capabilities built in. All are 
accessible while you're working on the Mac desktop, so they're important to learn 
if you want to become a true Mac expert. What's more, many programs build upon 
these innate editing features and add more of their own. Once you learn how to 
edit on the Mac's desktop, you're on the road to knowing how to edit with other, 
more sophisticated programs -even the heavy-duty ones such as Microsoft's Word 
and Apple's MacWrite. 

There are two types of editing you can do with the Mac: keyboard editing and 
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command editing. You've learned some of the keyboard editing tricks already, 
such as using the Backspace key. 

The other type, command editing, is performed with commands found in the 
Edit menu, which include Cut, Copy, Clear, and Paste. If you're like most Mac 
users, you'll use a combination of both keyboard and command editing. 

While working on the desktop, you'll have a chance to edit only text. In 
programs that deal with pictures instead of words, you'll be using some of the same 
skills. For the sake of clarity, we'll talk about editing text only. 

The most basic editing procedure, as you've already seen, is the use of the 
Backspace key. If you type a wrong character, you can simply erase it by tapping 
Backspace. When the Backspace key is pressed, it moves the insertion point -that 
flashing line that tells you where the Mac's attention is focused- back one 
character. Any character that may be standing in its way is erased, leaving a blank 
spot. Hold the Backspace key down to erase several characters. 

The second basic keyboard editing maneuver is erasing text that's not located 
at the blinking insertion point. You could back up over text to get to it, but you'll 
erase everything between. The better way is to move the insertion point. Here's 
how. We'll use the Empty Folder icon to practice with. 

With the mouse, move the pointer onto the letter "y" in "Empty." Click the 
mouse button. The insertion point will move to where the pointer was clicked- in 
this case, immediately to the left of the "y" (see Figure 5-25). 

From here, you could type in new text, or press Backspace, to erase characters 
to the left of the insertion point. Go ahead and change the name if you'd like. But 

stem Disk 
6 it•ms 304K in disk 96K availabl• 

~~ 
Font Mover Disk Copy Fonts Seattle 

LJ • 
System Folder Em pi~ Folder 

Fig. 5-25. Click within the name of an icon to set the insertion point. 
The place you click in the name determines where the insertion point will be placed. 
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before you're through, be sure that you change the name back to "Empty Folder" (the 
world won't end if you don't, but doing so will save you some confusion). 

INTERMEDIATE EDITING 

So far, you've learned how to edit text just one character at a time. The Macin
tosh is versatile enough that you can also work with blocks of text. It doesn't matter 
how long the blocks are- two characters or two thousand characters- it's all 
handled the same way. 

A good way to practice editing is to use the comments box inside an informa
tion window. The information window for Empty Folder is a good choice. Call it up 
in the normal way by selecting the Empty Folder icon and then choosing the 
File//Get Info command, or by pressing the Command and I keys together. With 
the information window displayed on the screen, it's time to begin. 

Write some text to edit: For starters, type "The slow cow hopped over the lazy 
bull." Figure 5-26 shows what you should have. If this sentence were longer, the 
text would automatically continue on the next line when space in the first line had 
been filled. With the Mac you don't have to press the Return key when you reach 
the end of a line. 

Information about Empty Folder -· ··--~~~-~~-- . __ ........, __ __ 

Empty Folder CJ 
Kind: folder 
Size: contents total 0 bytes 
Where: System Disk, internal driue 
Created: Wednesday, May 2, 1984 ot 8: 1 0 RM 
Modified: Wednesday, June 20, 1984 ot 2:12 PM 

D Locked 

The slow cow hopped ouer the lazy bull~ 

fig. 5-26. This is how the sample text should look. 

Now let's take out a whole word. That's easy. With the mouse, maneuver the 
pointer over the "c" in the word "cow." Click there. Now, drag the pointer over 
the entire word "cow." (Remember, hold the mouse button down while moving 
the pointer.) 
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When the whole word is highlighted, release the mouse button. The word 
" cow" should stay highlighted, as shown in Figure 5-27. 

!I I Information about Empty Folder 

Empty Folder 0 
Kind: folder 
Size: contents totol 0 bytes 
Where: System Disk, internol driue 
Created: Wednesday, May 2, 1984 at 8:10 RM 
Modified: Wednesdoy, June 20, 1984 at 2: 12 PM 

D Locked 

The slow II hopped ouer the lazy bull. 

Fig. 5-27. Drag over "cow" to select it. 

Delete the whole word by pressing the Backspace key. You' ll notice that when 
the word is deleted, the Mac reformats the sentence to fit the margins. Since the in
sertion point is left conveniently where the word "cow" used to be, we can enter 
an entirely new word there. Type "fox." The sentence should now appear as it 
does in Figure 5-28. 

MacTip 5-9 

Pressing the Backspace key when something is selected, 
even a picture, erases it. Depending on what you' re doing 
with the Mac, you may or may not be able to get it back. 
Sometimes, but not always, you can retrieve an accidentally 
erased block of text or a pictu re by using the Edit//Undo 
command, covered later in this chapter. 

When you know you' ll be deleting text and replacing it with something else, 
take this shortcut: Highlight the text to be deleted by dragging over it. Instead of 
pressing the Backspace key, just start typing the new text. The moment you press 
the fi rst key, the highlighted text will be deleted. 

Try this with the word "slow" : Select it as you did with " cow." Type in 
" quick." " Slow" will be obliterated; " quick" w ill take its place. 
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0 Information about Empty Folder 

Empty Folder 0 
Kind: folder 
Size: contents total 0 bytes 
Where: System Disk, internal driue 
Created: Wednesdoy, Moy 2, 1 984 at 8:1 0 AM 
Modified: Wednesday, June 20, 1984 at 2:12 PM 

DLocked 

The slow fo~ hopped ouer the lazy bull. 

Fig. 5-28. Press the Backspace key and type in "fox." 

MORE INTERMEDIATE EDITING 

Most of the time, you'll be highlighting whole words for deletion. Instead of 
dragging over words to be highlighted, double-click on them. 

Try it. Move the pointer over the word "bull." Double-click with the mouse 
button. The entire word "bull" (plus the blank spaces to the right) will appear 
highlighted, as shown in Figure 5-29. 

If there's more than one word to be selected at once and the words are next to 
each other, double-click the first word (you've already done that with "bull.") 
Follow by holding down the Shift key and double-clicking the remaining word or 
words. Try this with the word "lazy." 

You can now delete the two words at once. Do it by pressing the Backspace 
key. Now type in the following new text: "sleeping dog." The sentence should 
now look like the one in Figure 5-30. 

COMMAND EDITING 

So much for editing with the keyboard only. It's time to use the commands hid
den in the Edit menu. Before we start, drag the pointer over the entire sentence. 
Start by lining up the pointer over the "T" at the start of the sentence, and drag to 
the"." at the end of the sentence. 

Incidentally, if there are several lines of text you want to delete, you can take 
the shortest route-diagonally-between the beginning and end of the text. The 
Mac will do the rest. You should end up with something like Figure 5-31. 



Kind: 
Size: 
Where: 

Created: 

Modified: 

D Locked 
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Information about Empty Folder 

Empty Folder [J 
folder 
contents total 0 bytes 

System Disk, internal driue 

Wednesday, May 2, 1984 at 8:1 0 RM 

Wednesday, June 20, 1984 at 2:12 PM 

The quick foH hopped ouer the lazy bull. 

Fig. 5-29. Double-cl ick anywhere on a word (such as " bull") to select the whole word. 

:o Information about Empty Folder 

Empty Folder [] 
Kind: folder 
Size: contents total 0 bytes 

Where: System Disk, internal driue 
Created: Wednesday, May 2, 1984 at 8: 1 0 RM 
Modified: Wednesday, June 20, 1984 at 2:12 PM 

D Locked 

The quick foH hopped ouer the sleeping dog~ 

Fig. 5-30. The rewritten sentence. 

Pull the Edit menu down, but don't select anything yet. The desktop's Edit 
menu offers seven choices: Undo, Copy, Cut, Paste, Clear, Show Clipboard and 
Select All, w hich we already discussed. We' ll start with the Copy command. 

Drag the pointer down to Copy and release the button . The high lighted text 
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will be copied (Figure 5-32) and tempora rily stored in a place called the Clipboard, 
a spot that the Mac uses to store pieces of text and pictures. 

The copied text can now be placed elsewhere. For our purposes, it 's enough to 
place the copy right after the original. Move the pointer to the end of the sen
tence - right after the period is fine. Pull the Edit menu down and select the Paste 
command (Figure 5-33). It won't take long: the copy will be placed right after the 
original (see Figure 5-34). 

Kind: 
Size: 

Where: 

Creoted: 

Modified: 

0 locked 

Information about Empty Folder 

Empty Folder 0 
folder 
contents totol 0 bytes 

system Disk, internal driue 

Wednesday, Moy 2, 1984 at 8:1 0 AM 

Wednesday, June 20, 1984 ot 2: 12 PM 

Fig. 5-31. Drag over the entire text to select all of it. 

,.. ""' • File Special 

Clear 
Select Rll :JCR 

Show Cl board 

Fig. 5-32. Use the Edit//Copy command to send a copy of the selected text to the Clipboard. 
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,. . 
• file Special 

Show Clipboard 

Fig. 5-33. Use the Edit//Paste command to fi nish the editing job. 

Information about Empty Folder 

Empty Folder 0 
Kind: folder 
Size: contents total 0 bytes 
Where: System Disk, internal driue 
Created: Wednesday, May 2, 1984 at 8:1 0 RM 
Modified: Wednesday, June 20, 1984 at 2: 12 PM 

0 Locked 

The quick foH hopped ouer the sleeping dog.The quick 
foH hopped ouer the sleeping dog. 

Fig. 5-34. The added copy. 

The Cut command is similar to the Copy command, but instead of leaving the 
original, it takes it out. To t ry this, start by erasing the second sentence (the easiest 
way is to select the whole text of the sentence and hit the Backspace key) . 

Select the lesson sentence once again. Instead of choosing the Edit //Copy 
command, choose Cut from the Edit menu (Figure 5-35). The entire sentence will 
disappear. 
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,. 
File Special 

Clear 
Select Hll sgn 

Show Clipboard 

Fig. 5-35. The Edit\/Cut command. 

Just as with the Edit//Copy command, the selected text is placed in the Clip
board. It, too, can be recalled by choosing the Paste command from the Edit menu. 
Try it. The sentence should reappear. 

Edit//Cut and Edit//Copy both save text to the Clipboard; Edit//Ciear cuts 
selected text but doesn't save it to the Clipboard. Use Edit//Ciear in place of tapping 
the Backspace key. 

The Undo command in the Edit menu does what its name implies: It reverses 
the last edit or action. Let's say you're busy erasing lines of text. Ooops! You've 
gone too far. You've erased one too many lines. To bring the lost line of text back, 
just choose the Edit//Undo command. 

Keep in mind that the Edit//Undo command works to reverse the last action or 
command only. If you've erased text and then written some more, you can't recall 
the erased text. 

Unfortunately, Edit//Undo works only with programs and desktop accessories, 
so mistakes you make with naming icons or writing comments in information win
dows can't be reversed. 

THE CLIPBOARD 

Text that is Cut or Copied using the Edit//Cut or Edit//Copy command is tem
porarily placed in the Mac's Clipboard. Once in the Clipboard, text can be placed 
anywhere using the Edit//Paste command. The Clipboard can hold only one picture 
or block of text at a time. If you Cut or Copy something to the Clipboard and then 
Cut or Copy something else, the original Clipboard contents will be replaced with 
the new entry. 

The Clipboard retains its memory while you're working with the Macintosh, so 
you can conceivably cut something from one program and place it in another. 
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(Some programs can't accept outside material- the manual that accompanies the 
software will provide more details.) 

Maclip 5-10 

The Copy, Cut, and Paste commands in the Edit menu 
are important because you can use them to move text and 
pictures between documents (even documents created by 
different programs). You ' ll also use them w hen working w ith 
the scrapbook, detailed in the next chapter. 

The Edit//Show Clipboard command lets you see the current contents of the 
Clipboard , al l neatly placed in the Clipboard window. You ' ll be able to see the first 
five lines of text or the topmost portion of a picture. 

Call up the Clipboard by giving the Edit//Show Clipboard command. The win
dow normally appears in the lower portion of the desktop. Move it somewhere else 
if you want to. If you haven't done any additional doodling, your Clipboard win
dow should look like Figure 5-36. 

~D Clipboard 
~he quick fOH hopped ouer the sleeping dog. 

Fig. 5-36. The current contents of the Cl ipboard. 

To see the contents change, first close the Clipboard window (by clicking in its 
close box) and then Cut something from the example text. Double-click on the 
word " quick." Choose Cut from the Edit menu. In a matter of a second or two, the 
original Clipboard entry is erased (the w indow will stay), and is replaced by 
"quick," as show n in Figure 5-37. 

The contents of the Cl ipboard can be pasted as many times as you'd like. The 
cu rrent text o r graphic element remains in the Clipboard until you turn the Mac off 
or use the Edit//Cut o r Edit//Copy command again. 

I!D Clipbourd 
quick 

1'2 

Fig. 5-37. If you Cut or Copy more text, the contents of the Clipboard changes. 
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As with any other window, close the Clipboard window by clicking in its close 
box (or by using the File//Ciose command, of course). 

MacTip 5-11 

If you've saved something to the Clipboard that you 
want to keep for the time being, but you need to cut out 
more text, use the Backspace key or the Edit//Ciear com
mand. Neither one saves text to the Clipboard, so you won't 
inadvertently change the Clipboard's contents. 

SO YOU DON'T LIKE ICONS 

For some, icons are hard to get used to. The Mac gives you another choice. All 
but a very few desktop icons can be changed into old-fashioned text. It's all done 
with the View menu. 

Pull the View menu down. You'll see five choices: By Icon, By Name, By Date, 
By Size, and By Kind (see Figure 5-38). The Mac automatically chooses the 
View//By Icon selection when starting with the desktop; choosing any of the other 
commands converts the icons to plain text. 

All of the view-as-text commands display the same information. The only thing 
that changes is the way the files are sorted (you may have to resize the window to 
see all the text). 

View//By Icon 

When you select View//By Icon, the files appear as icons. The name of each file 
appears at the bottom of its icon (see Figure 5-39). 

View//By Name 

View//By Name displays the files organized alphabetically-A through Z (see 
Figure 5-40). Files that begin with numbers come first. 

r • • File Edit Special 
---------------- ~--~----------------------------------./by Icon 

I by Name 
I by Date 

by Size 
by Kind 

Fig. 5-38. The View menu, used to change the display from icons to text and back again. 
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I~ System Disk 
6 items 313K in disk 87K availabl• 

~ ~ ~ ~ 
~ 

Font Mover Disk Copy Fonts Seattle 

CJ CJ 
System Folder Empty Folder 

~ 
~I 1¢ 121 

fig. 5-39. The disk directory window, showing files displayed as icons. 

lEI System Disk 
Siz• lkm!. Kind Last Hodifi•d 

61( Disk Copy application 'w'ed 1 May 2 1 1984 lQ 
OK Emptg Fold•r fol•r 'w'ed 1 Jun 20 1 1984 

131< Foat Hov~r app licaticn 'w'ed 1 May 2 1 1984 

56K Fonts F cnt Mover dooument 'w'~d 1 May 21 1984 
91( S.attt. F cnt Mover document 'w'ed 1 Apr 25 1 1984 

216K st~t~m Fold•r folder 'w'ed 1 Jun 20 1 1984 K) 
101 It;: 12:1 

fig. 5-40. The disk directory window, showing 
files displayed as text. File names are organized alphabetically. 

View//By Date 

With View//By Date the files are organized in the order in which they were last 
modified, with the most recently modified file listed first (see Figure 5·41). 

View//By Size 

View//By Size organizes the files by size in bytes, with the largest first (see 
Figure 5·42). 
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;;O System Disk 
Siz~ N~m~ Kind lut tjo!lifkd 

OK Emptg Fold~r folder Wed , J un 20, 1984 ~ 
216K Sgst~m Fold~r folder Wed, Jun 20, 1984 

6K Disk Copg application Wed, May 2, 1994 

13K Foftt Hov~r application Wed, May 2, 1994 

56K FODts Font Mover document Wed , May 2, 1994 

9K Suttl~ Font Mover document Wed, Apr 25, 1984 
K> 

~I IQ 1'2l 

Fig. 5-41 . The disk directory window, showing files displayed as text and 
organ ized by the date they were last modified (the most recently modified files are listed fi rst). 

View//By Kind 

View//By Kind groups the files together by type, such as application (program), 
document, and fo lder (see Figure 5-43). 

It's important to remember th at the View commands change t he l isting of fi les 
in the active window on ly. All other w indows, open or closed, are unaffected. To 
make the change universal, you' ll need to reselect the View command for each 
w indow. You' ll need to reissue the desired command each time you create a new 
folder, or the f iles placed into it w ill be icons. 

MacTip 5-12 

If you want to select several icons of the same type (all 
documents, for example), use the View//By Kind command 
to change the fi les to text, o rganized by kind . Select the files 
you want by dragging down the list (they w ill all be grouped 
together, mak ing the selection process easier). 

Immed iately choose the View//By Icon command. The 
fi les, now as icons, will st ill be selected . Copy them, delete 
them, or whatever, as a group. 

CLEANING UP 

Much of the time, you' ll be rearranging icons all over the desktop, moving 
them from window to w indow, creating new ones, mak ing copies, and so forth. 
There's a way to keep the appearance of the desktop tidy -with icons placed neat
ly one by one - without pa instakingly moving them yourself. j ust use the Clean Up 
command, one of fou r unique entries in the Spec ial menu. 

Speciai//Ciean Up works only for the active w indow (or if no window is 
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System Disk 
Niim~ Kind Lut Hodifi~d 

Syst~m Fold~r foldtr 'w'td, Jun 20, 1984 

Fonts r ont Mover document Wed, May 2, 1984 

Font Hov~r app lioation 'w'~d, May 2, 1994 

s~attl• Font Mover document 'w'ed, Apr 25, 1984 

Disk Copy application 'w'ed,May 2,1984 

Empty Foldu folder 'w'ed,Jun20, 1984 

Fig. 5-42. The disk directory window, showing files 
displayed as text anc;f organized by size. The largest is listed first. 

lQ 

K5 
1¢ [Q] 

present, for the icons on the open desktop). so you' ll need to use the command 
several times if several windows are open. 

Using the Speciai//Ciean Up command is easy. just pick the window you want 
cleaned up by activating it (if it isn't active already) , and then choose Clean Up 
from the Special menu (Figure 5-44). The Mac automatically rearranges the icons 
into neat rows and columns. 

You may get large gaps between icons. This is normal. If you don't want the 
gaps, place the distant icons closer together, and give the Speciai//Ciean Up com
mand once again. 

EMPTYING THE TRASH 

Earlier in this chapter, you learned how to drop files and folders into the trash 
can icon for quick disposal. But as we mentioned earlier, simply placing files in the 
trash doesn 't automatically elim inate them. The trash must be emptied, through a 
simple process made possible with the Speciai//Empty Trash command. 

After placing whatever files and folders you' re absolutely sure you no longer 
need in the trash, select Empty Trash from the Special menu, as shown in Figure 
5-45. Mac's disk wil l whir a second o r two, and the files wi l l be permanently 
destroyed. 

Trying to delete a program? The Finder w ill double-check by asking you if 
you' re sure you want to delete the program. You' ll have to click the OK button in 
the alert box to continue. If the file happens to be locked or is on a locked disk, it 
cannot be erased. You' ll have to unlock the file or disk to proceed. 

By the way, the Finder automatica lly empties the contents of the trash when a 
program is started or when a disk is ejected . 
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~I 

Siz• 

2161< 

OK 
13K 

6K 

56K 
9K 

~I 

System Disk 
N~IH Kind Lut Hodifi•d 

SVst~m FoldH" folder 'vt'ed , Jun 20, 1984 

Emptg Foldu folder 'vt'ed , Jun 20, 1984 

Font Hov~r application 'vt'ed , May 2, 1994 

Disk Cop!l application 'vt'ed , May 2, 1994 

Fonts Font Mover document 'vt'ed , May 2, 1984 

s~attl• Font Mover document 'vt'ed, Apr 25, 1994 

j_Q 

Fig. 5-43. The disk directory w indow, showing 
files displayed as text and grouped together by kind. 

File Edit Uiew 

Fig. 5-44. The Speciai//Ciean Up command. 

~ 

~ 
lEl 

ERASING THE DISK 

Every once in a while, you' ll want to erase the entire contents of a disk. You 
could delete all the files and folders by throwing each one into the trash. But a bet
ter and faster way is to use the Speciai//Erase Disk command (Figure 5-46). 

The Finder won't erase the disk if one or more of these conditions exists: 

• The disk is the Startup disk. The Finder won't allow you to erase the disk you 
used to start the Mac (Figure 5-47). You start with another Startup disk, and 
then insert the disk to be erased . 

• The disk is write protected. Most Mac disks have a w rite-protect tab on them. 
W hen the tab is slid toward the center of the cartridge, the disk can be eras
ed; w hen the tab is slid toward the outside edge of the cartridge, the disk 
cannot be erased. 

If the disk you want to erase passes these above tests, the Finder w ill sti ll pro
vide one last chance for you to change your mind (which is nice, since it's possible 
to select the Speciai//Erase Disk command by accident). If you rea lly do want to 
erase the disk, click the O K button in the alert box (see Figure 5-48). 
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r -'-
• File Edit Uiew 

Fig. 5-45. The Speciai//Empty Trash command. 

r J. 
• File 

OK 

Edit Uiew 

Fig. 5-46. The Speciai//Erase Disk command. 

Thot is the stortup disk; it cun•t be 
erased. 

Fig. 5-47. You can't erase the Startup disk, and the Mac tells you so. 

AUTO MAC 

The Macintosh makes just about every computing chore a breeze. There is a 
way to make things even easier. If you want a certain program to run automatically 
when you turn the Mac on and insert a disk, use the Set Startup command found in 
the Special menu (Figure 5-49). You may want to do this if your Mac will be used by 
persons with no computer or Mac know-how, or if you don't want to bother having 
to start a program from the desktop. 

To set a program to be run automatically, select it, then choose the Speciai//Set 
Startup command. A dialog box, shown in Figure 5-50, will appear, asking you if 
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OK 

Completely erose disk nomed "New 
Moe Disk n (internal driue)? 

{Cancel J 

Fig. 5-48. You're given one last chance to decide 
whether or not you want to erase the disk. Click OK if you do, Cancel if you don't. 

'" .& • File 

OK 

Edit Uiew 

Clean Up 
I: tnt) tt.t ·r rastl 
l:rftse lU~k 
Set Stilrtup: 

Fig. 5-49. The Speciai//Set Startup command. 

Rre you sure you wont to moke "Font 
Mouer" the startup application? 

(Cancel ) 

Fig. 5-50. The Macintosh asks for confirmation of 
your choice of a startup application. Click OK if everything is all right. 

you really want to make this program the startup application. Click OK if you do, 
Cancel if you don't. 

The next time the Mac is turned on and that disk is inserted into the drive, the 
startup program will automatically run. You can return to the desktop by exiting the 
program, of course. 

Should you wish to choose another program for startup, go through the pro-
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cess again. Exit the current startup application, select another program, and choose 
the Speciai//Set Startup command once more. 

MacTip 5-13 

If the icons are scattered all over the place, try this: Take 
all the icons out of the window (use the Edit//Select All com
mand to select them all, and then drag them as a group out 
of the window). Issue the File//Put Back command. They will 
fly back into the window and neaten themselves up 
automatically. 

If you want to put the icons back in a particular order, 
take them out of the window as described above. Deselect 
the icons by clicking anywhere on the desktop. 

Now, Shift-click the icons in the order you want them 
put back in the window (for example, all programs, then all 
folders, then all documents). When you give the File//Put 
Back command, they will reenter the window in the order in 
which you selected them. 

If the time comes to cancel all Set Startup settings, open the System Folder and 
set the icon named "Finder" as the startup program. Next time, when you use the 
disk to start the Mac, you'll be greeted by the standard desktop. 

MacTip 5-14 

You can't set a folder or a document as the startup ap
plication, but it is possible to set any of the Mac's ''system" 
files (usually enclosed in the System Folder and shaped like 
little Macs or blank pieces of paper) as the startup applica
tion. However, only the icon labeled "Finder" should be 
selected as a startup application. Don't choose one of the 
other system files; because if you do, you won't be able to 
start the Mac with that disk. 

Should you accidentally select a system file other than 
the one named "Finder," start the Mac with another disk, 
eject it, put in the disk you messed up, and go through the 
Speciai//Set Startup procedure once more. This time, choose 
the Finder as the startup application. 

ONE MORE MENU 

This chapter has detailed all the menu choices available for working at Mac's 
sophisticated desktop- all except the choices found under the * (Apple) logo. 
These are the "desktop accessories," covered in Chapter 6. 



CHAPTER 6 

Desktop Accessories 
and How to Use Them 

l;,ough the Mac's desktop may not be made of oak or walnut, it does come com
plete with a full line of built-in accessories-a four-function calculator, a note pad, 
an alarm clock, and more. Any desktop accessory can be used with the Mac at any 
time, even while you're using a program. 

It's no trouble, for instance, to call up the note pad while using the MacPaint 
drawing program, and write yourself some friendly reminders. Put the note pad 
away and continue with MacPaint. 

An hour, a day, a week goes by- it doesn't matter. Bring the note pad desk ac
cessory back on the screen and read off your notes. The notes stay until you erase 
them. 

This chapter acquaints you with the six major desktop accessories. Some of 
these, such as the calculator, are handy tools. Others offer ways to make using the 
Mac even easier. These include the key caps and the control panel. 

Incidentally, there's no limit to the number and kinds of desktop accessories 
for the Mac -what comes with the computer when you buy it is just the beginning. 
Already, both Apple and independent software developers are coming out with 
new tools for the Macintosh desktop. 

119 



120 MacGuide 

THE SCRAPBOOK 

There will be many times when you'll want to transfer words or pictures from 
one program document to another. For example, you might create a letterhead us
ing MacPaint (a graphics program described in Chapter 7) and then use it with Mac
Write. The MacPaint graphic element is transferred to MacWrite before you begin 
writi ng. Once the letterhead is in place on the MacWrite screen, you can compose 
your letter (Figure 6-1). 

,. * File Edit Search Format Font Style 

Untitled 

l.f--'-'-·1-<-l.~-~•-L•-l-•-•-•.J.1_._,_l_,_J.~_J.'.'._ •. _ •. J ._. ,_J_ .• _I.~ •... I-•.!.•-·• ·-•-J~.-l ..... ...L....J_,_J} 
~~ ~§JEJ ~~~~ ::m: 

Dear George, 

Good to hear that you'll be able to beam aboard this weekend . Spock and I 
have been planning a 

Fig. 6-1. A picture from MacPaint inserted into MacWrite. 

::: 
:;:;:· 

~!!i; 

lll!!! 

The question is: How do you get the MacPaint graphic element into a Mac-
Write document? Here's one way: 

1. Start up MacPaint. 

2. Call up the saved letterhead graphic element. 

3. Copy it to the Clipboard. 

4. Exit MacPaint. 

5. Start MacWrite. 

6. Paste the letterhead stored in the Clipboard onto the page. 

A lot of trouble for one little letterhead. 
The better way is to use the scrapbook desktop accessory. With it, you'd paste 

the graphic element in the scrapbook and then proceed: 
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1. Sta rt MacWrite. 

2. Call out the scrapbook. 

3. Copy and paste the letterhead graphic. 

4. Start writing. 

Unlike the Cl ipboard , the scrapbook permanently retains material placed in it. 
What's more, the scrapbook can store more than one piece of information at a 
time. You could, if you wanted to, have dozens of items in the scrapbook and 
choose any of them w ith the same ease as flipping through the pages of a book. 

Call up the scrapbook by choosing Scrapbook from the Apple menu. It may 
take a few seconds to appear, however, because the contents of the scrapbook 
must be read off the disk. 

As seen in Figure 6-2, the scrapbook is enclosed in its own window. Unlike 
most of the windows you've encountered, the one for the scrapbook can 't be ad
justed. There's no way to make it larger or smaller, though you can drag the scrap
book w indow to another part of the desktop. You'll find that all of the desktop ac
cessories are like th is. Their windows have only the most basic features. 

The contents of the scrapbook can change, of course. The examples in the 
following pages were pulled from the sample scrapbook that's included with the 
System disk. If the scrapbook you' re working with includes items other than those 
shown here, don' t worry. It works in the same manner in any case . 

51 Scrapbook 

Ust tht Scrapbook to store o voritty of ttxt selections ond pictures which 
rnoy II. tronsftrr•d b.tw••n applications . From t~ Edit menu, Cut or Copy 
an lttm from the Scrapbook, tht>n Postt> into on application document. 

lt of5 TEXT 

Fig. 6-2. The scrapbook desktop accessory. 
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MacTip 6-1 

There's a different scrapbook for every disk. Pictures you 
save on a MacPaint disk won't be on a MacWrite disk, 
because the Macintosh will use the scrapbook from the Start
up disk. 

If the scrapbook window displays a " This Space for Rent" or a "Scrapbook 
Empty" message, shown in Figure 6-3, it means the scrapbook has nothing in it. 
You'll have to put something in before you can draw anything out. Read ahead to 
see how this is done. 

Scrapbook 

This space for rent ... 

©I I~ 

Fig. 6-3. An empty scrapbook. 

First, let's see what makes up the scrapbook window. Look at Figure 6-4. On 
the top is the title bar, complete with close box. As with other windows, you can 
move the scrapbook around the desktop by dragging the title bar. Try it. When 
you're through, click in the close box (the long-hand method is to choose the 
File //Ciose command). 

On the bottom edge of the scrapbook window are several tidbits of informa
tion. You can easily see how many items are in the sc rapbook, as well as the 
number of the item currently being displayed. The Number 1 item is always 
displayed when the scrapbook is first called up. 
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::D Scropbook: 

Use the Scrapbook to store a variety of text selections and pictures which 
may be transferred between applications . From the Edit menu, Cut or Copy 
on item from the Scrapbook, then Paste into on application document . 

11 of 5 I 
.& • 

lte~ Type lteL \ 
Number Contents 

Number or Items in Scrapbook 

Scroll Bar 

Fig. 6-4. Vital parts of the scrapbook. 

Toward the right is the indicator that shows the item type. It can be "Text," 
"Picture," or just about anything else. This indicator can come in handy when you 
transfer scrapbook items between different programs. 

It should be noted that some programs can't accept scrapbook data from another 
program. The manual that accompanies the software should detail the limitations. 

The scrapbook lets you see only one item at a time. And in some instances, th e 
item will be too large to fit w ithin the display window. There's no need for alarm : 
you can still use the item. 

To see another item, drag the elevator across the scro ll bar. Anoth er way: click 
in the right or left scroll arrow. Try scrolling over to the next item. Place the pointer 
in the elevator and drag it a half-inch or so to the right . If you've done it correctly, 
you should see the second item in the display window (figure 6-5). 

If you drag the elevator too far to the right, you' ll skip right past the Number 2 
item and go to Number 3. If you don't drag the elevator far enough, it wi ll spring 
back into its original position. 
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Scrapbook 

lz of :5 PICT 

Fig. 6-5. Use the elevator to scroll through the contents of the scrapbook. 

A surer way to advance through the scrapbook is to click in the right or left 
scroll arrow. If you click in the right arrow, as shown in Figure 6-6, the next higher
numbered item is shown. The next lower-numbered item appears if you click in the 
left arrow. 

For best results, use both the elevator and the scroll arrows. Use the elevator to 
pass several items quickly; use the scroll arrows to home in on your subject. For 
now, put the scrapbook away by clicking in the close box. 

So far so good. Now let's put the scrapbook to work. Since you may not have 
purchased programs with the Mac, we'll limit ourselves to readily available desktop 
tools. We'll be using our old friend, the information window. The one for the 
Empty Folder icon will do. Call it up now. 

Here's a rundown of what we' ll do: 

1. Create the text. 

2. Copy it to the Clipboard. 

3. Call up the scrapbook. 

4. Paste the copied text to the scrapbook. 

Type a line or two of text into the comment box inside the information win
dow. If you' re strapped for something to say, try " But soft! what light through 
yonder window breaks! It is the east, and Juliet is the sun!" 
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Scrapbook 

"\' 
PICT 

fig. 6-6. Step through the items in the scrapbook with the aid of the right and left scroll arrows. 

When you've finished writing, drag over the text to select all of it. The info w in 
dow should now look something like this Figure 6-7. 

Choose the Edit//Copy command (alternatively, press the Command and C 
keys together) . This wi ll place a copy of the text into the Clipboard (sorry, items 
can' t be copied directly into the scrapbook). 

If you'd like, verify that the text is in the Cl ipboard by selecting Show Clipboard 
from the Edit menu. Then put the Clipboard away by clicking in its close box. 

Bring the scrapbook up once again (by choosing Scrapbook from the Apple 
menu). Place the snippet of Shakespeare into the scrapbook by choosing the 
Edit//Paste command (alternatively, press the Command and V keys together) . The 
Mac's disk drive will whir a bit, and before long the quotation will appear in the 
scrapbook window, as shown in Figure 6-8. 

MacTip 6-2 

If you want to place the new item somewhere other than 
at the head of the scrapbook, scroll the contents over to 
where you want the newcomer to be placed before you 
invoke the Edit//Paste command. That is, if you scroll the 
scrapbook so it shows "3 of 6," the newly pasted item will 
become Number 3. The ones thereafter will be renumbered . 
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Information about Empty Folder 

Empty Folder 0 
Kind: folder 
Size: contents total 0 bytes 
Where: System Disk, eHternal driue 

Created: Friday, March 30, 1984 at 7:04 PM 
Modified: Friday, March 30, 1984 at 7:04PM 

D Locked 

But soft! what fight through yonder Ll•indow break.s! 
It h the east. and Juliet i.s the sun! 

Fig. 6-7. Select the text to copy by dragging over it. 

Scrapbook 

But soft! what light tttrough yonder window breaks! It is the east and JuHet 
is tM sun! 

It of6 TEXT 

Fig. 6-8. Text from the information window pasted into the scrapbook. 
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To copy an item from the scrapbook and put it into a document, use exactly 
the reverse procedure: 

1. Call up the scrapbook. 

2. Scroll to the item desired. 

3. Copy the item. 

4. Paste the item into the document. 

If you've changed the scrapbook since the last exercise, scroll the contents 
once again so that the Romeo quote is displayed. Choose the Copy command from 
the Edit menu (or simply press the Command and C keys). Put the scrapbook away 
by clicking in its close box. 

Maclip 6-3 

If you choose Edit//Cut, you'll remove the item from the 
scrapbook, so be sure this is what you want to do. If you take 
something out by mistake, paste it back in. 

If you accidentally choose the Edit//Ciear command, the 
item will be forever lost, so be careful when using the Edit 
menu. 

The information window should now be in view (and should be active). Look to 
be sure that the insertion point is placed right after the last"!" at the end of the entry. 

Finish up by choosing the Paste command from the Edit menu (or simply press 
the Command and V keys together). A second copy of the line should appear, as 
shown in Figure 6-9. 

Finish up the use of the scrapbook by closing the information window. (Keep 
the text in the comments box as it is. We'll use it again later in this chapter.) 

THE ALARM CLOCK 

The Macintosh has its own internal alarm clock and calendar system, which 
operates off the small 4.5 volt battery that's installed in the back of the Mac. AIJ 
told, the alarm clock/calendar enables the Macintosh to continually keep track of 
the time and the day-from the date your Mac is created. 

The calendar automatically compensates for the number of days in each 
month; it even knows when to add a February 29 each leap year. About the only 
thing the Mac doesn't handle is daylight savings time. If your state observes this 
semiannual time change, you'll need to reset the Mac's clock manually. 

Why is there an alarm clock built into the Macintosh? One reason is so that the 
correct time is never far away. Just call the alarm clock up and the current time is 
displayed for you. 

You can also use the Mac to remind you of an important appointment. Set the 
alarm for 11:45, for example, so you won't run the risk of missing an important lunch 
date. When 11:45 rolls around, the Mac will give out a short (but pleasant) beep. 
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···---·- .... Information about Empty Folder - - .:..-:~~,.:::.::..:.~ -,.::::3 

Empty Folder CJ 
Kind: folder 
Size: contents total 0 bytes 
Where: System Disk, eHternal driue 
Created: Friday, March 30, 1984 at 7:04 PM 
Modified: Friday, March 30, 1984 at 7:04 PM 

D Locked 

But soft! what light through yonder window breaks I 
It is the east, and Juliet is the sun I But soft I what 
light through yonder. window breaks! It is the east, 

Fig. 6-9. The scrapbook lets you cut and paste text 
almost anywhere, even back to the same place the text came from. 

If you happen to be away when the beep sounds, the Mac gives you another 
chance. A flashing box, like that in Figure 6-10, appears around the Apple logo in 
the menu bar. 

By far, the best reason is that several Mac programs-Microsoft's Multiplan 
and Apple's MacWrite, for instance- can internally access the alarm clock. This 
allows the program to automatically determine the current date and time. This can 
be important, for instance, in some financial calculations or when printing out 
"timely" memos. 

Like using the scrapbook, bringing up the alarm clock is a simple matter. just 
select Alarm Clock from the Apple menu. As shown in Figure 6-11, the Mac 
automatically places the clock in the upper right corner of the desktop. 

You can move the clock window around the desktop by placing the pointer 
anywhere in its small body (anywhere, that is, but in the key-shaped symbol or the 
close box) and dragging it. 

_,. _C_r_i 1_e 
Fig. 6-10. A block will flash around the on the menu bar once the alarm goes off. 
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I D 11 : 1 0:21 RM ~ I 
Fig. 6-11. The alarm clock desktop accessory. 

If this is the first time you've used your Mac, the time shown may not be cor
rect. There's no need to worry. just change it according to the directions that 
follow. If your Mac doesn' t keep time after you tu rn it off or unplug it, the clock 
battery may be incorrectly installed or it may be dead. Refer to Chapter 2, " Bring
ing Home the Macintosh" for details on installing the battery. 

If you haven't guessed yet, there's more to the alarm clock than what's show n 
here. Open the alarm clock completely by clicking the key symbol. The key will flip 
down and display the rest of the clock, as shown in Figure 6-12. 

0 11:10:59 RM ! 

6/20/84 

Fig. 6-12. The alarm clock must be opened to set the time or date. 

The alarm clock is divided into three main sections. 

• The top portion shows the current time. 

• The middle portion, used for time/date setting, shows either the time, the 
alarm time, or the date (depending on what's being set) . 

• The bottom portion consists of three icons: a clock, calendar pages, and an 
alarm clock, for setting the current time, the alarm time, and the current date. 

In the following exercise, you'll learn how to set the alarm clock. The same 
procedure is used to set the clock and the calendar, so we won' t bother with the 
details for these. 

Start by clicking the alarm clock icon, the one on the lower right corner. As 
shown in Figure 6-13, when the alarm clock is selected, a switch appears in the mid
dle panel. This switch turns the alarm clock on and off. In oth er words, clicking the 
alarm clock icon simply lets you reset the alarm time; it doesn't activate anything. 

When the switch is in the down position, the alarm clock is turned off, and it 
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0 11 : 12:03 AM f 

~ 12:00:00 PM 

(0~ 
Fig. 6-13. Click the alarm clock icon to set the alarm time 

(likewise, click the calendar to set the date, the clock to set the time). 

won't bother you. In the up position, the alarm is turned on and will go off each day 
at the appointed time. You'll be able to tell that the alarm clock is on in a flash by 
looking at its icon. Cartoon-like lines appear above the little alarm clock when it's on. 

To set a new alarm time, select one ofthe digit groups in the middle band. Click 
the hour digits, for example, and they appear highlighted. Setting arrows appear, 
too. Press the up arrow to advance the time forward an hour at a time; press the 
down arrow to back the time up an hour at a time. For now, press the up arrow to 
set the hour to "6" (see Figure 6-14). 

Go on to the minutes digits. Click on them and they become highlighted. Press 
the up arrow to advance the number to 15. 

If punctuality is your middle name, you could set the exact second the alarm 
will go off, but we'll ignore it for now. We will need to indicate whether the alarm 
time is 6:15 in the morning or 6:15 in the evening, however. Click the letters AM 
and they become highlighted. Click either arrow to change from AM to PM. 

MacTip 6-4 

As a shortcut, click the digits you want to change, and 
type in the new time from the keyboard. To change the other 
digits, press the Tab key. This selects the digit group imme
diately to the right. 

When you've finished, click the alarm clock icon once again. This finalizes the 
new alarm time settings. 

0 11 : 14:01 AM r 
~ Doo:oo PM 

(0~ 
Fig. 6-14. Click the digits you want to change, and then press the up or down arrow as needed. 
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If you want to turn the alarm on, click the small switch that's located in the 
middle panel. Click it once to flip the alarm on (switch up) (see Figure 6-15). Click it 
again to turn the alarm off (switch down). 

When the alarm goes off (as it will even when the Mac is off, though you won't 
get the telltale beep), you ' ll have to call the alarm clock desk accessory onto the 
desktop, " open" it up, and flip the switch off. Otherwise, the flashing block around 
the Apple logo will linger and the alarm will go off at the same time tomorrow. 

To set the current time, click the clock and follow the same procedure as 
outlined above. Likewise, click the calendar pages and select the correct day and 
date to set the calendar. 

When you 've finished setting the time, click the key symbol in the top panel 
again, and the alarm clock folds back up. When you get tired of seeing the alarm 
clock on the desktop, click in the close box. 

0 11:15:04 RM f 

l!)- ia:OO:OO PM 

@~ 
Fig. 6-15. Turn the alarm on by flicking the alarm switch. Flick it again to turn the alarm off. 

MacTip 6-5 

You can cut and paste the time and data by calling up the 
clock and choosing the Edit // Copy command. Paste the time 
and date into the document by marking the insertion point 
and then choosing Paste from the Edit menu. 

THE NOTE PAD 
Next is the note pad desktop accessory, handy for recording sudden bursts of 

literary genius or simply jotting down the grocery list. The note pad includes eight 
" pieces of paper." You can flip through the pages as you would those of a regular 
note pad. 

To call up the note pad, choose Note Pad from the Apple menu. Because the 
contents of the note pad are stored on the disk, it takes a while for it to appear on 
the desktop. When it appears, it looks like Figure 6-16. 

As shipped from Apple, the note pad has a short note on its first page. If you see 
no such note, go ahead and type it in. We're going to use it to investigate how text 
can be edited with the note pad. Figure 6-16 shows exactly what to write. 

Before we start writ ing, however, let's get to know the note pad a bit better. 
Look at the lower left corner. You ' ll easily spot the dog-ear, the upturned part of 
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Keep up to eight pages of notes 
In the Note Pad. Cl ick on the 
dog-ear to turn to the next 
following page. Click In the 
lower left corner to tum to the 
next previous pagej 

Fig. 6-16. The note pad desktop accessory. 

the page. Click w ithin the dog-ear, as shown in Figure 6-17, to advance to the next 
of the note pad's eight pages. The second page should be blank. 

Keep clicking in the dog-ear and you'll wh iz through all the pages. When you 
get to page 8, click once again. Surprise! You' re back at page 1. 

You can go backward through the pages, too. Instead of clicking in the dog
ear, click in the lower left corner below the dog-ear (see Figure 6-18). Each time 
you click, you turn back a page. 

Return to page 1. With the mouse, drag over the entire first sentence, as shown 
in Figure 6-19. 

Follow by choosing the Edit//Cut command. The sentence will disappear and 
the rest of the text will be rearranged to fill the void. Bring the text back by choos
ing the Edit//Paste command. 

~o= Note Pod 

Click in the dog ear to go 
rorward .. j 

Fig. 6-17. To go forward through the pages, click in the dog ear. 
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... and click in the corner to go 
back! 

Fig. 6-18. To go backward through the pages, click in the corner. 

C11ck on 
the dog-eor to turn to the 
following page. C11ck tn the 
lower left corner to turn to the 
previous page. 

Fig. 6-19. Select text to be copied by dragging over it. 

Click to the right of the period in the last sentence. Tap the Spacebar a few times, 
and add the words " Here we go again . . . " Follow by choosing the Edit//Paste 
command. The beginning sentence appears, looking like that in Figure 6-20. 

Enough of this foolishness. Get rid of the extraneous text and the clone by drag
ging over it all and pressing the Backspace key (Figure 6-21). 

MacTip 6-6 

Like the scrapbook, there's a different note pad for every 
Startup disk you use. You' ll be able to save different sets of 
notes on your MacWrite , MacPaint, and System disks. 
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~0- NotePad 

Keep up to eight pages of notes 
in the Note Pad. Click on the 
dog -ear to turn to the next 
following page. Click in the 
lower left corner to turn to the 
next previous page. Here we go 
again .. .Keep up to eight pages of 
notes in the Note Pad. I 

Fig. 6-20. Pasted note pad text. Use the same procedure 
to paste text from the note pad into other accessories or into documents. 

Keep up to eight pages of notes 
here in the Note Pad. Click on 
the dog-ear to turn to the 
following page. Click in the 
lower left corner to turn to the 

Fig. 6-21. Take the extra text out by selecting it and pressing the Backspace key. 

As you can see, the note pad takes advantage of all of the Mac's built-in w riting 
and editing features. In doing so, you can transfer text written with a program such 
as MacWrite and place it in the note pad. Likewise, you can transfer text from the 
note pad into just about any program document. just copy in the normal way, 
select where the new text is to go, and paste it in. 

We can simu late this by using an information window again. Click on the 
Empty Folder icon once more, and choose the File//Get Info command (or press 
the Command and I keys together) . 

If you haven' t changed things since our previous info window exercise earlier 
in this chapter, the comments box should sti ll contain the famous line from Romeo 
and juliet , shown again in Figure 6-22. 
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Information about Empty folder 

Kind: folder 

Empty Folder 0 
Size: contents total 0 bytes 
Where: System Disk, eHternal driue 
Created: Friday, March 30, 1984 at 7:04 PM 
Modified: Friday, March 30, 1984 at 7:04 PM 

D Locked 

!But soft! what light through yonder window breaks! 
It Is the east, and Juliet is the sun I But soft I what 
light through yonder window breaks! It is the east, 

Fig. 6-22. The information window for the Empty Folder should still look like this, unless 
you've changed it since the last exercise. 

Let's suppose this is text from a program document-for instance, a memo 
you've just written with MacWrite. Drag over all the text in the comments box to 
select it. Follow by choosing the Edit//Cut command (Figure 6-23). This cuts the text 
from the comments box and places a copy of it into the Clipboard. 

We've finished with the information window (for this chapter, at least), so close 
it by clicking in its close box. 

With the note pad in the forefront once again, click in the dog-ear to advance 
to page 2. Finish the job by choosing the Edit//Paste command. Figure 6-24 shows 
what your note pad should look like. 

To transfer text from the note pad into a document, just do the reverse. Mark the 
spot where the text is to go by clicking in the appropriate place in the document. 

When the note pad is put away, the notes you've written stay-even after you 
eject the disk and turn the Mac off. Whenever you call up the note pad, it greets 
you with page 1 . 

MacTip 6-7 

Some characters from special fonts may not transfer well 
into the note pad. The note pad cannot accept pictures, even 
the small thumbnail sketches produced by the Cairo font -a 
font made up of pictures rather than letters. 
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.----· r1 t----~_-:: Information about Empty Folder 

Kind: folder 

Empty Folder 0 
Size: contents total 0 bytes 

Where: System Disk, eHternal driue 

Created: Friday, March 30, 1984 at 7:04 PM 

Modified: Friday, March 30, 1984 at 7:04 PM 

D Locked 

But -.ott! whot light throuqh yondf'r window bredk\! 
It I\ tllP P<l\t. ond ,Julrrt 1\ the \un!But soft! whdt 
lrqh t 1111 ouqh yonde1 wmdow break-.! It is the east. 

Fig. 6-23. Selecting the text to be Cut by dragging over it. 

THE CALCULATOR 

How many times have you needed to add a few numbers together, on ly to 
fumble around the drawers in your desk hunting for that ever-elusive pocket 
calculator? 

When you' re working with a Macintosh, a calcu lator is no farther than a menu 
away. Though the Mac's calculator is a simple one, it does handle routine addition, 
subtraction , multiplication, and division admirably well. And the computed result 
can be copied into a document. 

Bring the calculator to life by choosing Calculator from the Apple menu. The 
calculator will appear in the center of the screen (Figure 6-25). Like any desktop 
accessory, it can be moved by dragging it by the title bar. 

Li ke the average battery-operated pocket calculator, the Mac's version has 
small buttons for entering numbers and form ulas, along with a display panel on the 
top to display the result. You can either click on the buttons with the mouse or 
press the corresponding keys on the Macintosh keyboard. 

Here's a rundown of the buttons of the Macintosh calculator and what they do: 

Keys Function 

0-9 0 thru 9, to enter standard numbers 

C Clear, to erase an entry and start over 

E Exponent, to convert the number to scienti fic notation (for 
example, 6.5* 10E3) 
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~O~ NotePad 

But soft! what light througll 
yonder window breaks! It is is 
the east, and JUliet is the 
sun !But sort! what ligllt througll 
yonder window breaks! ltls is 
the east, and juliet is the sun I 

Fig. 6-24. The pasted text from the information window in the note pad. 
Use the same techniques to get text from other accessories and documents into the note pad. 

0 ( ol( ulotor 

Fig. 6-25. The calculator accessory. 

+ Plus, to add 

• 

Minus, to subtract (and to enter negative numbers) 

Divide 

Multiply 

Equals, to finish an equation 

Point, to add a decimal point 
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Use the Mac's calculator just as you would any other. To add 10 and 23, for 
example, you would type (or point & click): 

[1 1 [0] 

[+] 

[2] [3] 

[ = 1 

The result of the computation, 33, will be shown in the readout. 
Though the calculator can handle some complex formulas (such as "23 plus 12 

divided by 8 minus 17"), it's much more comfortable processing simple equations. 
The calculator is ideal for adding a row of numbers together, for example, or find
ing a percentage. 

You'll also notice that the Mac's calculator lacks a ~~clear Entry" key, so if you 
make a mistake halfway through an equation, you'll have to press the Clear (11C") 
key and start all over again. 

If you want to use the result of your calculation in a document, choose the 
Edit//Copy command (or press the Command and C together). There's no need to 
select the digits in the readout panel. As long as the calculator window is visible 
and active, the Mac will know what you want to do. 

Once you've copied the result, click in the spot where you want the number to 
appear (this sets the insertion point). Follow by choosing the Edit//Paste command, 
or by pressing the Command and V keys together. 

When you've finished with the calculator, click its close box. 

THE KEY CAPS 

Unlike the previously discussed desktop accessories, Key Caps doesn't do 
anything to a Mac document. Rather, it can be used to test the keyboard for proper 
operation or to help remind you which keys to press to create one of the Mac's 
special characters. 

To begin, choose Key Caps from the Apple menu. The key caps display will 
appear on the desktop shortly (Figure 6-26). 

The key caps display is a picture of the Mac's keyboard. It includes a one-line 
readout to display characters. When you type on the keyboard (type 11 r," for exam
ple), the characters appear in the readout. When a key on the keyboard is depressed, 
as in Figure 6-27, the corresponding one in the key caps window turns black. You 
can also type characters by clicking the key caps keys with the mouse. 

Now the fun begins. Press the Option key and hold it down. Almost like magic, 
the legends on the keys change. Now press the "r" key. Look at Figure 6-28. Instead 
of an "r," you get a registered trademark symbol. 

Nearly all of the standard keys produce different and unique characters when 
the Option key is held down. You can produce even more special characters by 
holding down both the Shift and the Option keys (Figure 6-29). 

Those keys that have a square in the key caps display don't have special 
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Fig. 6-26. The key caps desktop accessory. 

Fig. 6-27. If you press a key on the Macintosh keyboard, its character 
prints out in the display, and the corresponding key on the key caps accessory turns black. 

characters assigned to them yet. Don't be surprised if you encounter programs that 
make use of these " dormant" keys, using them to create even more unique 
characters than those already built into the Macintosh. 

When you've finished playing, close the key caps window by clicking in its 
close box. The next time you use the key caps desk accessory, the one-l ine display 
will be empty. 
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fig. 6-28. Press the Option key and then another key to get different characters. 

Fig. 6-29. You get still more characters when you press the Option and Shift keys together. 

THE CONTROL PANEL 

The control panel is one of the handiest desktop accessories that the Mac has. 
With this stylized version of an electronic dashboard , you can change the volume 
of the warning beeps, the background pattern of the desktop (from gray to black, 
w hite, or nearly anything between), the key repeat speed, and more. 

You need never use the control panel if you don't want to - the Macintosh 
control panel on the System disk is set up for the average user . But it's nice to know 
that if you don' t like things as they are, you' re in control. 

Place the control panel on the desktop by choosing Control Panel from the 
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Apple menu (Figure 6-30). Don't be frightened by the seemingly complex appear
ance of the control panel. It's rea lly quite simple to master. 

The panel has contro l over the following Mac functions: 

• Volume level - Decreases and increases the volume of the Mac's built-in 
amplifier. 

• Clock-Sets the Mac's internal clock/calender (setting the time is easier 
with the ala rm clock desktop accessory, and so it won' t be covered 
here). 

• Key sensitivity-Sets the " touch" of the keyboard for repeating characters. 
The higher the setting, the lighter the touch of the keys and the more easily 
the keys can be made to repeat. 

• Key repeat- Sets the speed at which the keys repeat. 

• Mouse tracking-Sets how far the pointer travels w hen the mouse is moved 
quickly. 

• Command blinking-Sets the number oftimes the background behind com
mands (such as " Cut" in the Edit menu) fl ashes when a menu item is 
selected. 

• Insertion point blinking-Sets the speed at w hich the insertion point flashes. 

• Double-click speed - Selects the maximum acceptable duration between 
taps for double-clicking the mouse button. 

• Desktop pattern- Selects any of the 38 "standard " desktop patterns and 
allows you to create your own custom patterns. 

Control Panel 

6/20/84 

Fig. 6-30. The control panel desktop accessory. 
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MacTip 6-8 

As with most of the other desktop accessories, changes 
made to the control panel affect the Startup disk that's cur
rently in the drive (as you' ll recall, Startup disks are those 
with the Macintosh System Folder; they can be used to start 
the Mac). You can make a change on one disk, but the other 
startup disks won't be so changed. 

Alterations made during a computing session are tem
porarily stored in the Mac's memory. They stay there until 
you turn the power off. 

Setting the Volume Level 

The Mac's amplifier is hooked directly to a small internal speaker (the same 
kind found in transistor radios). The volume control gives you a way to increase or 
decrease the loudness of the sound coming out of the speaker. Likewise, if you 
have an external speaker hooked up to the Mac via the audio jack, adjusting the 
control changes the volume of the sound coming out of it. 

To change, drag the lever up or down, as shown in Figure 6-31. When the lever 
is all the way down (" 0"), the volume is turned off completely. No sound will come 
out of the speaker. Since you can't hear the Mac's warning beeps at this setting, 
you' re alerted in another way-the menu bar flashes black a few times. 

Setting the Key Sensitivity 

Unlike the keyboards of most other computers, the Mac keyboard is software 
controllable. That is, it's possible to change the way the keyboard works by using 
software. There's no need to take the keyboard apart and physically make changes. 

With the control panel you can vary the speed at which the keys repeat when 

7-
6-
5-
4-
3-
2-
1 
0-

.. ))) 
Fig. 6-31. Adjust the volume by dragging the control up and down. 
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they're held down. You can even turn the repeat feature off if you like. It's all done 
with the key repeat and key sensitivity selectors, located to the right of the pi-cture 
of the keyboard (center control panel). 

MacTip 6-9 

Some application programs can be quite noisy (par
ticularly games). You may want the people around you not 
to be bothered by the sound. At the same time, you may not 
always be able to turn the volume down or off because you 
want to hear what the Mac has to say. The solution? Hook up 
a set of earphones to the audio connector. The connector 
accepts the standard mini-phone plug (if the headphones 
don't have a mini-plug, use an adapter). 

One caveat: When using earphones, turn the volume 
down low, to 1 or 2. The normal setting of 5 or 6 is much too 
loud for earphone listening. And remember, if you're using 
stereo headphones, you'll hear sound in one ear (the left 
one) only. If this bothers you, purchase a stereo-to-mono 
mini-plug adapter. Most record and tape shops sell them. 

The Mac allows you to change the sensitivity, or touch, of the keyboard. If the 
keyboard touch is too light, for example, and you're getting extra repeated 
characters, decrease the sensitivity. The lower the sensitivity, the longer the key must 
be depressed before characters will repeat. If you're a touch typist, on the other 
hand, you'll probably want to set the keyboard sensitivity up as high as you can. 

Setting the keyboard sensitivity is a simple matter. To start, find the picture of 
the keyboard in the control panel (Figure 6-32). 

Fig. 6-32. The key repeat and sensitivity controls. 
Click a higher number to increase the repeat speed or sensitivity. 

The first row of numbers sets the key repeat speed. The second row of numbers 
is for setting the sensitivity. The selections are numbered 0 through 4: The lower 
the number, the less sensitive the keys. 

Normally, the keyboard sensitivity is set to 2 or 3. To change, just click another 
number. The current setting is shown highlighted. The new selection is recorded 
onto the disk and s~ays until you change it again. 
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Setting the Key Repeat Speed 
With the key sensitivity selector, you can adjust the time a key must be held 

down for the keyboard to go into auto-repeat mode. With the key repeat speed, on 
the other hand, you can vary the time it takes to produce each repeated character. 

The key repeat selector also has a set of numbers from 0 to 4 (the key repeat 
selector is easy to spot: there's a small icon of a turtle on one end, an icon of a 
rabbit on the other). 

For a normal delay of a quarter of a second or so between repeats, click the 
number 2 setting. For a longer delay between characters, click the number 1 set
ting. Likewise, select a much shorter delay by clicking the number 3 or 4 setting. To 
turn the auto-repeat off, click the 0 setting. 

Setting the Mouse Tracking 
The mouse lets you move the pointer to any part of the screen in a fraction of a 

second. In normal operation, when the mouse tracking selector is set to 1, if you 
move the mouse fast, the pointer moves farther. 

To see how this works, move the mouse slowly across your desk. The pointer 
will move in nearly a 1-to-1 ratio with the mouse. If you move the mouse five 
inches, the pointer will move about five inches. 

Now, move the mouse five inches once more, but whip it across the desk quick
ly. The mouse may have moved only five inches, but the pointer moved farther. 

If you'd rather have the pointer travel the same distance no matter how fast the 
mouse is moved, set the mouse tracking selector to 0 (as shown in Figure 6-33). 

To change the setting, just click in the appropriate number-1 (for variable 
ratio) or 0 (for constant ratio). The current selection will be shown highlighted. As 
with the other items in the control panel, the new selection is recorded onto the 
disk and stays until you change it again. 

Setting the Command Blinking 

When a command is chosen from one of the Mac's many pull-down menus, 
it's background flashes black a time or two. This provides a type of visual feedback 
that lets you know the command has indeed been given. The command blinking 
selector (upper right corner), controls the number of times a command blinks 
when they're chosen (Figure 6-34). 

Most Mac users set command blinking to 2 -each command blinks twice 
before it's carried out. To make things even more obvious, you can set command 
blinking to 3, for three blinks. If the blinking is annoying, set it to 1 or turn off the 
blinks by selecting 0. 

Setting the Insertion Point Blinking 

The Mac's insertion point (sometimes called a cursor) indicates where new text 
will be added when it's typed from the keyboard. To accommodate different tastes, 
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Fig. 6-33. Click "1" for a variable mouse-pointer 
movement ratio, "0" for a constant mouse-pointer ratio. 

Fig. 6-34. Click the number of times you want 
the commands to blink when you choose one from a menu. 

the control panel lets you change the speed at which the insertion point blinks (see 
Figure 6-35). 

The insertion point blinking selector is located right below the command blink
ing selector. You have three choices: slow-speed blink, medium-speed blink, and 
fast-speed blink 

To change the speed of the blink, click another number. You'll probably want 
to stick with the medium, number 2, setting. The medium speed is not too distract
ing; yet it's fast enough for the insertion point to be spotted easily. 

Setting the Double-click Speed 

As you've learned, double-clicking is the action of tapping on the mouse but
ton twice in rapid succession. With the double-click selector you can change the 
duration the Mac expects between the two clicks of a double-click. 

For example, you may want to set a long delay between mouse taps if you're 
new to the Mac and are having trouble getting the hang of double-clicking. Once 
you master the science of double-clicking, you can reset the delay. 

Rather than using numbers, the double-dick speed selector, located in the bot
tom right corner of the control panel, has three settings-slow, medium, and fast 
(see Figure 6-36). 

To select one of the double-dick speeds, click in the box below the delay you 
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Fig. 6-35. Click a lower number for a slow insertion-point blink. 

Fig. 6-36. Choose one of the three double-dick speeds by clicking in the appropriate box. 

want. As usual, the current setting is shown highlighted, and remains in effect until 
you change it again. 

Setting the Desktop Pattern 

The two large squares in the bottom portion of the control panel can be used to 
change the pattern of the Mac's electronic desktop from the usual medium-gray to 
black, white, checkerboard- in fact, just about anything (see Figure 6-37). 

The square on the right represents a miniature version of the Mac desktop. The 
white stripe at the top is the toy menu bar. 

The square on the left is a close-up of the series of dots that make up the pat
tern of the desktop. This square is there for more than just looks. You can edit the 
pattern with the aid of the mouse. More about this in a bit. 

Built into the Macintosh is a set of 38 different preprogrammed desktop pat
terns. As indicated in Figure 6-38, you can look at them all, one at a time, by click
ing on the right side of the miniature menu bar. 

A close-up of the pattern appears in the left square, which is more properly 
called the pattern box. The overall effect is shown in the right square, which is 
called the select box. 
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• • • • • • • • • • • • • • • • • • • • • • • • • 
Fig. 6-37. The pattern edit and pattern select boxes. 

• • • • • • • • • • • • • • • • • • • • • • • • • 
Fig. 6-38. Click on the right of the white strip at the top of the pattern select box 

to advance through the 38 patterns (or click on the left to go back through the patterns). 

To accept the new pattern (put it on the real desktop), click inside the main 
portion of the select box. If any of the desktop is in view, you'll be able to see the 
change. 

Continue clicking through the rest of the preprogrammed patterns. Eventually, 
after 37 clicks, you'll wind up with the 50-percent gray screen once again. 

If you get a bit overzealous with clicking the menu bar and whip past the pat
tern you want, you don't have to go through the set of 38 over again. Instead, click 
in the left side of the toy menu bar. This backs you up through the preprogrammed 
patterns. 

If you spot a pattern you like, but it's not perfect, you can change it. With the 
pointer placed in the pattern box, like the one in Figure 6-39, click dots to erase 
them, click any white area to create new dots. 

When you get the pattern just right, click in the main portion of the select box. 
Your new pattern will splash its way all over the Macintosh screen. 

Whatever you choose as your desktop pattern will remain until you change it 
again or start the Mac with another Startup disk. 

Incidentally, even though you may have edited an existing pattern, you haven't 
permanently changed it. To get it back, step one pattern forward, then one back 
(click on the right side of the mini-menu bar; then click on the left side). Your edited 
version will disappear; the original preprogrammed one will be as good as new. 
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Fig. 6-39. Edit the desktop pattern using the mouse. 

While the Mac's multipattern personality may be useful in some cases, most 
patterns are unusable for desktops because they tend to be extremely distracting. 
Imagine staring at a mad crisscross of lines all day long, or a desktop that looks like 
a piece of rattan furniture. For best results, stick with the 50-percent gray pattern. 

JUST THE BEGINNING 

Congratulations. With this chapter finished, you've learned everything you 
really need to know about the Apple Macintosh to use it effectively. Yet we've only 
touched upon the true power of the Mac. 

To investigate more, let's see how to use the Mac in everyday situations, using 
application programs. The next three chapters are for this very purpose. They intro
duce three popular optional programs for the Mac: Mac Write, for word processing, 
MacPaint, for creating freehand sketches and Multiplan, for manipulating figures in 
a spreadsheet format. 

Coops! Almost forgot. There's one last desktop accessory that may interest you. 
It's marked Puzzle. Go ahead. Call it up. Using the "blank" to provide maneuvering 
space, move the puzzle squares around until you have them arranged in the 
preselected numerical order of your choice. Remember this one when you need a 
diversion. 



CHAPTER 7 

An Introduction to MacPaint 

~e MacPaint program for the Macintosh provides you with a very versatile set of 
tools for graphic expression. What's more, MacPaint is easy to learn and use, so art 
doesn't have to be difficult. 

As you become an accomplished Mac Painter, you. may discover talents you 
didn't even know you possessed. Remember, Walt Disney started doodling on 
scraps of paper. For that matter, Pablo Picasso entered the world of art by making 
little books of line drawings and commentary. 

Whether you consider yourself an artist or you just like to play around with a 
sketch. pad, MacPaint is electronic manna from graphics heaven. 

The best part is that there are no brushes to clean, no pencils to sharpen, no 
stencils to cut. And you can integrate text in myriad styles, directly onto or into 
your graphic creations. The integration of words and pictures is particularly helpful 
if your drawing needs a label to help the viewer figure out what he or· she is 
viewing-whether it be a horse, your Uncle Jake, a Tahitian sunset, or your latest 
invention. 

Dare to experiment. No matter what you do, you can't ruin anything or waste 
paper. MacPaint is as indestructible as it is inspirational. 

What follows is an introduction to MacPaint, to get you started in your new
found artistic career. 

149 
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STARTING MACPAINT 

The several ways to start Mac Paint all share the requirement of turning on the 
Mac's power and inserting the MacPaint program disk. 

To create a new MacPaint document from the desktop, open the MacWrite/ 
MacPaint disk icon (by double-clicking it or selecting it and choosing the 
File//Open command). The result will look like Figure 7-1. 

Now that the disk is opened, start MacPaint by double-clicking the MacPaint 
icon or select the Mac Paint icon and choose the File//Open command. Allow a few 
seconds for the program to load (and for Bill Atkinson to take credit), and your 
screen will look like Figure 7-2. 

If, instead of starting a new document, you're going to re-edit an existing Mac
Paint file, open it instead. The MacPaint program will automatically start and the 
document will be placed in MacPaint, ready for work. 

MacTip 7-1 

To open a new file after you are already in MacPaint, 
close the current window by clicking in the close box (or use 
the File//Ciose command). Then use the File//New command. 

To open an existing file when you're already in Mac
Paint, close the window by clicking the close box, and use 
the File//Open command, as shown in Figure 7-3. A dialog 
box will appear. Scroll until you find the file you want, click 
it, and then click the Open button. 

Write/Paint 
5 it•ms 358K in disk 41 K availab1• 

Mac'v/rite Font Mover 

Syst~m F o ld~r ;mpty F ol~r 

Fig. 7-1. The MacPaint icon. Double-click it to 
start MacPaint, or click it and then choose the File//Open command. 
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-· 
Fig. 7-2. The MacPaint screen. Note the set of 

patterns on the bottom and the two rows of icons on the left. 

Open Paint Pictures 

Eject 

Cancel Driue 

... 

Fig. 7-3. When opening a document after you' re already in MacPaint, choose the 
File// Close command, then select the document you want by clicking its title. Follow up by 

clicking the Open button . 

MACPAINT'S EASEL 

The main MacPaint window, shown in Figure 7-2, is the painter's easel , the 
artist's sketch pad. This large window (31f.l-inches by S'lz-inches) lets you see that 
portion of the 8'/z-inch by 11-inch blank page on which you may work. You can 
draw lines, write words, sculpt textures, and more on the portion of the page visi
ble through this window. 

You can, as explained later, scroll to other parts of the page, or move the view 
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of the window. As you can see by looking at Figures 7-4 and 7-5, the window lets 
you see only a part of the page; the working portion that is accessible for graphic 
creation or alteration. More about this in a bit. 

TOOLS OF THE TRADE 

On the left side of the Mac Paint window is a block of twenty icons representing 
MacPaint's tools. When it's in the drawing window, the mouse pointer can assume 
the form and function of any of these tools. The Goodies// Introduction command 
provides the tool summary displayed in Figure 7-6. 

Looking at Figure 7-6, you' ll see the twenty tools grouped together on the left. 
In the upper right of this window (and the lower left part of the Mac Paint screen) is 
the line and border-width palette. The third group of MacPaint options is contained 
in the patterns palette. 

At any one time you can use one item (and only one item) from each of these 
three groups. You' ll always have one tool, one line width, and one current pattern 
selected (however, you don't have to make use of them all every time you use the 
MacPaint program). 

DRAWING AND PAINTING 

MacPaint gives the term " mixed media" a whole new meaning in the visual arts. 
You can mix drawing and painting techniques by switching from one tool to the other. 

The five tools that let you draw and paint are: 

../---· 
Fig. 7-4. The MacPaint window is only 3%-inches by S'/2-i nches. 
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Fig. 7-5. You can move the window (or 

the drawing) to create a picture up to 8Y2· by 11-inches in size. 

untitled 

lasso -+ p .. - , 
+- selection I I ,_ .... +-no border 

scroll-+ ~~ A +- text 
-./- }line & border 

area fill-+ ~ 
,,.~ +- spray paint - widths, rn~ltiple 

+-pencil - copy spacmg 
brush-+ 

lines -+ ""- g ~ 
+-eraser current 

D Ill pattern patterns 
! 

hollow 
0 • filled ~~ shapes 0 • shapes 

C? • 
(3 ll Cancel 

Fig. 7-6. The Goodies// lntroduction w indow. 
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• The paintbrush, for painting with any of 32 different brush tips and with any 
of 38 patterns (you can also create your own paint pattern; read more to find 
out how). 

• The pencil, for rough sketches or detailed work. 

• The paint bucket, for pouring patterns. 

• The spray can, for "touch-up" painting and graffiti artists. 

• The straight-line ruler, for drawing perfect computer-controlled lines. 

The Paint Brush 

The paintbrush tool is provided when MacPaint is first started (you can change 
it, of course, by clicking one of the other tools). Move the mouse pointer over the 
easel; the pointer turns into a round dot. Press the mouse button and move the 
mouse. Paint "flows" from the pointer and onto the easel. Let go of the button, and 
the paint stops. 

If you don't like the brush you're using, double-click on the paintbrush icon, or 
choose the Goodies// Brush Shapes command, You're greeted with a choice of 32 
different brush shapes and widths (Figure 7-7). The currently selected shape has a 
square around it. 

To choose another tip shape, click on it. The brush shape window will disap
pear. By the way, you must click on a tip to get rid of the window. If you decide you 
really don't want to change anything, click within the box that surrounds the cur
rent tip. 

The paint you apply to the easel comes from the patterns palette. The currently 
selected pattern is in the large window located on the leftmost edge of the patterns 

• • / " II e / ' 
• • / '\. 

• [] , .... 

Fig. 7-7. Click on another shape to select a new brush tip. 
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palette. When MacPaint starts, it thinks you'l l want to paint with black. But any of 
the other patterns wi ll do, too. To choose another pattern, just click in the appro
priate pattern box. More about patterns and textures later. 

The Pencil 

The pencil works much like a common preelectronic #2lead pencil, producing 
a line on the MacPaint easel (see Figure 7-8). Against a white background, the pen
ci l produces a black image. When drawing over a black background, the pencil 
provides a sharp, white line. 

Unlike the paintbrush tool, the pencil has only one tip. In addition, the pencil 
cannot draw with a pattern . 

The Paint Bucket 

The paint bucket is labelled "area fi ll" by Apple. It's job is self-explanatory: you 
use it to fill an area with the currently selected pattern. To fill the entire window with 
a pattern, o r a portion of it that has defined boundaries, follow this simple process: 

1. First, click the paint bucket tool. 

2. Click the pattern you want (your selection appears in the current pattern 
box on the left side of the patterns palette). 

3. Move the pointer (now shaped like a paint bucket) to the area you want to 
fill, and click (see Figure 7-9). 

., 

../-.... • -
Fig. 7-8. Use the pencil to draw thin lines. 
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../-.... -· 
Fig. 7-9. Use the paint bucket to fi ll any area with the currently selected pattern. 

When using the paint bucket tool to fill a shape, be sure that the shape has no 
gaps in its outline. If there are any gaps, the paint will come oozing out, filling the 
entire easel. If this happens, immediately choose the Undo command from the Edit 
menu. Then inspect the shape closely to find its hole(s), and repair them before 
refilling. (MacPaint has a useful feature called FatBits to make close examination 
easy. Read about it later in the chapter.) 

The Spray Can 

The spray can works like an artist's airbrush. Click the spray can, choose a pat
tern , and point to where you want to paint. Then simply press the mouse button 
and drag the spray over the area you want painted (see Figure 7-10). A quick pass 
gives a light touch of paint; holding the sprayer over the same spot or moving it 
slowly completely covers (" guaranteed one coat; lasts 20 years ... "). 

The Straightedge Line 

The straightedge line tool works like a straightedge ruler. Click the l ine icon, 
then position the crosshair-style pointer where you want the line to begin . Drag the 
mouse and a straight line follows . When you release the mouse button, the line 
stays put (Figure 7-11). By the way, until you let up on the mouse button, you can 
change the line- its length and orientation. 
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Fig. 7-10. The spray can works much like 

an airbrush (it's spray can't be adjusted, unfortunately) . 

.., __ ... 
• -

Fig. 7-11 . Use the line tool to create straightedge lines. Keep the 
mouse button pressed down as you drag the pointer until the line is just right. 
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MacTip 7-2 

For mechanical drawings (used in engineering, architec
ture, and perspective art), use the line tool in conjunction 
with the Goodies// Grid command and the " constrain" 
feature (that is, holding down the Shift key while drawing the 
line). 

CREATING SHAPES 

Ten shapes are provided in the tool box. When you click any of the hollow or 
filled shape icons, the pointer becomes a pair of crosshairs-a plus sign. 

You can create a square or rectangle, a cut-corner (picture frame) square or 
rectangle, or a c ircle or oval. You can also create a freeform shape or a polygon. All 
of these " hollow" shapes can be generated in any of the four solid-line widths 
shown in the line and border-width box (lower left corner). And if you hold down 
the Option key whi le dragging the pointer to create these hollow shapes, the 
border wi ll be in the current pattern ! Several examples are shown in Figure 7-1 2. 

The fi lled shapes work like the hollow shapes, but when you draw w ith them, 
their insides are automatically filled with the current pattern (Figure 7-1 3). 

In add ition to being able to choose one of four border widths, you can select 
the dotted-line option from the line-width box and your filled shapes will have no 
borders at all. 

--- -
---------

Fig. 7-12. Use any of the five unfilled shapes to create boxes, circles, rectangles, polygons, 
and freeform designs. 
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fig. 7-13. Use any of the five filled shapes to add the current pattern inside the shape. 

MacTip 7-3 

You ' ll need some practice in laying down the filled and 
hollow shapes exactly where you want them. The rectangles 
are the easiest: as you drag the mouse, the rectangles build 
from one corner. 

The circles and ovals are trickier, in that sometimes the 
starting point is not even within the finished form. Until you 
gain skill, it might be easier to draw the circles on a blank 
part of the easel and then drag them into position using the 
marquee and lasso tools (both described later in this 
chapter). 

TEXTURES AND PATTERNS 

At this point, if you aren't amazed at what MacPaint can do, you haven't been 
paying attention (or you know all about it already). 

There's more: 38 patterns and textures are at your fingertips. As you've seen, 
you can apply them with the paint bucket, the spray can, the paintbrush, the 
borders of the hollow shapes, and of course, the centers of the filled shapes. 
Perhaps the best part about the patterns is that they can be edited. It 's all done with 
the Goodies//Edit Pattern command. 

Choosing the Goodies//Edit Pattern command introduces the dialog box 
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featured in Figure 7-14. The box over the "OK' shows a close-up of the current pat
tern . The box over the "Cancel" shows how that pattern will appear on the elec
tronic easel. 

All patterns are made up of a series of strategically placed dots. For this figure, 
we started out w ith the all -black pattern, and c licked on some of the dots (squares). 
This had the effect of erasing them. Mistakes were corrected -dots added 
again - by clicking in the w hite portion (in other words, click on white to make 
dots; cl ick on black to erase dots). W hen all was finished, the new pattern was 
accepted by clicking the "OK" button. 

EDITING THE PICTURE 

The Edit menu and the several editing tools provided in the tool box add 
another dimension to the creative power of MacPaint. Used to edit a Mac Paint pic
ture are these tools and commands: 

• Lasso tool -to move objects around the easel and to select parts of the 
drawing to be cut or copied. 

• Marqu ee tool -also to move objects around the easel and to select parts of 
the drawing to be cut or copied. 

• Eraser tool- to erase parts of the drawing. 

• Edit//Undo command -to reverse the last edit ing o r drawing action. 

II. I •••• •• •• 
== 
~!;:] [ Cancel ) 

Fig. 7-14. Use the pattern edit box to make changes to the currently selected pattern. Use 
the mouse in the left square to draw or edi t the pattern. A sample of how the pattern will look 

appears in the right square. 
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• Edit//Cut command -to cut a selected object from the easel and place it in 
the Clipboard. 

• Edit//Copy command -to copy a selected object on the easel into the Clip
board. 

• Edit//Paste command -to place a cut or copied object stored in the Clip
board onto the easel. 

• Edit//Ciear command -to cut a selected object from the easel but not place 
it in the Clipboard. 

• Edit//lnvert command -to reverse the selected image (black to white; white 
to black) of an object. 

• Edit//Fill command, to fill the selected area with the current pattern. 

• Edit//Trace Edges -to produce an outline around a selected object. 

• Edit//Fiip Horizontal and Edit//Fiip Vertical-to flip a selected object around 
a vertical or horizontal axis. 

• Edit//Rotate-to rotate a selected object in 45 degree intervals. 

Maclip 7-4 

After you edit the pattern and install it by clicking the OK 
button, you can edit another one if you wish. When you 
close the picture document and exit MacPaint, the edited 
patterns on your drawing and in the pattern palette are 
stored with the document. The patterns will reappear when 
you reopen the document. 

When you select the eraser tool, the pointer becomes a white square that 
erases everything in its path (see Figure 7-15). You control its path and action, of 
course, by moving the mouse. When the button is down, the eraser erases. 

MacTip 7-5 

There are about 15 ways to erase: 
1. "White out" with: 

- White pencil 
- White paintbrush 
- White spray paint 
- White paint bucket 
- Any of the five solid forms, with a white pattern, 

with or without borders 

2. Drag the eraser over the area. 
3. Double-dick the eraser to erase the entire window. 

4. Select an area using the lasso, then strike the Back
space key. 

5. Select an area using the lasso, then choose the Edit// 
Clear command. 
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Fig. 7-15. Click the eraser tool and drag it across any part of the drawing you want to delete. 

6. Select an area using the marquee, then strike the 
Backspace key. 

7. Select an area using the marquee, then choose the 
Edit//Ciear command. 

8. Double-click the marquee tool to select the entire 
window, then hit the Backspace key. 

9. Double-click the marquee tool , then choose the 
Edit//Ciear command. 

10. Backspace to erase a selection. 

11. Choose the Edit//Undo command to erase (und o) 
the last action. 

12. Press the tilde ("'-) key to erase (undo) the last action . 

13. Choose the File//Revert command to erase 
everything since the last save. 

14. Double-click the hand tool to show page then drag 
the image off the page. 

15. Choose the Goodies//Show Page command and 
drag the image off the page. 

The lasso tool (in the upper left corner of the toolbox) lets you define an 
irregularly shaped part of a drawing or painting and then move that part intact, 
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placing it anywhere you wish within the window. Lassoing part of a drawing also 
selects it for any of several edit commands: Edit//Cut, Edit//Copy, Edit// lnvert, and 
so forth. 

Similarly, the marquee (next to the lasso) lets you define a rectangular or 
square block on the easel, and then move it to another place. It also selects a part 
of a drawing for any of several edit commands. 

If there is a background in the part of the drawing/painting you select, the mar
quee includes that background in the defined selection. The lasso, on the other 
hand, "pulls tight" around the item, excluding the background , so only the item 
itsel f is included. 

MacTip 7-6 

You can use the marquee to stretch or shrink the selec
tion, too (see Figure 7-16). Place the pointer on one side or 
corner of the marquee (be sure the pointer is arrow shaped or 
it won't work), hold down the Command key, and drag. If you 
don't like the way the selection was en larged or reduced, 
choose the Edit//Undo command and try again. 

As mentioned previously, when part of the picture is enclosed in the lasso or 
marquee, you can use the Edit menu commands (you can use the Edit//Undo com
mand at just about any time, to undo mistakes). 

To make a copy of the enclosed piece of picture, for example, choose the 

../· ··· · ·· · 
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Stretched with morquee 

Originol 
size 

., 

Fig. 7-16. Use the marquee to stretch or shrink a part 
of the drawing. Keep the mouse button down until you've finished resizing. 
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Edit//Copy command (Figure 7-1 7). This places the item enclosed in the lasso or 
marquee into the Clipboard, w here it can be used within the current MacPaint 
document, in another document, or even in another program, such as MacWrite. 
(Look for more about the Clipboard in Chapter 5, " Advanced Topics.") 

Likewise, choose the Edit//Cut command to take the item out of the pictu re, 
but st ill save it to the Clipboard. If you want to take an item out, but don't want to 
save it to the Cl ipboard, choose the Ed it//Ciear command. 

With someth ing in the Clipboard, you can use the Ed it//Paste command to 
place it back into the MacPaint easel. Just give the Edit//Paste command. The item 
w ill appear in the easel. 

If you don't li ke where the item is in the w indow, move it. Place the pointer 
over the item and drag it (make sure the pointer is in the shape of an arrow before 
you begin dragging). 

If you want a negative version of the image selected in the lasso or marquee, 
give the Edit//lnvert command. As shown in Figure 7-18, the enclosed area turns in
to a negative image. You can restore it to its original po larity by choosing the 
Edit// lnvert command once again. 

The Edit/ /Trace Edges command comes in handy when you are highlighting the 
object enclosed within the marquee or lasso. Tracing the edges creates a kind of 
pop art. Figure 7-19 shows our o riginal robot drawing after one treatment with 
Edit//Trace Edges. For a w ild and way-out look, repeat the Edit//Trace Edges 
command . 

Figure 7-20 shows the result of the Edit//Fiip Vertical command, used on our 

Trace Edges 3E:E 
Flip Horizontal 
Flip Uertlcal 
Rotate 

../-·--· 
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Fig. 7-1 7. The marquee and lasso let you use 
Edit//Cut and Edit//Copy, among other commands. 

., 
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untitled 

Fig. 7-18. The result of inverting. 

-· 
Fig. 7-19. The result of tracing. 

original robot. Enclose the object to be flipped top for bottom, and give the com
mand. To turn the image side to side, choose Flip Horizontal from the Edit menu. 

After you define a portion of the window with the marquee, you can use 
Edit// Rotate to turn the selected image on edge, so it is at right angles to its former 
position {see Figure 7-21). Keep Rotating to return the selection to its original 
upright position. . 

By the way, notice that Trace Edges, Flip Horizontal, Flip Vertical, and Rotate 
are not avai lable when an object is lassoed. These commands can be used only 
when you enclose the item with the marquee. 
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untitled 

Fig. 7-20. The result of flipping. 

Fig. 7-21. Select the part of the drawing to rotate and give the Edit // Rotate command. Keep 
giving the command to continue rotating. 

MORE THAN WORDS 
A pictu re may be worth a thousand words, but some pictures just aren' t the 

same without literary prose. Another tool in the tool box palette is the A icon, used 
for w riting text (the A probably stands for Alphabet). 
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Click the A icon, and th en cl ick anywhere in the easel. An insertion point will 
appear. Start typing. The text wil l appear at the insertion point (see Figure 7-22). 

MacPaint offers you several different typeface fonts to choose from. These 
fonts, some of which are illustrated in Figure 7-23, range from the seriousness of 
"New York" and " Toronto" to the highly stylistic forms of " Venice" and 
" London," to the outrageous fun of " San Francisco." 

Each of these fonts can be any of eight sizes, as shown in Figure 7-24. Type 
sizes are expressed in points, with approximately 72 points equaling one inch. 

MacTip 7-7 

MacPaint's text feature is great for captions, callouts, and 
annotations, but there are limitations: 

• There is no "word wrap" feature, so you must 
manually start each line of text. 

• If you type off the page, that text is lost and must be 
retyped. 

Text entered via the A icon can be set in regular style (" plain" ), or bold, ita lic, 
underline, outl ine, or shadow. All are set by choosing one of the commands in the 
Style menu (Figure 7-25). You can create combinations of styles, such as bold-italic, 
o r underline-shadow, or bold-italic-underline-shadow. Altogether, there are 27 
combinations of styles for each size and font. (When you want to go back to plain 
text, do so by choosing the Style/Plain command. 

../-·-· 

I 

., 

Fig. 7-22. Click the mouse where you want text to be inserted and start typing. 
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Monaco 
Chicago 
uenice 
London 
Athens 
San Franosc o 

New York ABCabcdefghijklm' 

Geneva ABC abcdefghijklmn 
Toronto ABCabcdefghijk 
Monaco AB Cobcde fghi jk l 

Chicago ABCab cdefghijk ln 

Venice ~Cabcdefghi.jfaftl.fl. 

1An~cm !~~e!g~ijk.!m~tOPCl 
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Fig. 7-23. A sampling of fonts available with MacPaint. Choose any of the fonts from the 
Fonts menu. 

Toronto plain 
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9 poinl 

12 point 

14 point 

18 point 
24 point 

36 poir1t. 
48 poi 

Fig. 7-24. Fonts can be sized between 9 and 72 points (72 points equals about one inch). 
Choose a size from the FontSize menu. (Actual sizes not shown) 
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Underline xu 
OlmQODIDCD xo 
~ xs 

../Hiign Left all 
Hlign Middle XM 
HI Ri ht MR 

Fig. 7-25. Add emphasis to any of the fonts with the commands in the Style menu. 

As if that were not enough, you can have your text aligned left (also called left 
justified or flush left), aligned right, or centered. These options, too, are available 
with the Style menu. 

All told, there are over 5,000 possible combinations of type fonts, font sizes, 
and alignments. 

SOME MACPAINT GOODIES 

Don't forget to use the many "goodies" offered by MacPaint. Appropriately 
enough, these are available under the Goodies menu. We've seen some of them 
already. Let's look at three more. 

The Grid 

The Grid is a pattern of invisible horizontal and vertical guiding lines. Brought 
into use by choosing the Goodies//Grid command, this feature is great when you 
need to add precision to your drawings and paintings. 

For example, you can create several lines, all the same length. Just choose the 
Goodies//Grid command (a checkmark will appear beside it, showing you that it's 
lion"), and use the line tool to draw some lines. let the Grid feature be your ruler 
(see Figure 7-26). 

Fat Bits 

FatBits is a supermagnifying glass that magnifies a small portion of the easel to 
full-screen size, so that the individual dots that make up a picture are clear and 
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Brush Shope 
Brush Mirrors 1-------------
1 ntroduction 
Short Cuts 

Fig. 7-26. Use the Goodies// Grid command to control many of MacPaint's drawing tool s. 

easily manipulated. This feature is great for detailed drawings or for 
" microsurgery" on problem areas in a half-finished painting. Figure 7-27 shows an 
image before (a) and after (b) magnification with FatBits. 

To use FatBits, select the point you want to view at supermagnification (use a 
nonmarking tool , such as the lasso or marquee). After getting into the FatBits mode, 
use the pencil (or another drawing tool) to change the individual dots. Click on a 
dot to erase it; click on white to draw more dots (see Figure 7-28). If you want to 
change many dots at once, drag the mouse. 

Note than in Figure 7-28, the modified drawing appears at its normal-scale size 
in the upper left corner of the easel. 

In FatBits, you can view approximately 1 V2 percent of the total window at one 
time, or approximately VJ of 1 percent of the total accessible area on a full-size 
page. You can scroll the FatBits image up and down, left and right to see more area, 
as described in "The Hand Tool," later in this section. 

When you 've finished with FatBits, click anywhere in the postage stamp-size 
section in the upper left corner of the easel. 

Brush Mirrors 

Brush Mirrors lets you create, among other things, your own ink blots. W hen 
you choose the Goodies// Brush Mirrors command, you' ll see the dialog box 
shown in Figure 7-29. Select one or more of the four transect lines to give you 
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(B) 

Fig. 7-27. (A) The screen before Goodies// Fat Bits. 
(B) The pictu re zoomed in. 

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • 
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single-mirror or multiple-mirror drawing effects . A multiple-mirror effect is shown 
in Figure 7-30. 

A single mirror gives you an equal and opposite copy of whatever you draw 

• 
• • • • 

• • 
• 
• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • 

Fig. 7-28. Use the mouse to add or delete individual pi npoints of the picture. 

OK None 

Fig. 7-29. Click one of the four transect lines to create various brush mirror effects. 
When you've finished selecting, cl ick the OK button. To stop mirroring, click None. 
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Fig. 7-30. Using Goodiesf/Brush Mirrors with all four transect lines selected. 

with the paintbrush . (Only the paintbrush tool works with mirrors, w hich is pro
bably why it's ca lled Brush M irrors.) 

When you select all four transect lines, the image appears as eight equal reflec
tions-much as it would in a kaleidoscope. 

When you want to stop mirrored painting, choose the Goodies//Brush Mirrors 
command once again and c lick in the Cancel button. 

MOVING THE PICTURE AROUND 

As you know by now, the total page size can be bigger than the Mac Paint easel. 
You can draw on one large 8Y2 by 11 -inch piece of paper, but you can see only one 
small section of it at a time. The challenge, then, is to move the page beneath the 
window, or move the window above the page. There are two ways of doing this. 
One is by using the hand tool ; the other is by using the Goodies//Show Page com
mand. 

The Hand Tool 

The hand tool is a convenient vehicle for moving the drawing paper beneath 
the main Mac Paint window. Imagine, if you wil l, that Mac Paint's electronic easel is 
a large sheet of paper, upon which you can pai nt or draw. Also imagine that hover
ing above it is a glassless frame, such as a picture frame or w indow frame. Balanced 
on the edges of the frame are the too ls and palettes. 
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MacTip 7-8 

When you use the Brush Mirrors feature, the junction of 
the mirrored images is approximately the midpoint (horizon
tally and vertically) of the electronic easel. 

If you want to use Brush Mirrors to create a symmetrical 
element for a larger drawing or painting, it's probably easier 
to scroll to the edge of the drawing, create the mirrored 
form, select it (lasso or marquee), and drag it to where you 
want it. 

The hand tool lets you put your "hand" through the open window and effort
lessly move the paper beneath it. You can scroll up or down, right or left, in any 
direction. To move the paper you click the hand icon; the pointer becomes a little 
hand (Apple calls this the Grabber) that enables you to push the page around, even 
if you're in the Fat Bits mode (see Figure 7-31 ). 

The Goodies//Page Command 

The Goodies//Show Page command gives you a macroscopic view of the page, 
the image you've painted, and the window that links the page and the image area. 
Just as the FatBits feature allows you to get microscopically close, the 
Goodies/IS how Page command lets you take a few steps back and view your efforts 
from a broader perspective. Look at the familiar MacPaint image in Figure 7-32. 

With Show Page, you see the picture you're working with on an 8112 by 11-inch 
piece of paper. You can move the window or the picture. 

To move the window (the dotted box on the screen), position the pointer 
within the box and drag it (Figure 7-33). To move the image on the page, place the 
pointer anywhere outside the box and drag (Figure 7-34). Should any of the 

Fig. 7-31. Move the drawing around the window using the hand tool. 
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Fig. 7-32. MacPaint window, normal view. 
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Fig. 7-33. When in the Show Page mode, move the window 
(to see another part of the picture) by placing the pointer inside the box and dragging. 
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fig. 7-34. When in the Show Page mode, move the entire picture 
on the page (to reposition it, for example) by placing the pointer anywhere 

outside the box and dragging. 

drawing go off the page and you don't want it to, get it back now . If you leave Show 
Page by clicking the OK button, any slipped portion of the drawing wi ll be lost 
forever. 

The ability to move the window is important, for example, if you want to posi
tion a drawing at the middle or bottom of a page instead of in the normal top center 
position . 

MacTip 7-9 

To eliminate an unwanted drawing, choose Goodies// 
Show Page, drag the image off the page, and click the OK 
button. The drawing is gone forever. This is particularly 
handy when you want to eliminate a drawing that is larger 
than the w indow. 

Moving the image or the window is necessary if you want to create full-page 
art. Even though you can work on only part of the picture at a time, you can create 
parts segmentally, like Michelangelo working on one small part of the Sistine 
Chapel at a tim e. 
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TRICKS AND SHORTCUTS 

We've talked about many features, but MacPaint has still more tricks and short
cuts to offer. You don't need to memorize all these shortcuts; in fact, you can refer 
to MacPaint's shortcuts with the Goodies//Short Cuts command (Figure 7-35). 

Double-Click Shortcuts 

Double-clicking provides a faster way of getting results than using the menu 
commands : 

• Double-clicking the hand takes you to Show Page. It is the same as choosing 
the Goodies//Show Page command. 

• Double-clicking the paint brush brings up the brush-shape choice. It is the 
same as choosing the Goodies//Brush Shapes command. 

• Double-clicking the marquee tool instantly "selects" the entire MacPaint 
window. This sets you up for full-window copying, clea ring, cutting, or 
other editing chores. 

• Double-clicking the pencil puts you into FatBits mode. It is the same as 
choosing the Goodies//FatBits command. From within FatBits double-cl ick 
the pencil icon to return to the normal window. 

• Double-clicking the eraser wipes clean the entire drawing w indow. 

• Double-clicking any pattern makes that pattern current and calls up the pat
tern edit w indow. It is the same as selecting a pattern and then choosing the 
Goodies//Edit Pattern command . 

0 untitled 

Double 
Click 

Select Window 

Sho\11 Page 

Brush Shape 

FetBits 

Erese Window 

IOptioolf!:] Multiple Copie~ 

!Option! Pellerned Lines & Borders 

!Option! (I Scroll FatBits 

U (I Enter or leave FatBits 

~[] Change Font Size 

~lstm I[] Change Font ~~~ Edit Pattern 

~000000000000~ 
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CJOOOOOODOOODD 
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Fig. 7-35. The Goodies//Shortcuts window. Refer to it often. 
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MacTip 7-10 

When you double-click the marquee tool, the entire 
window is selected with a moving dotted line (like the lights 
on a theatre marquee). If you press the Backspace key at this 
point, the entire window will be automatically erased. 

Constraining 

Constraining is a limiting feature that makes it easier to draw straight lines that 
are horizontal, verticaL or (sometimes) at 45-degree angles. It also allows you to 
make perfect squares and circles with the rectangle and circle shape tools. 

Here are the basic instructions for constraining: 

1. Click the tool you want to use. 

2. Hold down the Shift key (and keep it down until you finish drawing). 

3. Draw with the tool. 

Here is what happens when you constrain the various tools: 

• If you constrain the hand, you can move the document sheet vertically or 
horizontally only. 

• When you constrain the paintbrush, pencil, spray can, or eraser, you can 
draw only horizontally or vertically. 

• Constraining the line, open polygon, or closed polygon shape limits the line 
to positions 45 or 90 degrees from horizontal or vertical. 

• Constraining the hollow and filled rectangles (rounded-corner or plain) 
restricts these forms to creating perfect squares. 

• If you constrain the circle (filled or hollow), using it will result in perfect 
circles. 

• Constraining in the Show Page mode limits the movement to horizontal or 
vertical only. This applies to the motion of both the window (the dotted box) 
and the image on the page. 

Copying 

Copying shortcuts are straightforward. First, select the area to be copied using 
the lasso or marquee. After selecting, place the pointer inside the now-defined area 
(the pointer should turn into an arrow). Hold down the Option key while you drag 
the selection. As the selection moves on, a copy remains behind (Figure 7-36). 

Multiple Copying 

Multiple copying is a natural extension of the single-copying process described 
previously. First define the selection with the lasso or marquee. Then move the 
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untitled 

Fig. 7-36. Copy a selection by holding down the Option key while you drag it. 

pointer inside the selected area (as before, the pointer should turn into an arrow). 
Hold down the Option and Command keys and drag. 

When making multiple copies, the speed of dragging determines the number 
and approximate spacing of the copies. If you drag slowly (like dragging your feet 
whi le you walk), the images appear tightly grouped. If you drag quickly, the images 
are spaced farther apart (see Figure 7-37). 

Fig. 7-37. Make multiple, repeating copies by 
holding down the Option and Command keys while dragging the selection. 
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You can control the image-to-image spacing somewhat by selecting a thicker 
border width from the border-width palette. 

MacTip 7-11 

Stretching or shrinking a selection is constrained by us
ing the Shift key in conjunction with the Command key while 
dragging a selection. The result is that the image changes 
size, but maintains its original proportionality. 

Copying and multiple copying is constrained by using 
the Shift key with the Option or the Option and Command 
keys, respectively, while dragging a selection to make copies 
on a vertical or horizontal plane only. 

If you don't like the way your multiple copies turned out, choose the Edit// 
Undo command (or strike the I key), and you'll be ready to try again. 

DESKTOP ACCESSORIES 

The Mac's desktop accessories are fully functional with MacPaint. One you'll 
use quite often is the scrapbook. To place a drawing of your own design into the 
scrapbook, select the drawing and Cut or Copy it using the Cut or Copy command 
from the Edit menu. Then call up the scrapbook and give the Edit//Paste command. 
Do just the reverse to take something out of the scrapbook and place it in a Mac
Paint document. 

After you've called up one of the other desktop accessories, you'll have to put 
it away before you can return to MacPaint. Unlike some other Macintosh software 
(such as MacWrite) MacPaint does not allow you to have a desktop accessory on 
the screen and continue with the program. 

SAVING PICTURES 

Saving pictures is a simple task. To save a finished or partially finished drawing, 
use the File//Save command. If this is the first time you've saved the document, 
you're asked to give it a name (names of documents can be up to 63 characters 
long and can include any character except a colon). When you've finished entering 
the name, click the Save button (see Figure 7-38). Once you've given the docu
ment a name, the Macintosh will no longer ask its name if you choose the File//Save 
command to save it or a modified version of it. 

MacTip 7-12 

When you are working on a drawing and you are 
satisfied with progress thus far, be sure to File//Save it. Do it 
often. It's a simple habit to develop, and it'll save a lot of grief 
if you botch a promising masterpiece. 
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Saue document as: MacDriue 
I Lot sa Robots ( Eject ) ... ( Cancel ) ( Oriue ) 

Fig. 7-38. When saving documents, give them meaningful names (meaningful to you, that is). 

You might note that the File menu offers both Save and Save As commands. 
The former is for saving a document, plain and simple. Save As is applicable, on the 
other hand, when you have already saved a document and want to keep a varia
tion of it under a different name. Keep in mind that using the File//Save As com
mand doesn't rename the original MacPaint document, but creates another one. 

PRINTING 

There are three print commands in MacPaint; all three are accessed through 
the File menu. 

File//Print Catalog gives you a listing of MacPaint documents on your disk. To 
help you better keep track of your drawings, you get tiny thumbnail sketches, like 
that shown in Figure 7-39. Although the images aren't detailed or totally legible, 
they serve their purpose. 

The File//Print Draft and File//Print Final commands both produce a nearly 1:1 
paper copy of your Mac Paint document (when used with a compatible printer such 
as the Apple lmagewriter). The difference between the commands is this: When 
printing with File//Print Draft, the printer's printhead (the part that actually creates 
the images on paper) makes one pass for each printed line; with File//Print Final 
(Figure 7-40), the printhead goes over each line twice, making a darker and more 
"filled-in" picture. Before using any print command, make sure the printer is on 
and selected (the "Select" or "Ready" light will glow). 

BACK AT THE DESKTOP 

When you've finished playing with MacPaint, exit the program by choosing the 
Quit command from the File menu. If you haven't saved the latest version of the 
picture, MacPaint will prompt you to do so (just click the Yes button to save it). 
Within a few seconds, you're back at the desktop. 

You can, if you wish, eject the disk and turn the Mac's power off, but you can't 
turn off the creative inspiration of having experienced MacPaint, one of the most 
powerful, thoughtful, and simplistically beautiful pieces of graphics software available. 
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M6cP6!nt documents on d1sk C11ckArt 

Farm Animals Presidents Statues Farm House Al & Jimmy 

---

T.J& 
Rain/Chef Wine&. Beer Gorilla Skyhnes Cartoons 

egret Good guys Celebrities Borders Arrows 

Cats Cars Bigger guys Little guys Hopefuls 

David More Li tt 1 e guys Billboards Skier/Football Americana 

Fig. 7-39. A sample MacPaint catalog. 
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Ot)t~n ......... 
Close 
Saue 
SaueRs ... 
Reuert 
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Print Final 
Print Catalog 
Quit 

Fig. 7-40. Use the File//Print command to make a paper copy of your masterpiece. 



CHAPTER 8 

An Introduction to MacWrite 

At one time or another everyone writes, whether it's just a simple memo, a per
sonal letter, or a lengthy dissertation. Typing the document by hand usually 
requires at least one draft before the final copy. Any changes or corrections cause a 
messy splotch on the page or require the page to be completely retyped. 

Use the Macintosh with a word processor program and it turns the computer 
into a fancy all-electronic typewriter, making the job of writing much less of a chore 
and a lot more fun. Changes, right up to the last minute, are easy and quick to per
form, and the final copy always looks clean. 

This chapter guides you through the basics of MacWrite, the first word process
ing program written exclusively for the Macintosh. 

WHAT MAKES MACWRITE SPECIAL 

MacWrite is not the ultimate in complexity among word processing programs. 
Many other programs are more intricate and therefore more difficult to use. 

MacWrite is, however, perfect for the person who writes letters, memos, even full
lengthnovels, and doesn'twant -to spend a lot of time learning cryptic codes. With 
MacWrite, you type just as if the Mac were a regular typewriter. When you've finished, 
go back and make the changes or corrections needed. Then, print out the final version. 

185 
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It is in making changes that MacWrite proves to be a more than adequate word 
processing program. Any changes made will be neatly incorporated into the text. 
MacWrite rearranges the entire text to fit the change onto the page. For example, if 
a line or word is deleted, the text closes up so that there is no telltale gap remain
ing. MacWrite is almost automatic in operation. 

MacWrite also excels in using simple commands. Other word processing pro
grams use cryptic codes that bear little resemblance to the actual message you are 
trying to give the computer. MacWrite's pull-down menus let you select the com
mand you want by choosing a simple English word. " Cut" means remove or delete. 
Changes to the format, the way the page is set up, are equally easy with MacWrite. 

MacWrite doesn' t have a lot of excess baggage to slow you down. Its simple, 
easy mode of operation makes it a worthwhile program to learn . 

STARTUP 
When you want to write a letter, for example, getting started is just as easy as 

sitting down in front of the Mac, twning it on, and putting the MacWrite disk in. 
Once the disk has been loaded and the Macintosh desktop ISm v1ew, QEen the 

MacWrite/MacPaint disk icon (by double-clicking it or selecting it and choosing the 
File//Open command). The result will look like Figure 8-1. 

Now that the d1sk is open, start MacWrite by double-clicking the MacWrite 
icon, or select the MacWrite icon and choose tlieFITe7/0pen co~nd. Allow a 
few seconds for the program to load. Your screen will look like"Ffgure 8-2. Started 
this way, MacWrite automatically opens with a blank sheet of paper. The title bar 
says " Untitled," but you can fix that later . 

Write/Paint 
358K in disk 41 K availabh~ 

MocPoint Font Mover std. char . 

System Folder Empty Folder 

~ 
EJ 
3d pie 

Fig. 8-1. Double-cl ick the MacWrite icon to 
start MacWrite, or click it and choose the File//Open command. 
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!0 Untitled M Et..J lA. f:A L 
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cY ~~ tt ~~13 ~~~~ 
I 

Fig. 8-2. The MacWrite writing pad. Once you see it, just start typing. 

If, instead, you're going to re-edit an existing MacWrite document, open that 
document instead. The MacWrite program will automatically start and the docu
ment wi ll be placed on the writing page, ready for work. 

MacTip 6-1 

To open a new file after you are already in MacWrite, 
close the current window by ciTCJ<Irigin the close box (or use 
the FJiei/Ciose command), and use tlieRief/New commanO. 

To open an existing file when you are already in Mac
Write, close the window by clicki"ngtheclose box, and use 
the File//Open command, as shown in Figure 8-3, The result 
will be a d ialog box; scroll until you find-the fi le you want, 
cl ick it, and tn en cl ick theTipen button. 

At the top of the MacWrite sc reen, below the menu bar, is a MacWrite ruler. It 
controls margins, tabs, line spacing, line alignment, and more. We' ll get back to 
the ruler in a bit. --

Immediately below the ru ler is a blank screen- Mac Write's writing__Qad. The 
insertion point (sometimes ca lled the cursor), is in the upper left corner. When you 
begin typing, the words appear right there. 
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Chapter 1 
Chapter 10 - Dreamer 
Chapter 11 
Chapter 2 Eject 
Chapter 3 

Cancel Driue 

Fig. 8-3. When opening a document after you're already in MacWrite, choose the 
File//Ciose command, and then select the document you want by clicking it. Follow up by 

clicking the Open button. 

When you type, there's no need to press the Return key when you reach the 
endof the line. MacWnte does it for you automaffi:ally~Wordsthal are too--long to 
fit will be moved down to the next line. Of course, if you want to end a line 
yourself- at the end of a paragraph, for example-press Return and MacWrite will 
oblige. A new paragraph will be formed. 

I 
MacTip 8-2 

~dd a blank line to text by pressing the Return key. Keep 
pressing the Return key to add more lines. 

MOVING AROUND 

You get around the MacWrite writing pad the same as you would any other win
dow. As you type, MacWrite will automatically~~cr_q_ll_the_tex!_up__~~r:Q_,_ so there's 
always enough room below for more words. When you want to scroll back toward 
the beginning of the text, use the up scroll arrow-ornelevato-r(see -FTiure-8-4T~ 

You'll notice that while you can scr_q!_L to_~la~k_par!_s_Qf !_h_e paper belo~- tb._e 
existing text, you won't be (!hie to _P-lace !!l~-L~~_nign_ru>lnt_ there. There's a good 
reason for this. The insertion point can't be moved into a part of the document 
where you haven't yet typed. 

EDITING 

Making changes to your document is characteristically easy with MacWrite. If 
you know how to edit on Mac's desktop using the Edit menu, you know how to 
edit with MacWrite. Little is different. 

To make any change, including additions and deletions~_~!~rt_by_po~~ioning the 
insertion point where the change needs to be made. 
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A Journey •.. 
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Chapter 1 

My Uncle Makes a Great Discovery 

Looking back to all that has occured to me since that eventful day, I am 
scar~ely able to believe in the reality of my adventures. They were truly 
so wonderful that even now 1 am beWildered When 1 think or them. 

My uncle was a German, having married my mother·s sister, an 
Englishwoman. Being very much attached to his fatherless nephew, he 
invited me to study under him In his home in the fatherland. This home 1~1:' 
was in a large town, and my uncle a Professor or philosophy, chemistry, !!!:'' 
geology, mineralogy, and many other ologles. :iijl! 

One day, after passing some hours In the laboratory -- my uncle being .,., .. 
absent at the time-- I suddenly felt the necessity or renovating the tissues ~ _ s,c root-
--I.e., I was hungry, and was about to rouse up our old French cook, When ~ ELE'{A101V 

Fig. 8-4. Scroll up and down the document by dragging 
the elevator. Alternatively, press the up or down scroll arrow. 

MacTip 8-3 

To scroll up and down by the windowful, click an where 
in the shaded portion of the scroll bar. With each--cliCk, 
yOU'l l jump the contents of the window up or down one 
complete window. 

To add new text, just start typing. MacWrite automatically reformats the 
paragraph to accommodate the new addition . 

.Deleting text is a bit different, depending on how much you want to erase. If 
it's just a character or two, place the insertion point right after the text to be deleted 
and then press the Backspace key. Keep hitting the Backspace key for each 
_character you want to erase. 

If you' re going to be getting rid of several words or more, highlight that text by 
dragging the mouse over it (see Figure 8-5). When the Backspace key is pressed, 
the hi&b.!lghted text all disappears. 

As a shortcut, if all you want is to delete a single word, don't bother dragging 
over it. Double-click on the offending_word instead_ This will highlight the entire 
word automatically. 

To cut and paste or copy and paste text to other parts of your document, use , 
the Edit commands. Neither Cut nor Copy is active unless you highlight some text. 
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g IS woman emg very muc a ~c e 1s a er es nep ew. e 
tnvited me to study under him in his home in the fatherland. This home 
\'laS in a large town. and my uncle a Professor or philosophy, chemistry, 
geology, mineralogy, and many other olog!es. 

One day, ar~r passing some hours in the laboratory -- my uncle being 
absent at the time -- 1 suddenly felt the necessity or renovating the tissues jijij: 
-- i &., 1 wa·: llungry, and was about to rouse up our old French cook, When 
my un..::e. Pr·)fessor Von Hardwigg, suddenly opened the stieet door, and 
~·arne rushmg up the stairs. 

Now, Professor Hardwigg, my worthy uncle, is by no means a bad sort 
or man. he 1s, how~ver, choleric and original. To bear with him means to 
obe~·; and scarcely had Ills heavy teet resounded within our joint domicile 
than he shouted for me to attend urn him. 

I hastened to obey, but before I could reach his room, jumping three 
steps at a time. lle was stamping his right root upon the landing. 

-Harry!" lle cried, in a frantic tone. ·are you coming up?" 
Now to tell the truth, at that moment I was far more interested in the 

uestion as to What was ~ constitue o r di e than in an rob em · 

Fig. 8-5. Select text by dragging over it. In addition, 
you can select a series of words by shift-clicking each one in turn. 

Maclip 8-4 

To select a large segment of text: 

1. Click at the beginning of the text to be selec~ 

2. Move the mouse to the end of the text to be selected. 

3. Press the Shift key and click once again. All the text 
between will be higb.!lghted. -- -

When you invoke the Edit//Cut command, MacWrite takes the higb.Jighted text 
out and puts it in the Clipboard. Place the insertion point where you want the text 
to reappear. Then choose Paste from the Edit menu. 

The Edit//Copy command is similar, but the original text does not come out of 
the document. It remains intact, and a copy of it goes to the CliRboard. Once 
again, it can be placed anyw here else in the document using Ec!it//Past~ 

At any time, you can see the contents of the Clipboard by choosing _!b_e 
Edit//Show Clipboard command. You' ll be able to see the first five lines only, but 
this should give you a fair idea of w hat's in there. 

Should you make a mistake and take out too much text, fo~mRie, feel free 
to use Edit//Undo. Keep in mind that the Edit//Undo comm and works to undo only 
the last action you did. -
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RULERS 

It is a sim le matter to set up the page format the way you want it. As mentioned 
above, along the top of each MacWrite ocument IS a ru er 1gure 8-6). It has all the 
icons you will need to set up the margins, tab stops, spacmg, and text alignment. 

Margin markers are shown as black triangles. Using the mouse, select the 
margin marker on the right side of the ruler and drag-lfover!9 tJ}~_ -~-iS''_mark. As 
shown in Figure 8-7, you have just set the right margin of your text at five inches 
from the left edge of the pa~er. --------

The left margin is set the same way. It is easy to change the margin settings at 
any time, even after the text is written. just return to the ruler and drag. All the text 
that follows will realign itself automatically. 

Tab stops are similarly set. The tab wells look like boxes with triangles in them. 
Click in the tab well, as shown in Figure 8-8, and drag one of the triangles to where 
you want a tab. 

' 

JfB~· .~. 'r~!iil~'~(' ' , ~~~~~t~~ec~~r<:(,LS 
Fig. 8-6. The MacWrite ruler, used to format text. 

ey ... 

........ L. ..... J.. ...... .J.~.L ... .L ........ 1. ..... 0 .1 ........ 1 .~.L ... 
mws~ ~~ [&) [1 

Fig. 8-7. Adjust the margins by dragging the. 
black triangles. This one, the right marglrl marker, is at the 5-inch mark. 

-~-.L ....... L ....... .l ....... .1? .. . 

~G51 
Fig. 8-8. Pull tabs out of the tab well. The clear triangles 

are standard text tabs; the dotted triangles are decimal taos. 
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MacTip 8-5 

To delete a tab, drag it away from the scale inside the 
ruler. When you release the the mous~ bl!!-'.Q~, the tab wiJL. 
disappear. 

There are two types of tab wells: one is for standard tabs; the other is for 
decimal align tabs. Decimal align tabs are triangular in shape, too, but they nave a 
dQt inside. All numbers with a decimal (such as dollars and cents), typed at a 
decimal tab stop will be aligned decimally. This is very useful for financial reports, 
for example. 

Hidden under the left margin marker is a little black cross. This is an indenta
,tion marker (see Figure 8-9). It serves as an automatic tab. ltyou--placelt wneretfie 
usual paragraph indentatioJ]..is_to...be., every time the Return key is pressed, the next 
line will begin at that f?~int. It is a shortcut to tabbing over for a new paragraph. 

1 "2 l-j:··.L ........ 1... ..... .1 ...... ~ ... 

Fil~ 
Fig. 8-9. Like setting margins, setting the indent marker (arrow) is done by dragging it. 

Another useful feature of the indentation marker shows up when it is placed to 
the left of the left margin. In a g[ossary, for example, the main body of text-the 
definition of the word -is set in, while the word to be defined is flush on the left 
margin (Figure 8-10). Thi·s is more properly called "outdenting." ·---- ---

The next set of boxes in the ruler are space boxes. They are for single, space
and-a-half, and double spacing the text. Select the spacing you prefer by clicking in 
the box. The box will then go black. like the margin markers, the s-pacing can be 
changed at any time, and MacWrite will adjust all the text that follows. 

The last set of boxes controls the alignment of the text- how the text is spaced 
on each line of the page. The first one, shown in Figure 8-11, is for left alignment 
and is the most commonly used. This kind of alignment is known as "flush left," 
which means that all lines not indented with a tab will start at the left margl!l~ 

The second alignment box is for centering, useful for titles and for making invi
tations. for example. Click it, and all lines will be centered_jFigure 8-12). 

As shown in Figure 8-13, the third is for right alignment, also called "flush 
right." It sets all lines of text even with the right margin. 



,. j File Edit Seurch 

~0 

ac ntosh --The computer for the rest of us. All-ln-one design boasts a 
·mouse,- windows, and Icons. 

Mac Write -- The word processor ror the rest of us. Type on the screen; 
that's how it looks on paper. 

Fig. 8-10. A sample of "outdenting." 

My uncle Makes a Great Discovery 

Looking back to all that has occured to me since that eventfUl day, I am 
scarcely able to believe in the reality of my adventures. They were truly 
so wonderful that even now I am bewildered When I U1ink or U1em. 

My uncle was a German, having married my mother·s sister, an 
Englishwoman. Being very much attached to his fatherless nephew, he 
invited me to study under him in his home in the fatherland. This home 
was in a large town, and my uncle a Professor of philosophy, chemistry, i 
geology, mineralogy, and many other ologies. 

One day, after passing some hours in the laboratory -- my uncle being 
absent at the time -- I suddenly felt the necessity or renovating the tissues 
--i.e., I was hungry, and was about to rouse up our old French cook, When 

Fig. 8-11. Left-aligned text. 

0(\ 
'\ 
'93 
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. :o A Journey ... 
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. ~~ ~[§]~ ~~~~ J: 
·: ll<~pter i 

My UtKie Mal:<:-~. a Great Dtscw.:,ry 

Fig. 8-12. Centered text. 
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!0 A Journey ... 
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Chapter I 

My Uncle Makes a Great Discovery 

Looking back to all that has occured to me Since that eventful day, 1 am 
scarcely able to believe In the reality of my adventures. They were truly 

so wonderful that even now I am bewildered When I think of them. 
My uncle was a German, having married my mother 's sister, an 

Englishwoman. Being very much attached to his fatherless nephew, he 
invited me to study under him in his home In the fatherland . This home 
was in a large town, and my uncle a Professor of philosophy, chemistry, 

geology, mineralogy, and many other ologles. 

., 

One day, after passing some hours in the laboratory --my uncle being 
absent at the time -- I suddenly felt the necessity or renovating the 

tissues-- i.e., I was hungry, and was about to rouse 1JP our old French Q] 

Fig. 8-13. Right-aligned text. 
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The ~urth box is for full justification. It's used to space your text as though it 
has been typeset. Also called "justified," it alters the spaces between words so that 
the text is evenly spaced along the line and justified with both the nght and left 
margins (see Figure 8-14). 

MULTIPLE RULERS 

It is entirely possible to have more than one ruler governing a document. You 
may have noticed that every time we talk about changing something in the ruler, 
we say that the change affects all the text following the ruler. You can have any 
number of rulers in a document; each ruler controls the text that follows imme
diately after it. When another ruler comes along, the format is again changed. 

Suppose you want to center the chapter title on the first page of your latest 
magnum opus. To begin, select the center alignment box in the ruler. Every line 
you type following that ruler is centered (see Figure 8-15). 

Now, you're ready to start your text. But, no matter what you do, each line is still 
centered! Remember that all the text following the ruler is governed by that ruler. 
MacWrite needs to be told to stop centering, so another ruler must be inserted. 

To add another ruler, first be sure that the insertion point is flashing where you 
want the new ruler to appear. In this case, 1t's below the centered-tltre.-then, 
choose the Insert Ruler com-mand by pulling down the Format menu. The new 
ruler will appear at the position of the insertion point. 

Make the changes necessary in the new ruler. Change from centering to left 
alignment, for example, and all the text that follows will conform (Figure 8-16). 
When you start typing, you will be in the new format. Your neatly centered title 
won't be changed. It's governed by another ruler. 

Rulers can also be copied and used again in the same document. You may need 
to switch from one ruler to the next, back and forth, as in script writing. The dialogue 
will have one set of margins, usually indented toward the middle of the page, and the 
scene directions and actions will have another set, with wider margins. 

Select the ruler you ~ant to __ copy by clicking anywhere on the part with the 
numbers, and choose the Edit//Copy command. The ruler will be temporarily 
stored in the Clipboard. Position the insertion point where--theCopied ruler should 
appear and choose the Edit//Paste command. The copied ruler will remain in the 
CliQboard to be used again until you copy something else. 

I 
Ma€Tip 8-6 

To delete a ruler, select it and then press the Backspace 
key. You cannot delete the first ruler in the docum~nt. 

Rulers are a very simple and convenient way to set up your page format. But 
they can get in the way. Although they will not print out when you have finished 
with the document, the rulers affect the look of the screen and make it hard to 
visualize the final product. 
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~0 A Journey ... 

Chapter 1 

My Uncle Makes a Great Discovery 

Looking back to all that has occured to me since that eventful day. I am 
1

, 1/: 

scarcely able to believe in the reality of my adventures. Tlley were truly if:':': 
so wonderful that even now I am bE-\1/ildered when I think of Uler:·. · ' 

My uncle was a German, having married my m·')tr:.:r ·s sist~r. an ;;;,,, 
Englishwoman. Being very muc11 attached to hiS fatherless nephew, 11e .,.,,, 
inv!ted me to study under him :n h1s home m the fatherland Tlits home 

::>· 
was in a large town, and m}' uncle a Professor of philosophy, chemistry, 
geology, mineralogy, and many ot.ller ologies. ,. 

One day. after passing some hours in the laboratory -- my uncle being !';'' 
absent at tr.~ time -- I suddenly fel t the necessity of ren0vating the tissues ~ 
-- i.<"., I was hungry, and was about to rouse up our old Fren·.ll .:ooi:. when jQ] 

Fig. 8-14. j ustified text. 
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m A Journey ... 

Chapter 1 

My Uncle Makes a Great Discovery 

Fig. 8-15. The first ruler set for centered text. 
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Cilapter 1 F:-
h., 

My Uncle Makes a Great Discovery j: 

Looking back to all that has occured to me smce that .-ventiul day, l <~m 
scarcely able to believe in the reality of my adv.;nt1.tr<>< TMy w<:>r<? rp .' !y 
so wonderful that even now I am bewtldered when I t.hml: of u·.~m 

My uncle was a German, havtng married my rnrAli.;.r"s stst<:>r Mt 

Englishwoman . Bemg very much attacM'I to hts fatherlE>s~ n.:-pt.-ew. r,.,. 
invited me to study und<>r htm tn his home m tlle fatherland Thts j )" 

I 

Fig. 8-16. The second ruler, now added, set for left-aligned text. 

Luckily, it's easy to hide the rulers. When you want to make them disappear, 
choose the Format// Hide Rulers command (see Figure 8-1 7) . When you need to 
see them again (to make changes to them, for example), pull the Format menu 
down one more time and choose the Show Rulers command. 

HEADERS AND FOOTERS 

Headers and footers are those lines that a pear at the to and bottom of each 
page. T ey can be page numbers, the title of the document, or somethin much 
more complex, such as page number, document title, name of the author, and date 
the document was created. 

All of this may appear on the top (header) or bottom (footer) of each page. Of 
course, you may not want to have anything cluttering up the pages of a personal 
letter, but in many situations headers and footers come in handy. 

In the following pages, you'll learn all about headers and footers. For clarity 
and simplicity, we' ll talk about headers only. Footers are created and used exactly 
the same way. 

Choose the Format//Open Header command. A window labeled " Header" 
pops up in front of the MacWrite writing pad . The header winaow has three parts, 
as shown in Figure 8-18. At the top are three icons. Their purpose will be discussed 
shortly. 
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,. * File Edit Search Formql Font Style 

~0 A Journey ... 

Chapter I 

My Uncle Makes a Great Discovery 

Looking back to all that has occured to me since that eventful day, I am 
scarcely able to believe in the reality of my adventures. They were truly 
so wonderful that even now I am bewildered When I think of them. 

My uncle 'NCJS a German, having married my mother's sister, an 
Englishwoman. Being very much attached to his fatherless nephew, he 
invited me to study under him in his home in the fatherland. This 

Fig. 8-17. 

' -~~ 
HeQ(Ier 

1:1_ I'll !!1--
~!--'-L , . t?.__._._t_, , A ,. 1 _.... d.L. 1 ,__.. ,s,_,_·!·, .16. ,_ 1. '--·l 
1313 ~§E) ~~~(§] 
I 

tt!i 
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Fig. 8-18. The header window, complete with its own ruler. The three icons, 
from left to right, are fo r automatically add ing the page number, date and time. 

The header has its own ruler, so you can format the text independently from 
the rest of the document. The space under the ruler is the header text area. If you 
type something here- up to seven lines' worth- it will appear at the top of each 
page. 

Now for the strange icons. From left to right: 

• The icon with the # symbol is for page numbering. Drag the page numbering 
icon down into the text area (below the ruler) and place it along the top of 
the page where you want the page number to appear. The correct page 
number will be placed in the header of each page. 
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• The icon with the paper symbol is for dating. The current date is 
automatically pulled from the Mac's built-in dock/calendar. There is no 
need for you to manually type it in (unless you want to). just as with the page 
numbering icon, drag the date icon into the text area and place it along the 
top of the page where you want the curreJl.Ldare.Jo appear. 

• The icon w.ith the._Q.ock face is for adding the time to the header. The time is 
automatically ptl'lled from the Mac's built-in clock/calendar. Drag the clock 
icon into the text area and place it where you want it. Figures 8-19 and 8-20 
show how to set. 

The header is also used to alter the top margin of every page. MacWrite 

.. Header 

1!1 
1 .1!-&-....L...L ... J!...L. ........ .~-....ct..J.. •. .L....J ...... .t~-.. -·z· .......... J!...J ... --.~ .... ..J ....... J. 
!. 
~~ ~!§]~ g~~[g) 
A Journey to the Center of the Earth Page 8 lib 

t!i 

Fig. 8-19. Write text into the header as usual. 
Pull down any icons you ~arii"io"u~ into the textarea-.-fhfSactTvates them . 

" j File Edit Search Format Font Style 

gQ R Journey ... 

A Journey to the Center of the Earth Page 1 

Chapter 1 

My Un<.le Makes a Great Disc·wen' 

Looking back to all that has occured to me sm,~e that evenUul day. I am 
scarcely able to believe in the reality of my adventures They were truly 
so wonderful that even now I am bewildered when I think of tnem. 

My uncle was a German, having marned my mother's sister, an 
Englishwoman. Being very much attached to his fatherless nep11ew. he 
invited me to study under him in his home in the ft'therland This 

Fig. 8-20. The sample page, header added. 

., 
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automatically starts each page on the second line from the top of the page. You may 
need to start each page three lines down to create a larger top margin. This is easily 
done by pressing the Return key three times while viewing the Header window. 
Now, three blank lines will be figured into the top of each page (see Figure 8-21). 

Any text or page numbers you want to include in the header can go below the 
blank lines. Or the page number icon, for example, can be left above the blank 
lines, to provi de a wider distance between the number and the text. 

When you've finished with the header, click anywhere within the main Mac
Write w riting pad. The header window will shuffle its way behind the writing pad 
window. A header wi ll now show up on the top of every page of your document. To 
bring the header back into view, choose the Format//Open Header command again. 

Header 

1!.1 
~~~t.?._._.-'...._._...e._.._._L.,_,_._~.i......L._._Leo.J. !~_J!..._ . '-'-' ~l 

~~ ~[§IE] ~~[jj][I§J 

I A journey t.o the Center or the Earth Page (Y ITh 

n 

fig. 8-21. Increase the top margin by adding blank lines to the header. 
Increase the bottom margin by adding blank lines to the footer. 

MacTip 8-7 

If you want to c~eiJh.e_ILeadeL.lru_some_r.e~
choose the Format//Remove Headers command. The con
tents of the header will be ignored and nothing will appear at 
the top of the ages. Likewise, if you want to use the header;
choose the Format//Display Headers comman . 

Headers and footers may be added at any time and will affect the entire text. In 
other words, if you are on page 6 of your document, and you realize you have 
forgotten to put in page numbers, it is an easy matter to c;hoose Format//O~n 

Header and pull the page number icon into the text area of the header. Click 
anywhere on the MacWrite wmdow and the correct page number wdl appear at 
the top of every page. 

You may not want a number to appear on the first page (or title page), so Mac
Write provides a Title Page command in the Format menu. Wilen the Format77Title 
P,age command is chosen, the header wil l appear on page 2 and thereafter. 

There may be times when you want to start page numbering at a point other 
than 1 -for example, to combine parts of a single large document. If you have the 
128K Macintosh, each document can only handle 8V2 pages of single-spaced text. 
The 512K version can handle documents of up to 80 pages. By the time you read 
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this, there may be a new disk-based verson of MacWrite that will also allow for 
longer documents. 

In order to logically link these sections together and maintain some continuity 
after they are printed out, change the starting page number of the second part to 
follow the final page of the first part. 

FONT AND STYLE 

Sometimes, you may need to emphasize a word or two. With a regular 
typewriter, your only option is to underline this text. Of course, you can underline 
with MacWrite, too, but there are so many more options. 

First, you must highlight the word or words_!..q_be ern_p_.b_~sized. Then pull down 
the Style menu. All of your <;>Rti.oD·s are there: ~gld, Italic, Un~~_r)ine, Subscript, 
Superscript, OutlineJ and_Shadow.Choos~1rl~,~uch as underlining byj_@_gg!Q_g_ 
down to lt and r~J~~-sJngJ.h~_llJ.Q!J_~_l:>_YU..OJL(figure 8-22). 

The hjghlightedword will now be YJld~rJi.n~d (see Figure 8-23). To remove the 
IJighlighting, click anx~~er~_ejse pn the screen.. - -

You can also a_dd em_ghasis to text as you ty~ it. When you get to a spot 
you want italicized, for instance, stop and choose the Style//ltalic command. 
Now, what you type is shown italicized. The style that has the check by it in 
the menu is the one currently in use. Keep in mind that you can choose any 
combination of special styles. Why not try bold-underline or underline-italic
subscript? 

When you want to return to normal text, cb.Q~e the_?jyle//Piain command .. 
You can also choose Style//Pia~r!JC!..~'~ear the slate" of all special style selections 
before choosing a new cornbi.o_at.iQO. •. 

You may have noticed that there are various point sizes to choose from in the 
Style menu. They indicate the size of the text ...You might find it handy to have your 
title in a larger point size than your text to make it stand out. The point size that has 
a check by it is the one currentlY. in use. 

The other set of options, Fonts, provides another w~give your docume!J.lA. 
personal touch. MacWrite offers s~veral type styles, each named after a city. When 
you begin a new MacWrite document, you will see that MacWrite automatically 
chooses New York as the standard font (see Figure 8-24). 

Luckily, it's very easy to change to any of the othe.cfo.nts._Pull down the Font 
'!l~nu_gnd s~Le.h.tth~ font that appeals to you. Pull down the Style Menu and choose 
another style. Every style and point size is available in every font. in any combina
tion. You may want to use New York or Chicago for your business correspondence 
and then switch to Venice for personal letters. 

Unlike changes to the format, changes in the Style and Font Menus affect only 
highlighted text or any text typed after you make the change. In order to go back 
and change the typestyle of an entire document after it has b.e-.en..typ_e.d, you must 
highlight all the text. and then change the foot .... If the d.ocumentis set.eralpages
long, you may have to bighlight and change it in sections 
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so wonderful that even now l am 
My uncle was a German, hav1ng ID !PmOwC 

Englishwoman Being very mu..:h atta< h~ I 0 P.Oin t 
inv1ted me tv study under h1m 1n h1s hotj'1U ~ !PmOmQ 
'~s in a large t:IJwn, and my uncle" 0 ~ ri'mnm!! 

XP 
3€8 
:!€ 1 

:1€0 
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geology, mmeralogy, and many oth-?r ' um [p(i)Q!i)(l 

On~ day, a!ter p.:~ssing som~ hours 1 ~~ [)l(i)Qffi(l ·: :! ·: l-:> betng 
absent at the ttme -- I suddenly f~!~ ~ 11~ :l~<ess:ty of re :l(''!<'Un~ •h" u~.s~\e-s 

-- i., , 1 was hungry, and w:~s .':\wut ':0 l\>USE- '-'? o~t.r ·:· 1·~ r: -=- =~: ~ -, "!: •vh~n 

m;; unci~ . Professor Von Hardwigg. sudd€':1!/ •:>pen~d tilE- ~u·'-t- t <!o•Jl' . and 
..::arne rushing up tne stairs. 

fig. 8-22. Highlight text to be stylized, then choose one of the Style commands. 

r 
II File Edit Search Format Font Style 

R Journey ... 

Chapter l 

My Uncle Makes a Great Discovery! I 

Looking back to all that has occured to me smce that eventful day, I am 
scarcelY. able to believe in the realitY. of mY. adventures. They were truly 
so wonderful that even now I am bewildered When I think of thE>m. 

My uncle was a German, having married my mother's sister, an 
Englishwoman. Being very much attached to his iatlJerless nephew, he 
invited me to study under him in his home in the fatherland. This home 
was in a large town, and my uncle a Professor of philosoph!', chemistry, 
geology, mineralogy, and many other ologies 

One day, after passing some hours in the laboratory -- my uncle being 
absent at the time -- I suddenly felt the necessity of renovating the tissues 
-- i .<'!., I was hungry, and was about to rouse up our old French cook, when 
my uncle, Professor Von HardWigg, suddenly opened tlle street door, and 
came rushing up the stairs. 

Fig. 8-23. Underlined text. Styles can be combined. 

., 
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San Francisco 

Fig. 8-24. The current font is shown checkmarked. When MacWrite starts, it automatically 
selects New York. You may change the font at any time, or change the font of previously 

writterLle?Sl._ 

SEARCH 

MacTip 8-8 

When you add_ te~x.t, itsJQfl.!, __ s.~y!e, and size is the same as 
t,Qe te~(!b~!_sur~o~~ds __ ~t, unless you specifically change it. 
To do th~- set Jh~ inser1!9n_point fi~J~--~~~L1h_el1_ change the 
font, style, or siz~. 

Suppose you have finished a lengthy report on the research done by Johnson 
and Smith, your esteemed colleagues. You suddenly discover that Johnson is not 
Johnson, but Jones (no wonder he gives you such odd looks whenever you talk to 
him). Realizing that you have mentioned the Johnson name at least 50 times, you 
begin to despair. But since you had the foresight to write your report with Mac
Write, the problem is easy to fix. ~a_cWrit~ has a simple helper called the Search 
menu, displayed in Figure 8-25, to get you out of such a jam. With it, you can h_sy_e 
MacWrite look for words and phrases. YQu can even have it replace the existing 
text with something else. 

You may not be a person who misspells the names of friends and colleagues, 
but there will certainly be other times when you'll find a use for the Search menu. 
Here's how to use it. 

Start by moving the insertion point to the beginning of the docum~o.tl!
Tecb.oj£~HY.J. you can leave the insertion point ai'}}.'Where,_ but MacWrite..wilLseau;h 
o~ly from the positi()n_ oL~~ _ irt_~~!!L~EL po_int toward the end of thtioc.umenL 



204 MacGuide 

File Edit Format 
Find ... 
Change ... 

Font Style 

Fig. 8-25. The Find and Change commands, both found unjeU,be_Searcj:l m~. 

If all you want to do is look for text, use the Search//Find com man . If you want 
to automatica y rep ace found text with 1_omething else, use the Search//Chgnge 
command. With the Change command, fortunately, you still have the final say on 
what is and what isn't changed. 

To Find Text 

Choose the Search//Find command. A window will appear, as shown in Figure 
8-26. Type in_the_text to be found, but don' t press the Retur.n key when you've 
finished. 

find 

Find what IL.Pr_o_fe_ss_o~'------------'l 
(find NeHI ] ® Whole Word 0 Partial Word 

Fig. 8-26. The Find window. 

Instead, cl ick the Find Next button. The next occurrence of the text you' re search
ing for wi ll appear highlighted. Keep clicking the Find Next button to locate all the 
other occurences. When you reach the end of the document, and Mac Write can't find 
any more text that matches, the program will provide a message to tell you so. 

If you want MacWrite to make an exact match, make sure the Whole Word 
option is 'ielected. If you want partial matches (for instance, all the words that have 
" here" in them, such as " here," " there," " heretofore," and so forth), click the 
Pactial Word option button. 

To Change Text 

Choose tbe Search//Change command. A window will ae!Jear, as shown in 
Figure 8-27. Type irt.tb_e ex to be found in the Find What box. With that done,_p~ 
the Tab key or use the mouse to drop the insertion_p.oioLinto the Cbange Ta.._bo_x. 

To start the process. click the Find Next button. The fiiSLoccuuence of the text 
will be highlighted. If you doo 'l want to change that particular occurrence, simply 
click the Find Next button again . If you wanuo chaoge_thiligb.lighted text, click 
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Change 

find what ~~P..;ro_,fe;..,u_o=r --=========ll 
Change to . Ootlo~ 

[find NeHtl [ Clmnge. lhen f iM J [r 1\nnge I [ Change Ali i 

® Whole Word 0 Partial Word 

Fig. 8-27. The Change window. 

either Change, Then Find o r Change (Change, Then Find re p_laces the text and then 
gQS:LoD-to-the next qcctULeru:.e.; Cbange replaces the text and leaves yon at that 
pQllli) . 

If you' re sure you want to change all occurrences of the texl,_cUck tbe Change 
All button at the start You' ll be warned that Changing All can' t be undone. If this is 
indeed what you want, click the Go Ahead button (or just press Return). The rest is 
done by MacWrite. 

As w ith finding text, you can instruct MacWrite to look fo r the exact whole
word match or partial-word matches. Click either the Whole Word or the Partial 
Word option to make your choice (normally, you'll be looking for whole-word 
matches, so MacWrite provides thi s option automatically). 

SAVING 

MacTip 8-9 

The Search//Find and Search//Change commands aren't 
case sensitive. That is, though you might want to find a word 
such as " Fantastic," MacWrite w ill find " fantasti c," " fan
TAstiC," and all other variations . 

Th is can be a problem when MacWrite changes words, 
since the program doesn't know when to consider case and 
compensate for it. For example, suppose you substitute the 
word " like" for " love" throughout a document. But several 
times, " love" starts a sentence. You' ll end up with " like, " 
w ithout a capital letter, even w hen the word begins a 
sentence. 

To save your magnum opus for later, you' ll have to record it onto a disk. To 
save a finished or partially fi nished document, use the File//Save command. If this is 
the first t ime you've saved the document, you' ll be asked to give it a name (names 
of documents can be up to 63 characters long and can include any character ex
cept the colon) . When you've finished entering the name, click the Save button 
(see Figure 8-28). Once you've given the document a name, the Macintosh w ill no 
longer ask its name w hen you choose the File//Save command. 

You might note that the ·File menu offers both Save and Save As commands. The 
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Saue current document as Ore8mer 
I A Journey .. ~ ( Eject ) 

( saue ) ( Cancel ) ( Driue ) 
®Entire Document Q TeHt Only 

Fig. 8-28. The Save box provides the means to name documents when you've finished 
writing. 

former is for saving a new document. Save As, on the other hand, is used when 
you've already saved a document and want to save another version of it under a 
new name. Keep in mind that using the File//Save As command doesn't rename the 
original MacWrite document, but creates another one. 

MacTip 8-10 

Make it a habit to File//Save every 15 minutes or so. That 
way, should something unthinkable happen (a power 
outage, for example), you'll lose only the last 15 minutes of 
work. 

PRINTING 

There are two print commands in MacWrite; both are accessed via the File 
menu. 

File//Print Setup tells MacWrite the size of paper you're using. When you select 
File//Print Setup, you're given a choice of paper sizes, expressed in letter standards 
(see Figure 8-29). 

Here's how the standards and other options measure up: 

Paper: ® US Letter 0 R~ Letter 

0 US Legal 0 International fanfold 

Orientation: ®Tall 0 Tall Rdjusted 0 Wide 

Fig. 8-29. To change the printing dimensions, call up the File//Print 
Setup command and click the desired Paper and Orientation options. 



US Letter 

US Legal 

A4 Letter 

I ntl. Fanfold 

Tall 

Tall Adjust 

Wide 

8 Y2-by-11-i nches 

8%-by-14-inches 

8~-by-11 2/3-inches 

8 ~-by-12 inches 

Text printed upright 
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Text printed upright with correctly proportioned 
pictures. 

Text printed sideways. 

There's no need to use File// Print Setup if you're going to be printing standard 
text on 8Y2-by-11-inch paper-the US Letter option is chosen automatically (it is 
the ~~default" option). 

To make a printed copy, choose the File// Print command. Before printing 
commences, however, a dialog box like that in Figure 8-30 appears. It asks 
the print quality you want (see Figures 8-31 to 8-33 for examples), the number of 
copies you want printed, and the start and stop page numbers. After you've set 
things up the way you want them, click the OK button and printing will begin 
(make sure your printer is connected and turned on before clicking OK, or nothing 
will be printed). 

Quality: ®High 0 Standard 0 Dran ~ 
P11ge Range: ® Rll 0 From: D To: D 
Copies: EJ 
Paper Feed: ®Continuous 0 Cut Sheet ~ 

Fig. 8-30. Before printing with MacWrite, you're always given the chance to specify the 
number of pages to be printed, the print quality, the number of copies required, and whether 

you're using single-sheet or continuous-feed paper in the printer. 

Chapter I 

My Unde Makes a Great Discovery 

Looking back to all that has occured to me since that eventful day, I am 
scarcely able to belieye jo the reality or my adventures They were truly 
so wonderful that even now I am bewildered when I think of them. 

My uncle was a German, havins married my mother's sister, an 
Bnslishwoman. Being very much attached to his fatherless nephew, he 
invited me to study under him in his home in the fatherland. This home 

Fig. 8-31. Part of a document printed in High mode. 
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Chapter l 

My UnclE: Makes a Great Discovery 

Looking back to all that has occured to me since that e'{entful day, I am 
scarcely able to believe in t11e reality of mx adventures They were truly 
so wonderful that even now I am bev..rildered 'Nhen I think oi tll~m. 

My uncle was a German, havmg married my mother's stskr, an 
Englishwoman. Being very much attach~;td to his fatherless nephew, he 
invited me to study under him in his home in the fath~;trland. This home 

fig. 8-32. Part of a document printed in Standard mode. 

Chapter 

My Uncle Makes a Great Discovery 

Looking back to all that has occured to me since that !V!nHul day, I am 

scarcely able .!.Q. believe l.!!. the reality .Qf. m! adventures • They were truhr 

so wonderful that even now I am bewildered when l t~ink c' them. 

My uncle was a German, having married my mother's sister, an 

Eng! ishwanan. Be1ng very much attached to his fatherless nephew, he 

in11ited me to study under him 1n his hmt in the fatherland. This hane 

Fig. 8-33. Part of a document printed in Draft mode (no fonts or pictures possible). 

BACK AT THE DESKTOP 

When you've finished with MacWrite, leave the program by choosing the Quit 
command from the File menu. If you haven't saved the latest version of your docu
ment, MacWrite will prompt you to do so (juck click the Yes button to save). 
Within a few seconds, you'll be back at the desktop and ready for the next job. 



CHAPTER 9 

An Introduction to Multiplan 

Just as pen and paper have been the tools of the writer's trade, accountants and 
bookkeepers through the ages have relied on ledger pads to record numbers and 
other financial data. With the age of computers upon us, the ledger pad has bowed 
to the electronic spreadsheet. Now, crunching numbers will never be the same. 

One of the premier electronic spreadsheet programs for the Macintosh is 
Multiplan, from Seattle-based Microsoft. The overall design of Mac Multiplan is 
fancy and sophisticated, but that sophistication doesn't become complex when 
you sit down to use the program. 

Thanks to the Macintosh, the full computational power of Multiplan is right at 
your fingertips in easy-to-use menus. There are no strange and cryptic command 
codes to memorize. Despite it's "user friendliness," however, Multiplan lets you 
sail through your work quickly and gracefully, with a minimum of pain and effort. 

Multiplan makes perfect sense for accountants and bookkeepers. But it 
can be equally handy for anyone who works with numbers. It's a powerful data 
processing tool for scientists, engineers, forecasters-anyone with numbers to 
11Crunch." 

This chapter introduces you to Macintosh Multiplan. You'll learn the basics of 
what Multiplan does; how to enter numbers, formulas, and text; how to change or 
rearrange data once you've entered it; how to print the results; and much more. 

209 
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STARTING MULTIPLAN 

Getting started with M ultiplan is easy. Turn the Mac on, slip the Multiplan disk 
in the drive, and wait until the Mult iplan disk icon is displayed. Double-click on the 
disk icon to open it. 

After the disk is opened, simply double-click on the Multiplan icon to start 
Multiplan . In less than a half minute, a blank Multiplan worksheet will appear (see 
Figure 9-1 ). 

THE MU LTIPLAN WORKSHEET 

In case spreadsheet software is new to you, we'll get off to a sound footing by 
covering what a worksheet is and what it does. Multiplan's worksheet is a two
dimensional grid, with a number of horizontal and vertical lines. The intersection of 
these lines creates cells. Cells can contain: 

• Numbers 

• Formulas to process those numbers 

• Text to explain what all the numbers mean 

With electron ic spreadsheet programs, the individual cells must be identified in 
some way. Multiplan identifies cells by their row and column coordinates. It's a 
simple procedure. The cell created by the intersection of row 1 and column 1 is 
named R1C1. The cell created by the intersection of row 5 and column 10 is 
RSC10. In spreadsheet parlance, R1C1 and RSC10 are cell addresses. A cell is the 

.. • File Edit Select Format Options Calculate 
., 

R1C1 II I 
Untitled 

I 2 I 3 l 1 l 5 J 6 

1 -=--.~ ....... ...... ..... ;.. ................ : .................. : ............ .. .... : .................. ~= 
18; • . . . . . . . . . . . . .. . . . . . 

Fig. 9-1. A blank Multiplan worksheet. 
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smallest component of the worksheet. Multiplan can create a worksheet with up to 
63 columns and 255 rows, for a total of 16,065 cells. That's pl enty for j ust about any 
application. 

MacTip 9-1 

Multiplan usually displays only six columns and 15 rows 
at a t ime. To see a different part of the worksheet, use the 
scro ll bars in the usual manner. For example, to scroll the 
worksheet over to the right, press the right scroll arrow. Or 
drag the elevator in the horizontal scroll bar to the right. 

Word processing programs such as Apple' s MacWrite and Microsoft Word use 
a blinking insertion point to indicate where text w ill be entered when something is 
typed from the keyboard . With electron ic spreadsheet programs, you must enter 
numbers and text into cells, so there must be a way of indicating which cell is to 
receive the entry. 

At any time, one cel l, and one cell on ly, is current in the Multiplan worksheet. 
The current cell is the one Multiplan thinks you' re interested in . If you enter a 
number, for instance, it will be placed in the current cell. 

The current cell is always highlighted and shown with a white border. For add
ed feedback, the address of the current cell is shown in the left box of the formula 
bar (the white area immediately above the worksheet window). As shown in Figure 
9-2, the cell reference in the formu la bar is R2C3, because cell R2C3 is the current 
cel l. 

,.. j File Edit Select Format Options Calculate 

R2C3 

. . . . . . 
· ·· · ·· ·· ··········:· • ·· ·· · · · · ·· · ·· ···:····· ·· ··· ···· · ··· :········ · ········· : ······· . . . . . 

Fig. 9-2. The left part of the formula bar shows which cel l is current. 

To select a new current cell, move the pointer over to that cel l and click the 
mouse button. The new cu rrent cell wi ll become highlighted, and the cell address 
in the formula bar wi ll change. O nce the new cell has been made current, type in 
your entry. That's all there is to it. There are no cursor keys to press or commands 
to give. 

You may have noticed that when the pointer is positioned over the worksheet 
area, it turn s into a fat plus sign. The pointer will turn into many shapes, depending 
on where it is on the screen -a hand, double arrows, and more. 
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A SIMPLE WORKSHEET 

A simplified Multiplan worksheet with all three types of cell entries-text, 
numbers, and formulas-is shown in Figure 9-3. Here, text was entered into the 
top left cell. This text, " Simple Addition," explains what the worksheet is doing (in 
this case, adding 2 and 2). Multiplan doesn't use this entry for computation. 
Because the entry is made up of letters, Multiplan recognizes it as explanatory text 
and ignores it. 

r • File Edit Select Formot 

R4C1 

I 2 I 
~ ~i~J?.l.e . . A.d.dit.i.o~ . .. .... .. .... ~ ....... . 

2 2 : : f-J ............... 2 .. ~ .................. ~ ...... .. 
~ ................ .... ........ . 
~ . 

~::::::::::::::::::i:·:: . ::::.::·.·:··j:::·:::: 
Fig. 9-3. A very basic Multiplan worksheet. 

The next two cells contain numbers-two 2's. These are the numbers, or 
values, that Multiplan will add. The last cell contains a formula . We're adding 2 and 
2 here, so the formula says "- R2C1+R3C1 ," (indicating that we' re adding the 
contents of two cells, both of which happen to be filled with 2's. When Multiplan 
goes to work, it will add the two numbers and display the result in cell R4C1. 

CREATING THE WORKSHEET 

Adding two numbers together is a ridiculously simple task for Multiplan. Some 
things are better left to a simple $10 calculator. Where Multiplan really shines is in 
doing "what if" calculations. If you design a worksheet and then plug in a different 
set of numbers, Multiplan will automatically recalculate the worksheet w ith your 
new numbers. 

Let's look at the sophistication of Multiplan by creating a more elaborate 
worksheet. To start, make sure the Multiplan worksheet is blank. If it is not, choose 
the File// New command. This will blank out the worksheet for you. (You' ll prob
ably get a dialog box that asks if you want to save the current worksheet before star
ting a new one. This time, answer "No".) 

Now, to work. Position the pointer over cell R1C1 and click the mouse button. 
Depress the mouse button once more and drag down to row 5. The fi rst five cells in 
column 1 should now be highlighted, as shown in Figure 9-4. 

Notice that although the first five cells are shown highlighted, cell Rl Cl still has 
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Fig. 9-4. Cells RlCl through RSCl , highlighted and ready for work. 

a white border around it. Cell RlCl is still the current cell. If you type a number, for 
instance, it will be placed in cell RlCl. 

Cells R2C1 through R5C1 , on the other hand, comprise the selection. The 
distinction between current cell and selection is one you should know. The current 
cell is the one you want to fill . It will receive the number, formula, or text when you 
type it in from the keyboard. It is Multiplan's insertion point. 

The selection is the group of cells you want to further manipulate. You might 
want to delete several cells at once, for instance. Do it by selecting them, then 
choosing the Edit//Ciear command. 

If you've used MacWrite, you know that you can select one or more characters 
by dragging over them with the mouse. For example, you might select a group of 
words to delete or to copy. Or you might want to change their font or font size. Cell 
selection in Multiplan is really no different. It allows you to work with a number of 
cells at once. 

Let's start entering text and numbers. Type in the text shown in Figure 9-5. 
Finish each entry by pressing the Enter key. When you press Enter, Multiplan 
makes the cell below current. 

With all the text entered, select cells RlC2 through R5C2. Enter the bean prices 
shown in column 2 of Figure 9-6. Repeat this process for the numbers in columns 3, 4, 
and 5 (keep pressing Enter when you've finished with the Entry; don't press the Return 
key). When you've entirely finished, your worksheet should look like Figure 9-6. 

7 

Fig. 9-5. Type this text as shown. 



214 MacGuide 

Untitled 
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Fig. 9-6. The sample worksheet with all numbers entered. 

MacTip 9-2 

If you make a mistake, use the Backspace key to back up 
over the mistyped character. Retype correctly. 

If you rea lly mess things up, press the small stop sign that 
appears in the formula bar. This clears w hatever you've typed. 

If you spot a mistake after you've pressed Enter, there are 
a couple of ways you can handle the situation. 

One is to choose the Edit//Undo command. In most 
cases, Ed it//Undo will reverse the last command or action. If 
you've already pressed the Enter key, Edit//Undo will delete 
the entry. You can then retype the entry co rrectly. 

Another way is to ignore the mistake for the t ime being 
and type the text into the rest of the cell s. When you 've 
finished, press th e Enter key repeatedly until the cell with the 
incorrect entry becomes current again . Retype the entire 
entry. (Of course, there are ways to selectively edit the con
tents of a cell, but we' re getting ahead of ourselves). 

MacTip 9-3 

When entering a row or co lumn of text or numbers, it's 
easier to select the group of cells that w ill receive the entries, 
as you've done here, and then press the Enter key to go from 
one cell to the next. 

You can also use the Return, Tab, and Shift keys to move 
the current cell indicator around the worksheet. W hen you 
use these keys, don' t select the group of cells as you do 
when using the Enter key. 

• To move down one cell, press the Return key. 

• To move up one cell, press the Shift and Return keys. 

• To move right one cell, press the Tab key. 

• To move left one cell. press the Sh ift and Tab keys. 
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Text and numbers are easy to enter into Multiplan. Just type the entry. For
mulas are a little more complex and require more attention to detail. Multiplan 
knows you're entering a form u Ia if the entry starts with an equals (""' ) sign. 

For example, the entry "= R2C1 + R3C1" is a formula. As you've seen, this for
mula instructs Multiplan to add the contents of cell R2C1 and R3C1. The cell that 
contains the formula will be used to show the result of the calculation. 

MacTip 9-4 

Multiplan recognizes as a number an entry that includes 
any combination of these characters only: 

1 2 3 4 5 6 7 8 9 0 - + . E or e 
If the entry includes any other character, Multiplan treats 

it as text. 
There is one exception to this last rule. If the entry starts 

with an ... sign, Multiplan thinks it's a formula, and will try to 
work with it as a formula no matter what other characters the 
entry includes. 

If you want to enter text that starts with an equals sign or 
want to enter a number and have it treated as text, surround 
the entry with double quotes("). For example, to enter 1985 
as a date rather than a number, type it as "1985." When the 
entry appears in the cell, it will lack the quotes (if, for some 
reason, you want quotes to appear, type them 
double- ""1985"" .) 

Text and numbers are entered into cells by typing them character by character. 
However, formulas needn't always be typed this way. You don't need to type 
"= R2C1 + R3C1 ,"for example. Rather, it's possible to tell Multiplan which cells are 
to be included in the formula by pointing at them with the mouse. 

Let's demonstrate this by adding the first row of numbers in the example. Make 
cell R7C2 active by clicking on it (we will use to contain the formula -and thus, the 
result). Start the formula by typing an "'",then click cells R1C2 through R5C2 each 
in turn. With each click, Multiplan will build the formula for you (it will be shown 
growing in size in the formula bar, as shown in Figure 9-7). When you've clicked all 
five cells, press Enter. The result, 2257, will be shown in cell R7C2. 

ABSOLUTE AND RELATIVE CELL ADDRESSES 

While clicking, you probably glanced at the formula Multiplan was creating. It 
looked mighty strange, with all sorts of brackets and + and - signs, right? The for
mula Multiplan dutifully built for you uses relative cell addresses. 

That is, instead of identifying cell R1C2 as "R1C2," Multiplan referred to it as 
"R[-6]C." This identifies the cell as the one "six rows up in this same column." 
"R[-5]C" is the cell five rows up in this column, and so forth. Multiplan figured you 
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Fig. 9-7. A close-up of the formula bar. 

wanted to add the cells together, so it automatically placed a + sign between the 
cell addresses. 

MacTip 9-5 

Multiplan automatically places a + sign between clicked 
cells, but you can enter another arithmetic operator if your 
aim is not to add cells together. Multiplan also recognizes 
subtraction (-), multipl ication (*),and division (/) . 

Conversely, w ith an absolute cell reference, Multiplan looks for a particular cell 
on the worksheet, regardless of the spatial relation ship between the formu la and 
referenced cell. 

Why relative and absolute cell addresses? Here's a good example. Let' s say you 
type in a formula using absolute references that adds three cells together: R1 C1 , 
R2C1 , and R3C1. The formula wou ld read "~ R1C1 + R2C1 + R3C1." 

As you continue to create the worksheet, you decide to add an extra number. 
Wouldn't you know it! The number needs to go in row 2. You ' ll have to add a row 
to make room for the new entry (exactly how this is done is discussed a few pages 
later in this chapter). 

When the row is added, the original R2C1 and R3C1 cell s are displaced- they 
both drop down one cell. Since you used absolute cell references, your formula is 
tied to cells that no longer contain the information you need. You' ll have to retype 
the formula to compensate for the changes. With relative cell addresses, however, 
you can make physical changes to the worksheet without affecting the integrity of 
most formu las. 

SHORT-SHORTCUTS 
Entering formulas is the toughest part of Multiplan and the most t ime

consuming. Even so, if your worksheet uses the same basic formula in several 
places, there are several ways to speed up the job. 
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One way is to make a copy of the formula and place it in another cel l. Do this 
by using the Edit//Copy and Edit//Paste commands. Try it by clicking on cell R7C2. 
If you haven't changed the worksheet, our original formula that generated the 
resu lt wi ll be shown in the formula bar (it looks long and confusing. but you 
needn't worry about it-Multiplan knows what to do with it). 

Follow up by choosing Copy from the Edit menu. The formula (not the result) 
will be copied to the Clipboard. Click in cell R7C3 and choose Paste from the Edit 
menu . The formula wil l be copied from the Clipboard and inserted into cell R7C3. 
The displayed result is the sum of cells R 1 C3 through RSC3. 

MacTip 9-6 

You can also use the Editi/Fi ll Right and Editi/Fill Down 
commands to copy the contents of cells. In the worksheet 
example you' ll want to use Edit//Fill Right. Click on cell 
R7C3, then drag across to cell R7C5. Your worksheet should 
now look like Figure 9-8. 

Choose Fill Right from the Edit menu. The formula con
tents of cell R7C3 will automatically be copied to cells R7C4 
and R7C5. Each result in row 7 is the sum of the numbers 
above it. 

ABOUT MULTIPLAN'S FUNCTIONS 

Multiplan can add, subtract, multiply, and divide the contents of cells. More 
complicated formulas can be created using Multiplan's built-in fu nctions. You can 
think of functions as shortened versions of complex formulas. For example, there is 
a function built into Multiplan that let' s you find the average of a list of numbers. 
Without the function you'd have to write a formu la that adds the numbers 
together, then divides the sum by the number of cells added. 

Using Multiplan's average function , you'd simply type in "= AVG" and say 
wh ich cells you want included in the formula. Averaging num bers is but one of 
over 40 functions built in to Multiplan. There are others for finding the absolute 

1 ~~.\ ~~~ .. ~.~~~. ~ ........... ~.~.~ .. ~ ................ . ............. ~. ! .q .. ~ ........... 5.e.o .. ~ 
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3 ~r.e.~~ ... .. ... . : . ...... ... . 5.~. 1 ... : ... .... . ... 5.~.3 . . : .. ........ . 4.~.3 . . L .......... ?.6.4 .. : 

N~.YX ........... , ........... ?.~.4 . . : ..... .. . .. . 6.1.2 . . : .. .... .. ... 4.! .e .. : .. .. .. ... .. s.o.e .. : 
~ ~~.'? ....... ... . : ....... .... ?. ! .~ .. : ...... ..... ?.4.~ .. : .... ....... 1.9.0 .. : . ......... . 2.2.5 .. : . . . . . . . . . . . . . . •..•.....•.... .......... ..........•.. 
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Fig. 9-8. Select these cells, and then give the Edit//Fill Right command. 
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value of a number, determining net present value, calculating arc tangents, 
cosines, sines, and tangents, and more. 

Perhaps the most used function is SUM, which adds a list of numbers. Rather 
than building a formula by clicking on each cell to be added, use the SUM function 
instead. Here's how it's done. 

Click in cell R1C6. It will become current. Type: 

=SUM( 

but don 't press Enter yet. With the mouse, drag over all the number entries in row 1 
(from R1C2 to R1CS). Take a look at the formula bar, as shown in Figure 9-9. In
stead of listing each cell, it shows a range of cells-RC[-4]:RC[-1] . Type a right 
parenthesis: 

and press Enter. In cell R1 C6 will be the sum of the cells in row 1. 

Untitled 
I 2 I 3 I 1 s 

~~~.: .. ... .. ... . s.~.s .. : ........... ~.?.q .. ~ ........... ~. ! .q .. ~ ...... ... .. ~.~.o . .I 6 ~ 
... : .., .,., ; ")C' A : tnn : ..,.u: : 

Fig. 9-9. The SUM function adds several cells together. 

There's another, and somewhat easier, way to enter functions. Use the 
Edit//Paste Function command. Try thi s by clicking in cell R2C6. Now, choose the 
Paste Function command from the Edit menu. Within a second or two, you' ll be 
greeted by the Paste Function window. Press the down arrow to scroll the contents 
of the window. Stop when you come to "SUM()." Click SUMO to select it, and 
then click the OK button (Figure 9-1 0). 

In the formula bar is " =SUM(). " A blinking insertion point appears between 
the parentheses. The range of cells to be included in the formula will be placed 
here. Use the mouse once again to drag across the entries in row 2. Finish by press
ing the Enter key. 

To complete this part of the worksheet, add rows 3, 4, and 5 together, as well. 
You can go through the SUM function routine again , or you can use Edit//Copy and 
Edit//Paste or the Edit//Fill Down command. When you have fi nished, your 
worksheet should look like Figure 9-11. 

CELL EDITING 

Few worksheets are perfect when first created. In most cases, the contents of 
the cells must be adjusted to reflect new data . Or you may want to see how a 
change in business climate or sales figures would affect your bottom line. 
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ROUND() Paste Function 
ROW() 
SIGNO 
SINO ( OK 
SORT() 
STDEU() 

( Cancel ) 

Fig. 9-10. Choose the SUM() command. 
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Fig. 9-11. The SUMmed worksheet. 

The easiest way to edit the contents of a cell is to click on it and type a new en
t ry. For a number, th is is easier done than said. Just click in the cell you want to 
change, and type the new number. Let's do it w it h cell R3C2. Click it, then type 
441. Press Enter. The worksheet wi ll be automatically recalculated using the new 
number. 
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If you're working with a long bit of text or a complex formula, you may not 
want to re-enter entirely new material. The contents of the cell can be edited 
character by character. 

To edit a cell, click on it. As you know, this tells Multiplan which cell you want 
to work with. Then move the the pointer to within the formula bar. Clicking the for
mula bar makes it active. In addition, where you clicked indicates where the inser
tion point is placed (see Figure 9-12). If you don't get the insertion point exactly 
where you want it the first time, move the pointer and click again. 

k("' Insertion Point J ready for editing 

=SUM(RQ[-4]:RC[-1]) 

F.ig. 9-12. Use the formula bar to edit cell entries. 

Edit the text in the formula bar as you would any other text. To insert new 
characters, start typing. Use the Backspace key to erase characters to the left of the 
insertion point. 

When you have finished editing, press the Enter key. This places the newly 
edited text, number, or formula into the current cell. 

MacTip 9-7 

If you overedit an entry, you can easily go back to the 
original version. just click the small stop sign that appears in 
the formula bar. If you spot a mistake after you've pressed 
Enter, use the Edit/1 Undo command. 

INSERTING ROWS AND COLUMNS 

Along with editing the content of cells, you'll probably be fine-tuning the 
layout of the worksheet. For example, you may need to insert another row or col
umn, to make room for additional data. Our example worksheet lacks column 
heads, so a new row should be added to accommodate them. Fortunately, the pro
cess is a simple one. 

Start by placing the pointer along the far left edge of the worksheet window, 
over the numbered blocks. These blocks are more accurately called row heads 
(likewise, the blocks above the columns are column heads). Line up the pointer in 
the ''1" row head. Press the Shift key and keep it pressed. The pointer should turn 
into a strange down arrow. 

Click the mouse button and release the Shift key. In a few seconds, a new row 
will be added. All the other rows will be shifted down. Of course, adding columns 
is just as easy. To add a column, line the pointer up where you want the new 
column, press the Shift key, and click the mouse button. 
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To make it easier to enter the column headings, click in cell R1C2 and drag 
over to cell Rl C6. Type the text shown in Fig. 9-13, and press Enter after each entry. 
The current cell indicator will shift from cell to cell along the length of the selected 
area. Finally, for the sake of clarity, add a big fat " TOTALS" label to cell R8C1. 

Maclip 9-8 

Deleting rows and columns is done a little differently. To 
delete an entire row: click on the row head to be deleted, 
then choose the Edit// Cut command. The rows below will 
move up to fill the gap created by the removal. 

To delete an entire column: click on the column head to 
be deleted and then choose the Edit//Cut command. The 
columns to the right will move over to fill the gap. 

CELL FORMATTING 

There may come a time when you want to display more than raw numbers in the 
cells of a worksheet. You may want to show that the numbers are dollars or percen
tages, for instance. Unfortunately, Multiplan will not allow you to enter values with 
dollar or percent symbols (if you do, Multiplan treats the entries as text). 

What's more, Multiplan automatically aligns numbers with the right edges of 
the cells, and text with the left . You may, for one reason or another, want to alter 
this alignment convention. Alterir]g the way values and text are displayed in cells, 
and their alignment, is the job of the Format menu. 
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Fig. 9-13. The new worksheet, with text. 
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The Format menu lets you display numbers in seven distinct ways: general, 
dollar, percent, no decimal, decimal, scientific, and bar graph. You can mix 
number formats within one worksheet because you can select which cells are to be 
altered. When first started, Multiplan assumes you want to display numbers in the 
general format-that is, numbers are displayed pretty much as entered, without 
commas or other marks. 

To change the numbering format, select the cells to be changed, ~nd then 
choose the desi red format command. Let's change the numbers of the example 
worksheet to dollars. Place the pointer in cell R2C2 and drag diagonally down to 
the opposite corner, to cell R8C6. All of the cells with numbers should now be 
highlighted. 

Choose the Dollar command from the Format menu. In a few seconds, 
Multiplan will update the values and place dollar signs in front of each one. It w ill 
also add a decimal point and two trailing zeros. We don 't want this extra baggage, 
so let's delete the decimal point and zeros. This time, choose the Number of 
Decimals command from the Format menu. Type 0 when the dialog box appears 
and click the OK button. The worksheet will look like Figure 9-14. 

Here, in a nutshell, are the seven Multiplan formats available (see Figure 9-15). 
General displays all numbers as they were entered, with no dollar or percent 

sign. Multiplan may automatically change very large or very small numbers into 
scientific notation so it can display them within the cell (see Scientific). 

Dollar places a dollar sign($) in front of each number - for example, in Figure 
9-15, 1435.645 (the number entered) becomes $1435.65. The number is rounded 
to the nearest cent because of the Number of Decimals setting (explained later in 
this section). 

1666 1570 1-1 I 0 J:s:=;o ~~~~~ 

1237 f254 ! I ~(I 1245 f026 
! 44 I ! C·: !43 ! s~.4 !:02 I 
i:5·~4 if I - !4 I •) ! t.l 1;:; 1223: 
12 I 9 244 I I 1)1) f_:s !788 

t 2 I 57 12263 I I cc I ! --·--

Fig. 9-14. The same numbers, now as dollars. 

; 143564. SO'l. ' 

A 

Fig. 9-15. Multiplan 's numbe r formats. 
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Percent multiplies the value in the cell by 100 and places a percent(%) symbol 
after the value. For example, the number 10 in Percent format would be 1000%. 
Should you want to show the numeral1 0 as 108 rather than 1000%, enter the value 
as .10. The number of digits shown to the right of the decimal point is determined 
by the Number of Decimals setting (explained later in this section). 

No Decimal rounds off numbers to the nearest whole and deletes any digits to 
the right of the decimal point. Use the No Decimal command with caution- it can 
cause rounding errors in long or complex calculations. 

Decimal cancels the No Decimal command and puts the number into decimal 
notation. The number of digits to the right of the decimal point (from 1 to 15 digits) 
is determined by the Number of Decimals option (explained later in this section). 

Scientific transforms all values into scientific notation or exponential form. The 
number 5 becomes 5.00E +00, which means 115 times 10 to the 0 power," or 5 x 1. 
Scientific notation is handy when you're working with especially large numbers 
that don't fit neatly into Multiplan's standard 10-character-wide cells (Multiplan 
cells can be enlarged or reduced, as explained later). The number of decimal 
places displayed in Scientific format depends on the Number of Decimals Setting 
(explained later in this section). 

Bar Graph turns a number into a shaded bar. The length of the bar is determined 
by the value of the number. Positive and negative numbers are shown as different 
shading. 

There are two commands in the Format menu that allow you to modify the 
seven formats just described. The Number of Decimals command lets you tell 
Multiplan how many digits you want (from 0 to 15) to the right of the decimal point. 
Format//Number of Decimals affects the presentation of numbers in the Dollar, 
Percent, Decimal and Scientific Format commands. The Commas command does a 
simple job: it inserts commas in numbers exactly where they belong. The Commas 
command affects the General, Dollar, Percent, No Decimal, and Decimal formats. 

To change the alignment of text and numbers within the cell, choose the Align 
Left, Align Center, or Align Right commands. Normally, text is displayed aligned left 
and numbers are displayed aligned right. There may be plenty of times when you 
want to center text or values or both. Let's try this in the example by centering the 
column headings. 

Select all the cells in the top row. Drag over them in the usual manner, or try 
this shortcut: Place the pointer in the 111" row head and click the mouse button. 
The entire row-all 63 columns across-will be highlighted (this trick also works 
for the column heads). With either method, finish by choosing the Format//Aiign 
Center command. In a flash, the text is shown centered (Figure 9-26). 

Multiplan cells can hold up to 255 characters each. But they can only display 
10 characters at a time. You may have noticed, if you've done some extracurricular 
playing with Multiplan, that a cell sometimes fills with stars (*). This occurs when 
the cell includes a number that is too long to fit. Multiplan's columns can be reduced 
or enlarged to accommodate just about any size data. The column width can be 
changed in either of two ways: with the mouse or with the Format//Column Width 
command. 



224 MacGuide 

Fig. 9-16. A sample of center-al igned text. 

To change the width of a column with the mouse, follow these simple steps. 
Place the pointer over the right edge of the head of the column you want to 
enlarge, as it is in Figure 9-17. Make sure the pointer is resting over the dividing line 
between that column and the next one to the right. Then drag the mouse to the left 
or right, as desired. If you drag the column divider to the left, the column width wi ll 
be decreased. If you drag the column divider to the right, the column width will be 
increased. A column can be as wide as the screen, but no wider. 

Untitled 

I 2 I 5 I 6 

rL ~~.~!~r .. ~.~~!l.~ ......... ~~.~.~ ........... ~nq .. ~ .. J ...... ~~. 1 .q .. ~ ......... ~~.~.o .. : ........ s~~.~.~ .. iH!i' 
3 Garbanzo : $237 $254 : I $190 : $245 : $926 j!!!i' 

101 IOQJ 

Fig. 9-17. Use the mouse to increase or decrease the width of the columns. 

Here's the other method of changing column width: Set the column width by 
selecting the column or columns to change (click in the column head), and then 
choose the Format//Column Width command. A dialog box will appear asking the 
number of spaces to set. Type in the number and press OK. 

All ABOUT RANGES 
Most of the time you' ll be using Multiplan to work with a number of cells at 

once. As you've already learned in this chapter, you can total a row of numbers by 
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using the Edit//Paste Function command, scrolling to and clicking the SUM() 
option, and then using the mouse to indicate the cells to be added together. This 
group of cells is more commonly called a range. 

MacTip 9-9 

If you want to return all columns to the regular width of 
10 spaces, choose the Format//Column Width command, 
click the Set All Columns to Standard Width box, and then 
click OK. 

Normally, a range is indicated by dragging over the cells, or by typing the range 
address ("[R-5]C:[R-1]C", for example). But dealing with ranges this way can get 
tedious and confusing. With Multiplan, you can give a name to a range of cells. 
Then, whenever you want to deal with that range, it's as easy as entering its name. 

To see how this is done, click in cell R2C2 and drag across to cell R2C5. This is 
the range of cells that will be named. Follow by choosing the Select//Define Name 
command. In a few seconds, a dialog box, like that in Figure 9-18, will appear ask
ing for the name of the range that was selected. 

Define Name 

( OK ) 

( Cancel ) 

Fig. 9-18. The Define Name box. 

Multiplan suggests the name "Butter_Bean." This name is offered because it's 
the text immediately to the left of the first cell of the range. In this instance, 
"Butter_Bean" is a perfect choice. Press the OK button to accept the name. (In 
case you're wondering, if you want a different name, you can simply type it in. As 
you type, the old name will be erased and replaced by the new one.) 

Now, when you want to use the range of cells from R2C2 to R2C5, type 
"Butter_Bean" into the formula and you'll get the proper result. Try it out. Click in 
cell R2C6. Type in the formula 
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= SUM(Butter _Bean) 

and press Enter. Th e answer is the same as before. 
Range names can be used to create formulas, too. Repeat the range naming 

process for each row of beans. When finished , click in cell R8C6. Choose the 
Edit//Paste Function command and click the SUMO option. Type 

Butter_Bean:Lima 

(for " Butter_Bean to Lima" ) and press Enter. Shown in cell R8C6 is the year's total 
sum of all beans. Compare your results w ith Figure 9-19. 
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Fig. 9-19. The finished worksheet. 

Maclip 9-10 

When you c reate a range name, follow these rules: 
The first character in the name must be a letter. 
No spaces are allowed in the name, but any character is 

permitted (you can substitute th e underscore character (_) 
for a space, if you ·like. 

Multiplan doesn' t regard case in range names. "Garbanzo" 
is treated the same as " GARBANZO." 

The name can' t look like a cell or range reference 
(absolute or relative). 

The name can't be more than 31 characters long. (For 
your ease of use, it should be as sho rt as possible.) 

., 
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In addition to selecting ranges (for naming or otherwise) by dragging the 
mouse, you can also select an entire-row or entire-column range by clicking the 
row or column head. 

MacTip 9-11 

You can also establish a group of noncontiguous cells 
(cells that aren't together) as one range by using the mouse 
in combination with the Command key. This is something 
that few other electronic spreadsheet programs can do. 

1. Drag over the first group of cells to be included in the 
range. 

2. Depress the Command key. 

3. Keep the Command key depressed and drag over the 
next group of cells. 

Continue this process until all cell groups are selected for in
clusion in the range. Name the range as usual. 

MULTIPLE WINDOWS
MULTIPLAN'S SPLIT PERSONALITY 

One of the nicest features of Multiplan is that you can simultaneously look at 
several portions of the worksheet, with Multiplan's 2-in-1 and 4-in-1 windowing 
feature. 

As shown in Figure 9-20, you can split the screen to view several parts of the 
worksheet at once. You can split the worksheet at any point horizontally or any 
point vertically. 

The control for splitting the window vertically is found in the leftmost area of 
the horizontal scroll bar. Drag the small black rectangle that's adjacent to the left 
scroll arrow, to pull the vertical split bar into action (see Figure 9-21). Continue 
dragging until the window is split the way you want it. When the worksheet is split 
vertically, you get two horizontal scroll bars. Press the scroll arrows or drag the 
elevators to independently view different parts of the worksheet. 

To split the screen horizontally, drag the horizontal split bar (located above the 
up scroll arrow). This time, you get two vertical scroll bars. As you probably guessed, 
you can use the vertical and horizontal splitters separately or together. 

PRINTING WORKSHEETS 

Once a worksheet is complete, you'll probably want to make a paper copy of 
it. Just as in other programs for the Mac, printing is accomplished by choosing the 
File//Print command. But there's a little more to it than this. 

Choosing the File//Print command prints the active part of the worksheet (the 
active part is the area that includes cell entries). However, there will be times when 
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Fig. 9-20. A four-way split, Multiplan style . 

Fig. 9-21. Dragging the vertical split bar. 

., 

you' ll want to print just a portion of your worksheet. To do this, drag over the cells 
to be printed. If what you want to print extends beyond the screen, keep dragging. 
The window will automatically scroll to keep up with you. 

Choose the Print command from the File menu. Before printing starts, 
Multiplan wi ll present a dialog box. To tell Multiplan to print the highlighted cells 
only, click the Print Selection Only box. 

Multiplan offers several formats for printing worksheets. Before printing, choose 
the Page Setup command from the File menu. Before long, you' ll be greeted by a 
dialog box that offers a variety of valuable printing options (Figure 9-22). 

As with most other Macintosh programs, you can set the page size (usually U.S. 
Letter-8% by 11 inches). You can also set the printing orientation: Tall, for vertical 
orientation, or Wide, for horizontal orientation. 

In addition, you can instruct M ultiplan to leave out the row and column 
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Peper: ®us Letter 0 A4 Letter 

0 US Legal 0 International Fanfold 

Orientation: ®Tell 0 Tell Adjusted 0 Wide 

181 Print Row end Column Numbers 

181 Print 6rtdllnes 

Page Header: 
~========================~ 

Page Footer: '--------------.....J 
Left Margin: !=I 0=. 75===l 

Top Margin: L-It __ __. 

Right Margin: !=I 0.=75=::::::::! 

Bottom Margin: L-lt __ .....J 

Fig. 9-22. The Print dialog box. 

numbers or to print the worksheet without the grid lines. If you like, you can set a 
page header or footer (a header is a line of text that repeats at the top of every page; 
a footer is a line of text that repeats at the bottom of every page). 

MacTip 9-12 

You can select a larger-than-screen area by clicking once 
in the upper left corner of the area you want to select, scroll
ing to the lower right corner, and then holding down the 
Shift key and clicking once more. The cells between the two 
corners will be selected. 

Multiplan allows some flexibility in designing headers and footers. You can 
have Multiplan automatically add the time, date, or page number to the header or 
footer. And you can have Multiplan align the header or footer text to the left, right, 
or center of the page. MacTip 9-13 tells how to enter these formatting codes into a 
header or footer. 

MacTip 9-13 

Multiplan can print one line of text on the top (header) 
or bottom (footer) of every page. To indicate the header, 
click in the header text window and type the text (see Figure 
9-23). To indicate the footer, click in the footer text window, 
and type the text. 

To have Multiplan automatically include the time, date, 
or page number in the header or footer, use one of these 
codes: 

&P Prints the page number. 

&D Prints the date. 

& T Prints the time. 
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Orientation: ®Tall 0 Tall Adjusted OWide 

181 Print How and Column Numbers 

181 Print Gridlines 

Page Header:jThis Is a sample header .. ~ 
Page Footer: 

~--------------------------------
Left Margin: I 0.75 

:====~ 
Top Margin:!~... 1 ___ ___, 

Right Margin: [! 
Bottom Margin: ~ 

Fig. 9-23. Some sample header text. 

Page Header:! &CThis teHt will appear centered on the page 

Page Footer: jToday's time and date Is &T &D &RPage&P 

(A) 

. . . 

6 
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(8) 

Fig. 9-24. Some examples of header and footer formatting: 
(A) as entered. 
(8) as printed. 

To have Multiplan align the header or footer text, use these 
codes: 

&L Aligns the characters that follow to the left 
margin. 

&C Centers the characters that follow. 

&R Aligns the characters that follow to the right 
margin. 
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Multiplan also allows you to set the top, bottom, left, and right printing 
margins. For example, as shown in Figure 9-25, you can set the top margin to 2 
inches, the right and left margins to 1.25 inches, and the bottom margin to .5 inch. 

SAVING WORKSHEETS 

When you have created the worksheet (and printed it, if you like), you'll prob
ably want to save it. 

The File//Save As command saves the worksheet and asks you to name it (as 
with other Macintosh programs, you name the work after creating it). When you 
first save a worksheet, your only available option is File//Save As. Choose File//Save 
As. The Save As dialog box appears, inviting you to provide a name (one such box 
is shown in Figure 9-26). just type in a name and press the Save button when 
you've finished. (Remember to keep the name under 63 characters, and don't use 
colons. And, by the way, that mysterious SYLK button to the right of Normal is used 
for transferring Multiplan data into other Microsoft programs.) 

If you want to save the worksheet on a different disk, click the Eject button first. 
Insert the new disk, and then click Save. 

Once you've given a name to the worksheet, you can resave it using the 
File//Save command. Since you've already provided the name, Multiplan won't ask 
for it again. (As an aside, it's a good idea to use tne File//Save command often; 
otherwise, you stand to lose a lot of work if the Mac should "crash" losing 
everything in its random access memory for one reason or another.) 

Left Margin: 11.25 
~====: 

Top Margin: '-12 ___ __, 

Right Margin: 11.25 
F.==~ 

Bottom Margin: 1~--·~...;....._--~ 

Fig. 9-25. Multiplan gives you full control of page margins through the Print dialog box. 

Saue document as Multiplan ••. 

I Sample workhee~ ( Eject ) 

( Saue ] [ Cancel ) ( Driue ) 
@Normal QSYLK 

Fig. 9-26. The Save dialog box-saving the sample worksheet. 
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MacTip 9-14 

If you want to save another version of the worksheet 
(and keep the original intact), use the File//Save As command 
once again. You' ll be asked to provide a name for the new 
file. 

BACK AT THE DESKTOP 

When you 've finished with Multiplan, choose the File//Quit command . You' ll be 
returned to the desktop. If you haven't saved the worksheet (or if you've changed the 
worksheet since the last save), you' ll be asked if you want to save the changes. Once 
back at the desktop, you' re ready to eject the Multiplan disk and turn the Mac off, or 
to use another program. 

The pages you've read in this chapter have been loaded with information on 
using Microsoft Multiplan. But don' t th ink you've seen it all. W hat else is in store? 
You can learn how to use the other functions in the Edit//Paste Function menu, how 
to protect data from accidental erasure or alteration , how to link several 
worksheets together, how to use the Calculate functions, and how to control the 
way Multiplan calculates numbers. 

If, while using Multiplan, you need more information than this short chapter 
provides, refer to the manual that came with the program. Or check Multiplan's 
built-in " help" feature. You can access the help feature by choosing the * //About 
Multiplan command. 

You can then choose one of several help topics by clicking on it, and then 
pressing the Help button. For example, you could scroll down the "About 
Multiplan" selection window to Printing, click it, and learn more about how to 
print with Multiplan (see Figure 9-27). 

LEAVING MULTIPLAN 

When you've finished with Multiplan, exit the program by choosing the Quit 
command from the File menu. 

About Multiplan Other Functions 
~ Inserting Rows/Columns 

98 Percent Free Names 
0 Per cent In Clipboard Operators 

39842 Bytes MaHimum 
References 

Multiplan Uenlon 1.02 Scrolling ~ 
Apl"ll 27, 1984 

IIIII. ( cancel ) 0 1984 Microsoft Corp. 

Fig. 9-27. Getting help is easy: Choose a topic and click the Help button. 



CHAPTER 10 

The Macintosh Unveiled 

Tt,e Apple Macintosh makes computing so easy that it's .hard to remember that 
behind the cream-colored cabinet is a powerful mix of electronics. To better 
understand how the Mac does its tricks, read this chapter. It's a basic, 
semitechnical introduction to the inside workings of the Macintosh. 

The Macintosh is made of three. distinct pieces, all of which work together. 
There's the keyboard, the mouse, and the main cabinet, which houses the Mac's 
internal disk drive, the video display screen, and all of the computing circuitry. 

MOUSE 

The Macintosh mouse is a relatively simple piece of machinery. It consists of a 
rubber ball mounted in its underbelly, a small but sensitive switch on the top, and 
inside, two rotation sensors. When the mouse is rolled on a desktop, the rubber 
ball rotates. 

The two sensors inside the mouse pick up that movement, and relay 
it-through the mouse's built-in circuitry-to the Mac. The rollers sit 45 degrees 
apart; one picks up horizontal movement; the other picks up vertical movement. 

When the Macintosh is first turned on, the mouse pointer appears in the upper 
left part of the screen; this is the reference point. As shown in Figure 10-1, if you 

233 
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Fig. 10-1. The position of the pointer is determined by horizontal and vertical mouse motion . 

move the mouse, the mouse sends electrical pulses to the Mac that correspond to 
direction and distance from this reference point. The pointer is moved accordingly. 

The one switch on the mouse performs many functions. Depending on how 
you use the switch- press it, click it, double-click it, and so forth -you command 
the Mac to do different things. The Macintosh senses when the switch is being 
pressed, and correlates the pressing w ith the mouse's motion. 

KEYBOARD 

The Macintosh keyboard is little different from the keyboards found on most 
other computers. The one thing that does separate the Mac's keyboard from the 
rest is its low number of keys (it has fewer keys than many home computers, even 
the Apple lie and lie). Most computer keyboards have at least four cursor
positioning keys. The Mac's mouse makes them unnecessary. 

When you press one of the Mac's keys, you engage a small microswitch. The 
keyboard has its own electronics to sense which of the 58 keys was struck, and en
codes this information for use by the Mac. 

The Mac's keyboard has what is called a two-key rollover. That is, it can inter
pret the signals when you have one or two keys depressed, but not three or more. 
This rollover featu re is good for touch typists, who tend to push down on one key 
before completely releasing the previous one. 

There are exceptions to the one-key-at-a-time rule: the Option, Shift, Caps 
Lock, and Command keys. You can press any or all of these while depressing any of 
the other Mac keys. These multiple-key combinations are helpful for giving a com
plex command to the Mac via the keyboard (as an alternative to using the mouse 
and pull-down menus). 
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For example, you can engage the Caps lock key and press the Shift, Com
mand, and number 4 keys together to create a printout of the current screen. 

MAIN CABINET 

The mouse and the keyboard are the Mac's means of communicating with the 
outside world. But, the Mac's main cabinet is where all the exciting work is done. 
The main cabinet is the most complex of the three major components. 

To make it easier to explain, the contents inside the cabinet can be divided up 
into several parts: the digital board, the analog board, the cathode ray tube (CRT, 
or simply, the video tube), and the disk drive. All are shown in Figure 10-2. let's 
take them one at a time. 

Analog Board 

Among other things, the analog board contains the Mac's power supply, which 
converts the standard 11 0 volts AC of your home or office to levels more suitable 
for a computer. Also contained on the analog board is a 1-watt audio amplifier and 
a small, 3-inch speaker (see Figure 10-3). 

Through this amplifier and speaker the Mac can talk to you, play music, pro
vide titillating sound effects, and more. For near concert-hall-quality sound, an ex
ternal speaker can be hooked up to the Mac's amplifier (thus bypassing the small, 
built-in speaker), by way of a mini connector on the back of the computer. 

The other major job performed by the analog board is powering the Mac's 
high-resolution black and white video tube. The images you see on the screen 
aren't created by the analog board, however; that's the job of the digital board, the 
heart of the Macintosh. 

Digital Board 

At center ring on the the digital board, shown in Figure 10-4, is the Mac's 
''brain": the microprocessor that performs all the number crunching and logic 
functions of the computer. The Mac's brain is Motorola MC68000 and is what's 
known as a 16/32 bit microprocessor. It connects to the Mac via 16 "data" lines 
(like water pipelines but for computer data). Inside, it can work with 32 bits- 1 's 
and O's-at a time. 

Most other computers have processors that handle 8 or 16 bits at a time. It 
doesn't take a wizard to realize how much more innate power a Macintosh holds. 

Surrounding the microprocessor is a bank of memory chips, used for tem
porary storage of data while you work with the Mac. This type of temporary 
memory is called RAM (random access memory) and is used by both the Mac and 
you. It can "record data" and "play it back" when it's called for. 

RAM is like a water tank: it can hold only so much data before overflowing. In 
more technical terms, the Mac originally provided 128 kilobytes of RAM, or 
enough to store about 128,000 characters. (Each character is roughly equal to one 
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Fig. 10-2. A Macintosh, with cover removed. Note the bare high-voltage TV tube. If you 
ever manage to get the back cover off (which you shouldn't do, anyway), keep your fingers 
off this tube and the heavy wire. Touching it can result in serious electrical shock, even when 

the Mac is turned off and unplugged. 
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Fig. 10-3. The analog board and its major components. 

byte, which is 8 bits. A byte is a code word composed of ones and zeroes that looks 
something like " 10010110" or "1 0101001.") 

Since more memory allows a computer to run more complex programs, a new 
generation of Macs comes with four times the memory, 512 kilobytes. 

The Macintosh has another type of memory, known as ROM (which stands for 
read only memory). ROM is much like RAM, except that it can only play back 
previously encoded data. New data cannot be stored. 

The ROM inside the Mac is exactly the same type of memory as is found in 
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Fig. 10-4. The digital board and its major components. 

v ideo game cartridges. With those, you plug the cartridge into the game computer, 
and you' re off. A program or a series of programs encoded in the ROM chip inside 
the cartridge guides the game computer along. Similarly, the Mac's ROM contains 
programming instruction that helps the Macintosh operate. In this case, the ROM is 
permanently encased within the Mac. There are no cartridges to pop in and out. 

Attached to the digital board is a series of connectors that enable the Macintosh 
to better communicate with the outside world. You've already been introduced to 
the connector used to hook up the mouse. It' s the one on the far left side (as seen 
with the back of the Mac facing you (see Figure 10-5). It's marked not with a word, 
such as " mouse" or even "digital input device," but simply a small picture of a Mac 
mouse. 
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Fig. 10-5. The connectors on the rear of the Mac-mouse, disk, printer, modem, and sound. 

Next, to the right, is the external disk drive connector. If you purchase a 
second disk drive (to make operation of your Mac quicker and easier) you' ll hook it 
up here. Like the mouse, the drive plug is secured to the Mac by tightening the 
pla~tic thumb screws. No tools are required (see Figure 10-6). The most time you' ll 
spend hooking up the drive is 30 seconds, and most of that is unpacking the drive 
from its shipping box. Unlike most other computers, there are no switches to throw 
or jumpers to cut when adding another drive to the Macintosh. 

Next over is the printer connector, marked by an icon of a piece of paper com 
ing out of a printer. You' ll use this connector when hooking up the Apple Image
writer (or another compatible unit). 

The next connector over, the one marked with the telephone handset, is for 
attaching a telephone modem, a device that makes it possible for your Mac to com
municate with other computers via telephone lines. You might also use this con
nector for hooking several Macs together to form a small network, or even to hook 
up your Mac to another computer. 

Both the printer and modem connectors send and receive data serially, or one 
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Fig. 10-6. To install the second, external disk drive, just plug it in and tighten the thumb screws. 

bit at a time (the other popular type, parallel data transmission, sends eight bits at a 
time). Serial communications tend to be slow, but th e kin d used in the Mac operate 
at transmission speeds of up to 1 million bits per second. Needless to say, that' s 
fast. 

It should be noted that the printer and modem connectors are internally hook
ed up to the same electronics and can often be used interchangeably. 

By the way, besides fitting into its own connector, the mouse will also fit into 
either the printer connector or the modem connector. Though connecting the 
mouse via printer or modem connector won' t hurt anything, the mouse won' t 
work w hen it ' s connected this way. 

O n the far right is the mini-jack for the external speaker. The Mac's own 1-watt 
ampli fier w ill drive j ust about any speaker except the very large ones. When you 
p lug another speaker into the jack, the Mac's internal speaker is disconnected. 

Finally, there's the disk drive. The disk drive is the self-contained mechanism 
that reads programs off disks and records new programs and data on disks. In the 
most basic sense, the Mac's disk drive works much as a standard audio cassette 
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deck does. The main difference is the recording medium: instead of a long string of 
tape, the drive inside the Macintosh uses a flat, circular disk. 

When a disk is inserted into the Mac, a spring-loaded shutter built onto the disk 
opens to reveal the delicate magnetic medium that's within. A record/playback 
head then makes contact with the disk. 

To read or record data, the head moves back and forth across the surface of the 
spinning disk, much the same way as the tone arm of a record player passes from 
the outside edge toward the center of a record, recording information on the tracks 
of the disk (see Figure 1 0-7). 

For more information on the makeup of the Macintosh, see Appendix D, 
"Macintosh Specifications." 

Shutter 

Casing Hub 

Magnetic 
Tracks 

Fig. 10-7. A cutaway view of a 3%-inch microfloppy disk. 



APPENDIX A 

Macintosh Quick Reference Guide 

PARTS OF THE MACINTOSH 

The Macintosh is made up of three discrete major components: the main 
cabinet, the keyboard, and the mouse (Figure A-1). 

The Main Cabinet 
The cabinet houses the video tube for viewing Macintosh images, a 3Y2-inch 

microfloppy disk drive for program loading and data recording, a one watt sound 
amplifier and 3-inch speaker, and all the computing electronics. 

Connectors 

On the rear of the cabinet are several connectors, all marked with icons. From 
left to right (back facing you) the connectors are: 

Connector To connect 

Mouse 
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Clock/Calendar 

Fig. A-1. The main components of the Macintosh. 

Optional external disk drive. 

Compatible printer o r similar output device; 
other expansion devices (check with your 
dealer). 

Telephone modem; other expansion devices 
(check with your dealer). 

External speaker; when an external speaker is 
connected, the Mac's internal speaker is auto
matically disconnected. 

The Macintosh has its own clock calendar, powered by a number 528 (or 
equivalent) battery. The battery compartment is located in the upper right corner of 
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the back cabinet. Replace the battery when the clock/calendar no longer functions. 
Insert the battery as shown on the compartment door, positive ( +) side down. 

The Keyboard 

The keyboard has 58 keys and closely resembles a typewriter keyboard in func
tion and appearance. 

Key Result 

Character Any alphabetic Produces the lowercase character 
keys key 

Shift and any Produces the uppercase character 
alphabetic key 

Any numeral or Produces the character imprinted on 
symbol key the lower half of the key face 

Shift and any Produces the character imprinted on 
numeral or the upper half of the key face 
symbol key 

Option Option Produces the key set shown in 
character Figure A-2 
sets 

Option and Shift Produces the key set shown in 
Figure A-3 

Accents and Option and Produces a grave accent (·) over the 
foreign next character typed 
language 
characters 

Option and e Produces an acute accent (·) over the 
next character typed 

Option and i Produces a circumflex (") over the next 
character typed 

Option and u Produces an umlaut ('·) over the next 
character typed 

Option and n Produces an ti Ide (-) over the next 
character typed 

Other keys Tab Moves the insertion point to the next 
tab stop 

Backspace Deletes the character immediately left 
of the insertion point and closes the 
space; if any text is highlighted, deletes 
all highlighted text 
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Command and 
another key 

Return 

Enter 

Issues an instruction, often as an 
alternative to a menu command 

In word prqcessing, terminates the l ine 
and drops the insertion point to the 
next line down; with dialog or alert 
boxes, confirms the chosen response; 
with some programs, used interchange
ably with the Enter key 

Usually tells the Mac that an entry is 
finished and it's t ime to act on the data 
typed in 

Fig. A-2. Option character set 1 . Fig. A-3. Option character set 2. 

The Mouse 

The mouse is used to move the pointer around the Macintosh screen. The 
movement of the pointer corresponds to the movement of the mouse. 

The button on the top of the mouse is used to signa l the Mac that you want to 
do something. Use combinations of moving the mouse and operating the mouse 
button to issue commands or to control the Macintosh. 

Name O peration Function 

Moving Sliding the mouse around Moves the on -screen pointer 
any flat surface but doesn't invoke any action 

Clicking Tapping lightly on the Usually selects whatever the 
mouse button pointer is resting on 

Double-clicking Tapping lightly on the Usually opens an icon into a 
mouse button twice in window, starts an application, 
rapid succession or highl ights an entire word 

Shift-clicking Tapping lightly on the Tel ls the Mac to select more 
mouse button while hold- than one item at once (Shift-



Pressing 

Dragging 

DISKS 
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i ng down the Shift key 

Depressing the mouse 
button and keeping it 
pressed continuously 

Moving the mouse while 
pressing the mouse button 

click on each item to be 
included in the group.) 

Issues a continuous command 
to the Mac 

Does many things-moves 
icons around the desktop, 
resizes and moves windows, 
chooses a command from a 
pull-down menu, selects large 
portions of text, and more; 
releasing the mouse button tells 
the Mac you've finished 
dragging 

The Macintosh accepts Sony (and compatible) 3¥2-inch microfloppy disks. 

Inserting Disks 

Make sure the label faces up and that the metal end goes in first. Push the disk 
in until the drive captures it. 

Copying Disks 
Making copies of your more important disks and keeping those copies in a safe 

place protects you against the loss of irreplaceable data. But the basic Macintosh 
has only one disk drive, and to make a copy of a disk using a basic Macintosh 
means swapping disks in and out of the drive up to several dozen times. The pro
cedure is time consuming and cumbersome. 

To make it easier for owners of single-drive Macs to make copies of disks, 
Apple provides a utility program called Disk Copy. It comes on the System disk that 
is provided with the Mac, and you can use it to copy a disk in just four disk swaps. 

Using Disk Copy is a snap. Find it on the System disk and double-click its icon. 
You'll see the "About Disk Copy" window, which explains what Disk Copy will do. 
Push the OK button to get the first of several prompts that lead you through the 
copying process. 

Ejecting Disks 
There are three methods for ejecting the disks. The standard software method 

is the safest for protecting against loss of data. 
Standard software method- Return to the desktop, select the icon of the disk 

you want to eject, and choose the File\/Eject command. 
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Shortcut method internal drive- Press the Command, Shift, and number 1 
keys together; (external drive) press Command, Shift, and 2. 

Emergency method-Stick a small, bent-out paper clip into the small hole 
located on the drive. 

Startup Disks 

Startup disks are those that have the Macintosh operating system program on them 
(contained in two files, named Finder and System). Only a Startup disk can be used to 
start the Mac when it is first powered on. The Macintosh will reject all other disks. 

ICONS 

Icons are pictorial representations of disks, computer files and concepts. 
Following is a list of some of the Macintosh icons and their functions. 

Icon 

n 
~ 

mm 
f J ·~ 
·mm· 

Type 

Disk 

Concept 

Computer 
file 

Concept 

Computer 
file 

Computer 
file 

Computer 
file 

Concept 

What it does 

Represents the disk currently in 
the disk drive. 

Provides a means to throw 
unneeded files away. 

Contains a document of some 
type, such as a picture or letter. 

Can contain other icons, even 
more folders. Use folders to 
group like icons together. 

Represents a program. Program 
icons can take many forms. 

Contains a file used by the 
Macintosh. 

Contains one or more fonts for 
use by the Macintosh. This file 
is used by the Font Mover pro
gram, contained on the disk 
named System. 

Indicates that you must wait 
while the computer performs 
internal operations. 
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Icons can appear on the desktop in three ways: 

Form 

CJ 
Standard 

• Dimmed 

lliiiillllllllll 
Shaded 

PRINTING 

Appearance 

Icons without shading represent files and disks 
currently accessible to the Mac. Disk is cur
rently in the drive. 

Dimmed icons represent disks the Mac is keep
ing track of, but that are no longer immediately 
accessible to the Mac. Disk has been removed 
from the drive. 

Shaded icons are opened files. Somewhere on 
the desktop is a window that belongs to that 
icon. 

Printing text and graphics on the lmagewriter is easy. Following is a list of print
ing commands. 

Menu choice 
or command 

File/Print 

Caps Lock
Command-Shift-4 

Command-Shift-4 

Result 

Prints the selected document files; program that created 
the document must be on the disk. 

Prints a "snapshot" of the screen. 

Prints a "snapshot" of the active window. 

DESKTOP MENUS 

The desktop menu bar contains the menus used to command the Macintosh: 
the el, File Edit, View and Special menus. 

The a Menu (Desktop Accessories) 

Menu 
choice 

Scrapbook 

Calculator 

Alarm Clock 

Function 

Permanently holds text or graphics for use in other 
documents; each disk has a Scrapbook. 

Performs as a four-function calculator. 

Displays the time and date; can function as an alarm clock. 
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Note Pad 

Key Caps 

Control Panel 
(see 
Figure A-4) 

Can save up to eight pages of notes; can be accessed without 
closing the file being worked on. 

Shows diagrams of keys to press to get the Mac's special 
characters. 

Allows adjustment of speaker volume, the number of times a 
command entry in a menu blinks before it is executed, rate 
at which key characters repeat when the keys are held down, 
keyboard sensitivity, rate at w hich the insertion point blinks, 
pointer speed relative to mouse movement speed, desktop 
pattern and time allowed between two clicks to be inter
preted as a double click (see Figure A-4). 

Fig. A-4. The Control Panel 

The File Menu 

Menu 
choice 

Open 

Duplicate 

Get Info 

Put Back 

Close 

Close All 

Print 

Eject 

Alternate 
method 

Command-O 

Command-1 

Function 

Opens a disk, trash, or folder icon to a 
window; starts the program represented by 
a program icon; loads the document 
represented by a document icon . 

Makes a copy of the selected icon. 

Displays window with information about 
the selected icon; allows comments to be 
recorded ; allows file to be " locked" 
aga inst erasure. 

Puts selected icons back into the folder or 
d isk from which they most recently came. 

Closes the active window. 

Closes all windows on the desktop. 

(See " Printing," p.249) 

(See " Ejecting Disk," p.247) 



The Edit Menu 

Menu 
choice 

Undo 

Cut 

Show 

Alternate 
method 

Command-Z 

Command-X 
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Function 

Reverses the last command or action. 

Removes the selected te~t and places it in 
the Clipboard. 

Displays a window that shows the top 
three lines of the contents of the Clip
board. 

The View Menu 

Menu 
choice 

By Icon 

By Name 

By Date 

By Size 

By Kind 

Function 

Displays the files in the active window as icons. 

Displays the names of the files alphabetically, with numbers 
(in ascending order) first. 

Displays the names of the files, in order by the date the file 
was last modified. 

Displays the names of the files in order by the size of the file, 
largest first. 

Displays the names of the files, grouped by type, such as 
folder, application, or document. 

The Special Menu 

Menu 
choice 

Clean Up 

Empty Trash 

Erase Disk 

Set Startup 

Function 

Rearranges icons in the active window in a neat and orderly 
way. 

Erases contents of the trash can. 

Erases the selected disk; will not erase Startup disk. 

Sets the selected program to start automatically when the 
disk is inserted. 
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Alert Boxes 

l;,e following listing tells about some of the more cryptic alert boxes and how to 
deal with them. 

"CRASHES" 

~-• Sorrg, • cgatem emar o"urred. 

10.2 

,, 
i

~ 

sarrg ••. A certoua &!Pt•m emar Ilea occurred. 
You meg cllaoae to rectort lila cgalem or ottempl 
to recume tile current eppllcatlan. 

ID • Z 

The Mac has "crashed," or "bombed," as indicated by the picture in the 
upper left corner of the box. A hardware or software fault has interrupted the 
smooth flow of data inside the Macintosh. When a crash occurs, the Mac's memory 
is usually wiped clean, and you'll probably lose the data you've been working with 
(data you have saved onto disk will not be lost). If the Resume button is not dim
med, click it to go back to the application; otherwise, click the Restart button. This 
starts the Mac over again. The ID code that appears in the lower right corner is for 
programmers to use in figuring out what's wrong with a program that crashes. 

253 
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~ this dlst 11 ~~~~nod.tllr. 

D Do 11011 want to tnlllellze It? 

You have inserted a brand-new disk into the drive. The Mac cannot use a new, 
unused disk until it has "initialized" it, so you are given a chance to do so now. 

~ Tills 11 nat a Maclntosl'l dlsle: 

ILJJ Do you wont to lnlllollze It? 

You have inserted a non-Macintosh disk into the drive, and the Mac cannot 
read the data off it. You cannot use a disk from another computer on the Mac; you 
are prompted to Eject the disk or to Initialize it. Initializing erases whatever was 
previously on the disk. 

~ Tills dlst 11 damaged: 

U Da uau want to llllllonze It? 

You have inserted a "damaged" disk into the drive-all or portions of it are 
unreadable. Eject the disk or reinitialize it. 

~ Initialization fallodl 

The initialization process didn't work, either because the disk itself is damaged 
or because there's something wrong with the Mac or its disk drive. Click OK to 
eject the disk, and insert a new disk to start over. 

SOFTWARE PROBLEMS AND LOSSES 

l1iJ 1111 ~etlan cu't lie found to ap•n 
IIIII Item. 

You have tried to open the document of an application program that is neither 
loaded into the Mac nor on the disk currently in the drive. To open the document, 
copy the proper program onto the current disk, or copy the document to the disk 
that contains the program. Alternatively, insert the disk that contains the program, 
start the program, then insert the document disk and open the document from 
within the program. 

1m Tile dlst II damaged and <Gift liD UIDCI. 
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The disk is physically damaged and can't be used. Documents or programs on 
it are permanently lost. 

r:J?' Tbe dlat •sgatam• needa minor 
~ repob'a. Do 11011 want to repair It? Rll 

documonllln folders will mage bact to 
tile dlat window. 

c::!!:J I Cancel I 

llepolr1Ag dill dlst. Ill faldon were 
lost; tlleb' contents INI110 mouod bOCt 
to tt1e dlst window. 

Your Desttap fllo II IIICDASIItent, ID It 
mutt bo recreated. Ill folden will be 
IDit. 

The organization of the Mac's pictorial desktop has been messed up somehow 
and the Mac must reorganize it. In almost all cases, programs and documents will 
survive the reorganization, but folders will be lost. After the reorganization is com
plete, re-create the folders and place the documents and programs back into them. 

file startup Cllst 11 damaged. lfll 
starting again, L'loldlng dawn llle 
Commend oad Opllan tegs. 

Some of the information on the Startup disk governing the Mac's desktop has 
been lost or damaged and the Mac can't be started. In most cases, the disk can be 
recovered by restarting the Mac while holding down the Command and Option 
keys. Keep depressing the keys until the desktop appears in its entirety. 

Tbe mo •tolt" 11 demo~ and can't be 
repaired. Do 11011 wont to remoue It? 

Something has happened to the document or program named in the alert box, 
and the Mac can no longer use it. If you would like to erase the file from the disk, 
click OK. 

The file you're trying to duplicate or to move from one window to another is 
copy protected. 

Tile Clllt tDPU didn't wart. Tfll copytag 
to e dln.nnt c11st. 
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The disk-to-disk copy of files wasn't complete, either because of some software 
error or because the destination disk was damaged or copy protected. Try using 
another disk for the copy. 

Replace Items with the semo nomos 
with tho selected Items? 

You're trying to copy files to another disk, and that disk already has files with 
the same names as the ones you're copying. If you don't want the old files to be 
erased, Select Cancel and rename either the old files or the ones to be copied. 
Then try the copy operation again. 

'11111 Ia 1111 slortap llbt; It cu'l 111 
erased. 

You tried to erase the Startup disk. The Mac must use this disk for its opera
tions, so you can't erase it. 

Cecl't tllnlw eweg thllmete of !be 
atertup diet. 

You have tried to deposit the dimmed image of the Startup disk into the trash 
can (the image is dimmed because the disk has been ejected). The Mac must retain 
information from this disk for its operations, so it won't let you put the icon in the 
trash. 

1'1111 foldor/dlst laloctcd or lleiOAOt to 
o IOcted fald•r. 

The folder or disk is locked, so files contamed in it cannot be deleted. The 
folder/disk must be unlocked before files can be thrown away. Click on OK and 
unlock the disk or folder. 

fhll It- Ia lactod or In al8, Cllld can't 
llenmc~nd. 

You are trying to throw away (1) A file that the Mac is currently using (such as 
the System file or (2) A file that is locked. The file must be unlocked before it can be 
deleted. Click on OK and unlock the file. 

then Isn't 8IIOUih -marg to eject tho 
tlertap disk. Plcese dllpeae of o 
dlllnaed dlst and try egaln. 
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The Mac has run out of memory to keep track of all the disks you have inserted 
during the current session. It must make more room before it can store the 
necessary programs from the Startup disk before ejecting it. Click on OK, and then 
drag one of the dimmed (ejected) disk icons into the trash to make more room in 
memory. 

Tllara kn"t OIICIUIIh memorg to 
nmemiNir tills disk. Its IIMIIO will 
diiiCIIIBir tram lbl desktop. 

The Mac has run out of memory to keep track of all the disks you have inserted 
during the current session and can't retain the image of the disk you're ejecting. 

lllcre Isn't tiiOUI!h memory to wort 
1111111 onotber dlat. 

The Mac has no more memory to work with the disk you've just inserted. To 
get more room, click on OK, dispose of a dimmed disk (if any) by dragging it to the 
trash can, and reinsert the disk you want to use. 

11111 dllt 11 10 fctlllhat lbe folder 
CJ1ange1 coaldn"l 111 recorded. 

Not enough space exists on the disk to record the things you've done with 
folders-such as making new folders or placing files into folders. The contents of 
files on the disk remain unaffected, however. To make more room, click on OK and 
then dispose of something by deleting or copying to another disk. 

The dllt II 10 full IIIII 1111 CIISICIOII 
csn'llle created. 

Not enough space exists on the disk to record the changes you've made to the 
desktop-such as rearranging icons or moving windows. All the windows and 
icons still remain on the disk, however, To make more space on the disk, click OK 
and then dispose of something by deleting or copying to another disk. 

Thi1'1111MI ..ugll ..-oa dllt Ia 

-till·~· 

Not enough space exists on the disk to save the contents of the Clipboard 
(referred to here as "scrap"). To make more room, click on OK and then dispose of 
something. 



APPENDIX c 
Fonts 

THE FONTS THEMSELVES 

The Macintosh is able to display and print text in a variety of typefaces. It 
accomplishes this with the aid of its built-in fonts. There are nine basic fonts, plus 
several more for added flexibility. 

The Mac's fonts are accessible in programs that make use of words-word 
processors such as MacWrite or picture processors such as MacPaint, for 
example. Fonts are selected from menus; special styles can then be specified 
to add emphasis. In addition, all fonts can be displayed and printed in varying 
sizes, expressed in points (72 points is equal to about one inch). In most programs 
-MacWrite, for example-you can choose from 9-, 10-, 12-, 14-, 18-, or 24-point · 
fonts. Some others, MacPaint included, give you even larger sizes: 36-, 48-, and 
72-point. 

Fonts are kept in the System file, along with many other small programs vital to 
the Macintosh. Each font takes up quite a bit of space, which is one reason the 
System file is so large. 

At the end of this appendix you'll find a sampling of the Macintosh fonts in their 
various styles. 
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FONT MOVER 

Font Mover is a special utility program that allows you to transport fonts in and 
out of the System file. Use Font Mover to take unneeded fonts out of the System 
file, thus creating more space on the disk (each font takes a considerable amount of 
space on the disk). Or use Font Mover to transport fonts into the System file or to 
replace previously removed fonts. 

Font Mover is included on the disk named System and on most other Apple
made application programs. To use it for the fonts on the disk it's on, just start it like 
any other program. That is, double-dick its icon. When the window opens, push 
the Help button for instructions and hints on using Font Mover. 
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Macintosh Specifications 

Processor: 
Processor speed: 
User memory: 

Machine memory: 
Disk type: 
Disk capacity: 
Screen: 
Picture Resolution: 

Interfaces: 

Keyboard: 
Mouse: 

Motorola MC68000, 16/32 bit. 
7.8336 MHz. 
128 kilobytes or 512 kilobytes random access 
memory (RAM). 
64 kilobytes read only memory (ROM). 
Sony 3¥2-inch; hard shell; single-sided. 
400 kilobytes per formatted disk. 
9-inch diagonal; monochrome black and white. 
512-pixel (horizontal) by 342-pixel (vertical) bit
mapped display. 
One mouse interface. 

One external disk drive interface. 

Two RS-232C/422A serial ports; up to 0.920 
megabit per second transfer rate. 

One keyboard interface. 
58 keys; full size, full travel; 2-key rollover. 
Mechanical tracking, optical shaft encoding; 90 
pulses per inch resolution. 
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Sound generator: 

Power requirements: 

Cabinet size and weight: 
Keyboard size and weight: 
Mouse size and weight: 
Note: 

Four-voice with 8-bit digital-analog conversion; 
capable of sound effects, music, and voice. 
105 to 125 VAC line voltage; 50 or 60Hz; 60 
watts power consumption. 
13.5 by 9.7 by 10.9 inches; 16.5 lbs. 
2.6 by 13.2 by 5.8 inches; 2.5 lbs. 
1.5 by 2.4 by 4.3 inches; .5 lbs. 
Future generation Macs may come equipped 
with double-sided disk drives (for BOO-kilobyte 
storage capacity). 



Glossary 

Active window An on-screen window that is able to receive user input. Active windows can 
be identified by the presence of a close box and shading in the window's title bar. 

Acoustic-coupled A type of modem that couples to the phone through use of cups that fit 
the mouthpiece and earpiece of the handset; most frequently used for multilane 
telephones or portable use (see modem). 

Alert box A special box displayed by the Mac to warn you of some problem that might result 
from a particular command or action. You'll be asked to confirm that you wish to con
tinue with that command. 

Alphanumeric Information that may consist of letters, numbers, punctuation, other print
able characters, or any combination of the above. 

Application program A piece of software designed to perform a complete and final task, 
such as word processing, accounting, or database management. 

ASCH American Standard Code for Information Interchange. A set of codes that matches 
characters with numbers so they can be universally used by all computers. This means 
that the internal number that tells a Mac to print 11M" will mean the same to an IBM PC or 
another computer. 

Assembly language A computer language with "words" that are very close to the basic 
instructions used by the microprocessor chip. 

Auto.-answer A feature of some modems that allows the modem to answer the telephone 
when it detects that the phone is ringing; used to access an unattended computer from a 
distant location. 

Auto-dial A feature of some modems that allows the modem to electrically "take the phone 
'off the hook" and dial a telephone number. 

265 
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Backup A duplicate of a disk or disk file, which may be used to recover lost data if the original 
is lost or damaged. 

BASIC Basic All-purpose Symbolic Instruction Code. A high-level programming language that 
is easy to learn. At present, BASIC is the most widely taught and used programming 
language for personal computers. 

Baud The number of individual events per second carried by a stream of data. The baud rate 
divided by ten will roughly equal the number of characters per second in the transmission. 
For example, 300 baud equals about 30 characters per second. 

Binary Base-two arithmetic, using 0 and 1 as its only digits. This is the only type of arithmetic 
directly understood by today's digital computers. 

Bit The basic unit of computer binary numbers. Each bit can have only two conditions, known 
as 1 and 0, on and off, or high and low. 

Board A flat piece of nonconductive material, covered with conductive metal strips that con
nect electronic components; a means of mounting and "wiring" such components used in 
computers as well as other electronic equipment. 

B~ot Derived from "pulling one's self up by one's bootstraps." The process of starting or 
restarting a computer's operation, which usually requires that a special operating system 
disk be inserted in the computer's disk drive. Information stored in the computer's RAM is 
usually lost during a boot (see startup disk). 

Buffer A block of memory used for the temporary storage of information. 
Bug A problem caused by an error in the design of a program or in the operation of the 

hardware. 
Bus 1. A series of connections that act as a computer's "spinal cord" connecting its various 

parts and carrying signals vital to its operation. 2. A connector that attaches to the above 
bus, used for system expansion or the connection of peripherals. 

Button 1. The push-button switch located on top of the Mac's mouse. 2. Small graphic 
devices used in dialog and alert boxes. When buttons are pointed at with the mouse and 
"pushed" by clicking the mouse, the action identified by the button's label will be 
performed. 

Byte A group of bits, usually eight, used to represent a more complex piece of information 
(such as a character). 

Card Same as board. Also known as a PC (printed circuit) card. 
Character Any letter, number, punctuation mark, or space. May also describe nonprintable 

"control" characters, such as line feeds and carriage returns for use by printers. 
Click The action of using the mouse to point at a particular location on the screen and then 

quickly pressing and releasing the mouse button. 
Clipboard A place where information that has been cut from a picture or document is tem

porarily stored, so that it can be pasted elsewhere; considered a type of buffer. 
Close 1. To remove a window from the Macintosh desktop by clicking that window's close 

box or choosing the File //Close command. 2. To terminate use of a file, automatically 
returning all information from the computer to the disk and recording any changes that 
have been made. 

Close box A small box located at the upper left corner of almost any open window. When the 
close box is pointed at with the mouse and clicked, the window is removed from the 
screen. 

Command Any user input that instructs the computer to perform a particular action. 
CPU Central processing unit. In microcomputers this usually refers to the microprocessor chip 

that is the heart of the computer; less frequently, the box containing the microprocessor 
and its support circuitry. 

CRT Cathode ray tube. In computer lingo, any television-type display device, such as the 
Mac's built-in display. 

Cursor (see insertion point) 
Cut To remove a section from a document or picture and to store it in the Clipboard. Can be 

used to delete that section or to move it to another location or document. 
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Daisy wheel 1. A type of high-quality printer that uses metal or plastic type mounted 
around the outside of a rotating wheel. 2. The type wheel used in a daisy wheel printer, 
usually replaceable if the type becomes worn or if the type style needs to be changed. 

Data Any type of computer information. 
Database Any collection of information organized in a way to make that information easily 

accessible by computer. 
Database manager A computer program designed to find, sort, modify, delete from, or add 

to the information stored in a database. 
Descenders Characters, displayed on a computer screen or printed on paper, having por

tions that extend below the normal baseline of the text; for example, q y, p, g, and j. 
Desk accessories A series of simple tools, such as the calculator, note pad, and alarm clock, 

that can be used with most Macintosh programs. These tools are always available by 
selecting the pull down menu. 

Desktop The on-screen "work surface" provided by the Mac; may contain numerous win
dows, desk accessories, menus, and so forth, at any given time. 

Dialog box An on-screen box that appears in conjunction with commands that allow the 
user various options; allows you to specify which options you wish to use and to continue 
with the operation. 

Direct-connect A type of modem that plugs directly into the telephone jack, bypassing the 
telephone handset. 

Directory A listing of the files stored on a disk or some portion of it. (see Finder). 
Disk A rotating disk coated with a magnetic material; used to store computer information. 

A "flexible" disk is made of an inexpensive plastic material. A "hard" disk is made of 
metal and is enclosed in a special dust-free housing. The latter is capable of storing larger 
amounts of information on a small space. 

Disk drive The device that reads information from and writes information onto a disk. 
Display 1. The visual output resulting from a program, such as text, numbers, or graphics. 

2. A device used to show the output of a computer on a screen. 
Document 1. In the Mac, any file containing information to be used by a program, such as 

text, pictures, or a database file. 2. A text file for use with a word processing program. 
DOS Disk operating system. The special software, either built into the machine or stored on 

a special Startup disk, that connects you, as well as software, to the computer's hardware. 
The Mac's Finder is part of its DOS. 

Double-dick Rapidly depressing, then releasing, the mouse button twice in rapid succession. 
Dot matrix A type of printer that forms characters and graphics out of a series of small, 

closely spaced dots. The Apple lmagewriter is a dot matrix printer. 
Drag The action of moving the mouse while holding the button down; used to move or 

manipulate objects on the Mac's screen, as when changing the size of a window. 
Eiectronic mail A system that allows messages to be sent electronically over telephone lines 

or a computer network. The message may be delivered electronically or printed at or 
near the recipient's location and delivered by conventional methods. 

Elevator Another term for scroll box (see scroll box). 
Finder The central element of the Mac's operating environment, a program that, among 

other things, displays and organizes files stored on Macintosh disks. 
File Any collection of information stored on a computer disk. 
Firmware Computer programs that are permanently stored in a special ROM chip. This chip 

may be built into a computer or enclosed in a special program cartridge. 
Floppy disk 1. A flexible disk that is 8" in diameter. 2. Any flexible disk. 
Font The particular typeface to be used by the Mac; within a font there are different sizes 

and styles. 
Footer In word processing, a block of text to be printed at the bottom of each page. 
Format 1. The arrangement of text in a printed document, its margins, line spacing, 

paragraph indents, and so forth. 2. The command that prepares a blank disk to receive com
puter information (also called initializing). 3. The structure by which information is organized 
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within a file. 4. The structure by which information is stored on a computer disk. 
Friction feed A printer feature that allows single sheets or roll paper to be fed through the 

printer by a series of rollers, much like those of a conventional typewriter. 
Graphics Nontext, nonnumeric display of information; for example, charts, graphs, 

diagrams, pictures, and drawings. 
Hacker 1. Anyone who is obsessed with or knowledgeable of computers. 2. Anyone who 

attempts to gain unauthorized access to a computer. 
Hard copy A paper copy of information produced by a computer printer or plotter. 
Hard disk (see disk) 
Hardware The solid physical components of a computer, as opposed to software. 
Header In word processing, a block of text to be printed at the top of each page, such as the 

document title or the author's name. 
High-level language A computer programming language in which one high-level command 

can equal hundreds of simple machine-level commands. 
Highlight A reverse image of a command or icon (white on black instead of black on white), 

indicating that the icon has been selected or is active. 
1-beam The appearance of the mouse pointer when the pointer is over an area used for text 

entry. The "1-beam" shapes makes it easy to position the insertion point. 
Icon Literally, an image. On the Mac, a small descriptive picture used to select a program, 

document, or command function. 
fnitialize 1. To open disk files, input user information, select options, and perform other 

functions associated with running the program for the first time. 2. To prepare a new disk 
for use with the Macintosh. 

Input 1. The process of feeding information into the computer. 2. The information that is 
fed into the computer. 

Insertion point The point on the Mac's screen where text will appear when typed; indicated 
on the screen by a flashing bar. 

Interface 1. A port, connection, or device used to tie together different pieces of hardware. 
2. That portion of a program that handles communication between the user and the 
computer. 

1/0 Input/output. The flow of information in and out of the computer. 
Keypad A small keyboard consisting of numbers arranged as on a ten-key pad plus a few 

other commonly used keys. 
Kilobyte (Also "K byte" or "K") In computer terms, 1024 bytes of information; for example, 

a file that is 4K long contains 4096 bytes of information. 
LAN Local area network. Any of a number of systems that allow numerous computers at the 

same location to share information and the use of accessories such as printers and hard 
disks. 

Load The process of transferring information into a computer's memory from another 
source, such as a disk. 

Low-level language A programming language close to the computer's own binary dialect. 
Memory The portion of a computer that stores information. Most commonly RAM or ROM, 

but sometimes other types of storage, such as a disk. 
Menu An on-screen list of options from which the user can make a selection. 
Menu bar The bar located at the top of the Mac screen from which the user can "pull 

down" a number of menus. 
Microfloppy A flexible disk under 4 inches in diameter, such as the one used with the 

Macintosh. 
Microprocessor A computer-on-a-chip, which is the heart of most microcomputers. 

Smaller, less powerful microprocessors are also frequently used to run peripherals and 
perform simple "housekeeping" functions within a computer. 

Minifloppy A flexible disk that is SV.." in diameter. Used on many microcomputers, such as 
the IBM PC. 

Modem Short for MOdulator/DEModulator. A device used to transfer computer information 
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over telephone lines; for example, between a microcomputer and an electronic mail 
service. 

Monitor (see CRT) 
Mouse A computer pointing device consisting of a small handheld box, topped with one or 

more buttons. Sliding the mouse over a flat surface, such as a desk, moves a pointer on 
the computer screen. Items that have been pointed at on the screen can be manipulated 
using the mouse's button(s). 

Network A system that allows communication between a number of computers (see LAN). 
Open 1. To create a window on the Macintosh desktop. 2. To open a disk file so that it can 

be examined, added to, or changed. 
Operating System (see 005) 
Output 1. The flow of information from a computer. 2. The information that results from 
, the operation of the computer. 
Parallel port An interface used to connect different pieces of hardware; uses a number of 

wires to send several bits of information at the same time. 
Pascal A popular programming language for microcomputers. Like BASIC, it is reasonably 

easy to learn, but it is more efficient and makes it easier to avoid programming errors in 
large, complex· programs. 

Paste The act of placing the contents of the Clipboard into a document or picture. 
Peripherals Any external hardware device connected to a computer; for example, a printer, 

plotter, disk drive, or modem. Also commonly called accessories or add-ons. 
Pixel Picture element. The smallest dot that can be displayed on a computer screen. Arrays 

of pixels are used to create character and graphic displays. 
Plotter A hard-copy device that creates text or graphics using one or more electrically 

driven pens. 
Pointer A graphic representation (usually an arrow) on the screen showing the relative 

position of the mouse. 
Port 1. A device or connection used to move information in or out of a computer. 2. The 

act of converting a program designed for one computer to operate on another 
type. 

Press To depress and hold the mouse button without moving the mouse. 
Program A set of instructions that tells a computer how to perform a particular task. Mac

Paint and MacWrite are programs for the Mac. 
Pull-down menu A menu that can be displayed by moving the mouse pointer to a title on 

the menu bar, then pressing the mouse button. Pull-down menus spring closed when the 
mouse button is released. 

RAM Random access memory. A type of memory used for temporary storage and manipula
tion of information. On most computers, including the Macintosh, information stored in 
RAM is lost when the computer is turned off. 

Resolution A measure of the ability of a screen to display text or graphics. For text, resolu
tion is usually measured in columns and rows; for graphics, in pixels across the screen by 
pixels down the screen. 

Ribbon cable A flat cable containing a number of wires side by side. Often used to connect 
computers with peripherals. 

ROM Read only memory. A type of memory that is programmed with information at the fac
tory, and that cannot be erased or changed. The contents of ROM will not be lost when 
the computer is turned off. · 

R5-232 A standard type of serial interface, often used to connect a computer with 
peripherals; can also be used to connect two different computers together. 

R5-422 A recently adopted standard for a very high-speed serial port. The Mac uses this type 
of port to communicate with peripherals. 

Ruler A graphic representation of a ruler that is used in MacWrite to indicate tabs, margins, 
line spacing, and text alignment. 

Save To transfer information from the computer's memory to a disk for storage. 
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Scrapbook A Macintosh desk accessory that stores text and pictures for frequent use in 
documents. 

Scroll To move the contents of a window; a process used to view all of a document or pic
ture that is too large to be displayed all at once. 

Scroll arrow Arrows located at the edges of scroll bars which, when pressed, cause the con
tents of that window to scroll. 

Scroll bar Bars located along the bottom and right edges of most active windows. Scroll 
arrows located in these bars allow the contents of the window to be scrolled vertically or 
horizontally. 

Scroll box A small box located within each scroll bar. The scroll box moves within the bar to 
indicate the window's position within the document. Also called an elevator. 

Select To choose a command, an icon, an action, and so forth. 
Serial port A type of computer interface that transmits data in a continuous stream, one bit 

after another. 
Shift-dick To click the mouse button while depressing the Shift key on the keyboard. 
Size box A small box located at the lower right-hand corner of most active windows. Drag

ging this box with the mouse causes the window to shrink or expand. 
Slot A connector located within the computer and connected to the computer's bus, used 

for inserting boards that expand the capability of the computer. The Macintosh has no 
such slots (see board, bus). 

Software A recorded list of instructions that tells a computer how to perform a particular job. 
Spreadsheet A special program used to store and manipulate rows and columns of 

numbers. Useful for a wide variety of business, financial, and statistical applications. 
Useful in making "what-if" business projections. 

·j'. Startup disk A special disk containing the Finder and other programs used by the Macintosh 
\ for its normal operation. Must be inserted in the computer in order to start, or boot, the 

system. The System disk provided with the Macintosh is a Startup disk; so are most disks 
that contain application programs (see boot). 

Style Describes the style in which a Macintosh font is printed or displayed; for example, 
italic, bold, underline, or shadow. 

Tab well The two boxes in the MacWrite ruler that serve as an endless source for regular 
and decimal tabs. 

Title bar A bar located at the top of the window. The printed title in the bar indicates the 
file, folder, or application that is being displayed in that window. 

Toolbox A set of powerful graphics programs stored inside the Mac. Used by applications 
.J. programmers to simplify making windows, icons, and the other complex screen devices 

that make the Mac so simple for the user. 
Tractor feed A printer option that pulls continuous paper through the printer using pins 

that engage holes on each side of the paper. Also known as pin feed. 
Windows Areas on the Macintosh desktop that display information. More than one window 

r'-. j may be on the desktop at one time, and windows may overlap. 
Write protect To protect a disk so that information on the disk can be loaded and examined, 

but not erased or modified. Can be done within the software or by using a small tab on 
the floppy disk. 
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An (M) after a heading refers to a Mactip. 

Accessories, 6 
Add-ons. 6 

A 

Alarm clock/calendar. 32, 60, 119, 127-13 I 
alarm setting, 127, 131 
beep, 127 
cut and paste (Ml. 131 
daylight savings time, 127 
dragging, 128 
flashing box, 128 
setting, 129-130 
setting shortcuts (M). I 30 

Alert boxes. 253-257, 265 
desktop problems. 255 
disk problems, 254 
disk room, 257 
duplicate names, 256 
locked disk/folder, 256 
memory, 256-257 
program problems, 254 
startup disk problems. 255, 256 
system error, 253 
"Test" tilt• problem, 255 
write protl·ctt:•cl disks. 255 

271 

Analog board, 235 
Apple MacTerminal. 26 
Apple menu, 60 

command summary, 249-250 
desktop accessories, 60 
See also: specific accessories 

Application icon, 67 

B 

Battery compartment, 32 
528 battery, 32 

Beep, 34 
alert boxes. 80 
volume level setting, 140, 141. 142 

Boot. 38, 266 
Byte, 237, 266 

c 
Calculator, 60. I I Y, I 36-138 

clear entry, 138 
close box. 13B 
dragging, 136 
functions, 136- U7 
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keyboard, 1 36 
mouse, 136 
transferring results, 138 

Caps lock key (M). 11 
Chapter summaries, 2-3 
Check-out tests, 40-45 
Clean Up command, 62, 112-1 1 3 
Clipboard, 108- 11 0, 266 

closing, 11 0 
content saving (M), 110 
inter-document transferring, 120 
MacPaint, 164 
storage, 106, 108 
Show Clipboard command, 109 

Clock/Calendar; See: Alarm clock/calendar 
Colon, 69 
Closed folders, 86-87 
Command editing; See: Edit Menu 
Command key, 9, 10-11 

functions, 10 
pull-down menus, 20 

Commands shorthand (M), 21 
Communications, 25-26 
CompuServe, 25 
Computer components, 29-30, 263-264 
Computer size, 13 
Computing power, 25 
Control key, 10 
Control panel, 9, 119, 140-148 

alteration effects (M), 142 
command blinking setting, 144 
functions, 14 I 

Convection cooling, 30-31 
Copy-protected disks; See: Write-protected disks 
Cursor; See: Pointer 

D 

Data management, 27 
data entry template, 27 
searching tasks, 27 

Desktop; See: Electronic desktop 
Desktop accessories, 2, 119-148, 267 

limited windows, 72 
MacPaint, 180 
window opening, 77 
See also: specific accessory 

Digital board, 235-241 
Disk; See: Microdisk 
Disk Copy Utility Program (M), 90 
Disk directory window, 43 

removal, 45 
Disk drives, 6, 240-241, 267 

computer connecting, 239 
dual-drive printout (M). 98-100 
placement, 32 

Disk icon, 40, 66-67 
opening, 14, 41-42,84 

Document icons, 67 
Document naming (M). 19 
DOS, 17, 267 
Drawing, 23-25 

text/picture integration, 25 
·see also: MacPaint 

Duplicate command, 90-92 
disk space, 91 
multiple copying, 92 

E 

Earphones (M). 143 
Edit Menu, 101, 104-110 

block text retrieval (M). I 03 
Clear command, 105, 108 
command summary, 250 
Copy command, 105-106 
Cut command, 105, 107 
diagonal deletion, 104 
functions, 61 
inter-document movement (M), 109 
MacPaint, 160-165 
MacWrite, 188-190 
Paste command, 105, I 06, 108 
Select All Command, 105 
Show Clipboard command; See: Clipboard 
Undo command, 105, 108 

Editing, 100-110 
built-in capabilities, 100 
See also: Edit menu; Keyboard editing 

Electronic desktop, 2, 13, 40, 83, 267 
basic desk composition, 38 
pattern change (M). 14, 146-148 

Empty folder, 68 
Enter key, 9 

functions, 9 
Erase Disk command, 62, I 14-115 

alert box. 114 
Startup disk. 114 
write-protected disk, 114 

Extension cord, 30 

F 

File (M), 66, 267 
disk transferring, 87-90 
disposing, 85, 90 
name changing. 69 

File folder icons. 68 
File menu, 60 

Close command, 60 
command summary, 250 
functions, 60-61 
Get info command or Get Info, 60 
St>e a/so: specific commands 

Finder, 2, 13. 17-19, 97,· 267 
file keeping tasks, 18, 97 



functions, 1 7-19, 83 
housekeeping tasks, 18 
multiple-window capability, 72 
trash emptying, 113 

Font menu, 3, 21, 259-262, 267 
Font Mover, 269 
font style samples, 260-262 
MacWrite, 201-203 

Footers, 197-201, 267 
See also: Headers 

Format menu; See: Multiplan; specific commands 

G 

Goodies menu; 
See: MacPaint, specific commands 

Graphics, 23, 268 
See also: MacPaint 

Graphics tablets (M). 49 
Graphics-intensive computer, 48 

H 

Headers, 197-201, 268 
adding, 200 
cancelling (M). 200 
closing, 200 
dating icon, 199 
Open Header command, 197 
page numbering icon, 198 
ruler, 198 
time icon, 199 
Title Page command, 200 
top margin altering, 199-200 

Icons, 2, 13, 14, 65-72, 268 
body, 68 
By Kind command (M), 112 
copying, 90-92 
dragging over (M), 92 
editing names, 70 
functions, 65 
identifying (M). 69 
keyboard touching (M), 70 
name, 68 
name changing, 69 
opening, 71-72 
reorganizing (M), 117 
shiit-clicking (MJ. 92 
symbol representJtions. 14-1 5. 248-249 
turning black (M). 87 
uses, HJ 
word processing, 21 
St•t• .11.-;o: specific type 

lnformdtion window, 4.i, 92-% 
charJcteristks. 93 
comment box. 43, YS-Y6 
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file saving, 96 
Get Info command, 92-93 
insertion point, 95 
lock box, 95 
purposes, 94-95 
removal, 45 

Insertion point, 43 
blinking setting, 144-145 
See also: Pointer 

K 

Keyboard, 8-11, 234-235, 245-246, 263, 264 
check-out tests, 43-45, 138 
colied cable installation, 33 
colied cord removal (M), 34 
key sensitivity setting, 9, 141, 142-143 
keys, 8, 234, 245 
main cabinet connection, 8 
multiple key combinations, 234 
repeat key rate adjusting, 9, 140, I 44 
special keys, 245-246 
telephone hookup, 8 
two-key rollover, 234 
See also: specific keys 

Keyboard editing, I 00 
backspace key, 101-102 
block text removal, 102-103 
double-click, 1 04 
highlighted characters, 103 

Key caps, 119, 138-139 
close box, 139 
keyboard testing, I 38 
special characters, I 38 

L 

Light, 31-32 
Light pens (M). 49 

M 

Mac Paint, 23, 67, 149- I 83 
A icon, 166-167 
aligning, 169 
brush mirrors, 170,173 
brush mirrors scrolling (M), 174 
Clear command, 161. 164 
constraining, 178 
Copy command, 161, 163-164 
copying shortcuts, 178 
Cut command, 161, 164 
desk top Jccessories, 180 
document storing (M), I 6 I 
double-click shortcuts, 177-178 
dragging, 164 
drawing elimination (M). 176 
drawing saving (M), 180 
easel. 15 I- I 52 

/ 
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Edit Pattern command, 159-160 
editing, 160 
erase techniques (M), 161-162 
eraser, 160, 161-162, 177 
FatBits, 169-170 
Fill command, 161 
Flip Horizontal command, 161. 165 
Flip Vertical command, 161, 164-165 
functions, 23 
Grid command, 169 
hand tool, 173-174, 177, 178 
Introduction command, 152 
Invert command, 161, 164 
lasso, 160, 162-163 
line-width palette, 152 
marquee, 160, 163, 165, 177 
marquee window erasing (M), 178 
mechanical drawings (M), 158 
mouse, 152 
multiple copying, 178-180 
opening, 150 
opening existing file (M), ISO 
opening new file (M), ISO 
paint brush, 154-155, 177, 178 
paint bucket, 154, 155-156 
Paste command, 161, 164 
patterns palette, 152, 159-160, 177 
pencil, 154, 155, 177 
picture movement, 173-176 
Plain command, 167 
Print Catalog command, 181 
Print Draft command, 181 
Print Final command, 181 
Quit command, 181 
Rotate command, 161, 165 
Save As command, 181 
Save command, 180-181 
scrapbook, 180 
shape manuevering (M), 159 
shapes, I 58, 178 
Shortcuts command, I 77 
Show Page command, 173, 174-176, 178 
shrinking (M), 163, 180 
spray can, 154, 156 
starting, ISO 
straight-line ruler, 154, 156 
stretching (Ml. 163. 180 
textures, 159 
tools; See: specific tool name 
Trace Edge command, 161, 164 
typeface fonts, 167 
Undo command, 160 
word wrap (M), 167 

MacTips, 2 
MacWrite, 67, 185-208 

alarm clock access, 128 
blank line (Ml. 188 
changing text, 188 
Copy command. 189. 190 

Cut command, 189, 190 
deleting text, 189 
editing, 188-190 
fonts, 201-203 
headers; See: Headers 
highlighting text, 189 
insertion point, 187, 188 
opening, 186-187 
opening existing file (M), 187 
opening new file (M), 187 
Paste command, 189, 190 
Print command, 207-208 
Print Setup command, 206-207 
printout, 98-100 
Quit command, 208 
reformating, 189 
ruler; See: Ruler 
Save As command, 205-206 
Save command, 205 
saving text tip (M), 206 
scrolling, 188 
search; See: Search menu 
Show Clipboard command, 190 
starting, 186-188 
Style menu, 201-203 
text restyling (M), 203 
text selecting (M), 190 
text size, 201 
Undo command, 190 
windowful scrolling (M), 189 
word wrap, 188 
writing pad, 187 

Magnetic disks; See: Microdisks 
Main cabinet, 5-6, 235-241. 243-245, 264 

accessory connectors, 5, 243-244 
clock/calendar, 244-245 
computing electronics, 5 
disk drive, 6 
video display tube, 6 

Menu; See: Pull-down menu 
Menu bar, 20, 57-60, 268 

bold items, 60 
dimmed items, 60 

Microdisk, 6-7, 241, 247-248, 263, 267, 268 
content interchange (M), 7 
copying, 247 
description, 6 
dual-drive transferring, 89-90 
ejecting, 11, 45, 247-248 
entire disk copying (M), 90 
entire disk locking (M). 96 
erasing; See: Erase Disk command 
handling, 7 
inserting, 36, 247 
MAC operating system, 38 
name changing, 69 
non-MAC operating system (M), 39 
removal problems (M). 46 
single-drive transiNring, 88-89 



size, 6 
Microprocessor, 235, 2b3, 268 
Microsoft's Chart, 23 
Microsoft's Multiplan; See: Multiplan 
Modem, 239, 265 

Mouse, 2, 11-13, 47-63, 233-234, 246-247, 
263, 264, 269 

button, 11, 233, 266 
cable installation, II, 32, 238 
care, 49 
check-out tests, 40-43 
cleaning (M), 49-50 
clicking, 47, 51, 52-53, 246, 266 
complaints, 13 
cursor movement, 11 
double-clicking, 47, 51, 53-54, 246, 267 
double-clicking speed change (M), 54, 

145-146 
dragging, 47, 51, 54-56, 257, 267 
handling, 49 
keyboard/mouse system, 13 
menu bar, 57-60 
moving, 47, 51-52, 246 
picture creating, 48 
placement, 32-33 
plastic mouse pad (M). 3 I 
pointer operations, 48 
pressing, 47, 51, 56, 247, 269 
pull-down menu, 20 
reference point, 223 
rolling space, 30, 40 
rolling surface, 30, 49 
rubber ball, 11, 233 
scroll bars, 74 
sensors, 1 I, 233 
shift-clicking, 246, 270 
switch; Set..•: button 
tracking setting, 144 
uses, 12, 47-49 
window moving, 48 
word processing, 21 

Multiplan, 25, 209-232 
About Multiplan command, 232 
absolute cell address. 21 b 
alarm clock access, 128 
aligning procedures, 223 
arithmetic operation entering (M), 21 b 
average function, 217 
Bar Graph command, 223 
built-in functions, 217-218 
cell addresses, 210 
cell content copying (M). 217 
cells, 210-211 
character-by-character editing, 220 
charactt•r capacity, 223 
column coor<linates, 210 
column deleting. 221 

column heads, 220 
column inserting, 220-221 
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Column Width command, 223-224 
Commas command, 223 
current cell, 211 
Decimal command, 223 
deleting cells, 213 
Dollar command, 222 
double quotes (M), 215 
editing, 218-220 
editing mistakes correcting (M). 220 
footers, 229-231 
brmatting commands; See: specific command 
formula bar, 211 
formula copying, 217 
formula entering, 215 
General command, 222 
headers (M). 229-231 
larger-than-screen selecting (M), 229 
mistake correcting (M), 214 
multiple entries (M). 214 
multi-version saving (M). 232 
New command. 21 2 
No Decimal command, 223 
noncontiguous cell range (M). 227 
number editing, 219 
number entering, 215 
Number of Decimals command, 223 
number recognition (M). 215 
opening, 210 
Page Setup command, 228 
Percent command, 223 
Print command. 227 
Print Selection Only box, 228 
Quit command, 232 
range, 224-227 
range formula creating, 226 
range naming, 225 
range naming tips (M). 226 
relative cell address. 215-216 
row coordinates, 2 I 0 
row deleting (M). 221 
row heads, 220 
row inserting. 220-221 
sample worksheet. 212 
Save As command, 231 
Save command, 231 
Scientific command, 223 
scrolling (M). 211 
selection cells, 213 
standard width (M). 225 
starting, 210 
stop sign (M), 214, 220 
SUM function, 218 
SYLK button, 231 
text entering, 21 S 
window splitting. 227 
worksheet. 210-211 
workshet.•t creation, 2 12-2 IS 
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N 

Names (M), 70 
Notepad, 60, 119, 131-135 

advancing, 131-132 
disk differentiation (M). 133 
editing, 132-135 
font transferring (M), 135 
obtaining, 131 
reversing, 132 
text transferring, 134-135 

Numeric keypad (Ml. 9, 268 

0 

Operating system, 17 
Option key, 9, 10 

functions, 10 
Option/Shift keys, 1 0 
special characters, 10 

Overheating, 31 

p 

Parallel data transmission, 240 
Period, 69 
Peripherals, 6, 269 
PFS:File, 27 
Pointer, 11, 12, 40, 268, 269 

arrow, 12 
1-beam, 43, 268 
plus sign, 211 
See also: Insertion point 

Power, 33, 45-46, 264 
Power cord, 30 

computer installation, 32, 33 
plugging in, 30 
unswitched outlet (M), 35 

Print command, 96, 98-100 
Printer, 249 

computer connecting, 239 
Program icon, 67 
Programer's Switch, 37 
Programs, 2, 265, 2b9 

disk drive placement, 72 
double-clicking, 71 
Finder, 18 
program sharing (M), 67 
See also: spedlic program 

Pull-down menus, 13, I 9·21, 268, 269 
Command Key usage, 20 
how-to-use, 58 
menu bar; See: Menu bar 
mouse, 20 
release (Ml. bO 
view contents (M), bO 
word processing, 2 I 
Set• also: specific menu 

Put Back command, 96, 97 
icon trash retrieval (M), Y7 

write-protected icon (M). 91 
Puzzle, 148 

R 

RAM, 235-237, 263, 269 
Return key, 9 

function, 9 
ROM, 237-238, 263, 269 
Rulers, 187, 191·197, 269 

copying, 195 
decimal align tabs, 192 
deleting (M). 195 
Hide Rulers command, 197 
indentation marker, 192 
Insert Ruler command, 195 
justification, 195 
margin markers, 191 
multiple rulers, 195-197 
outdenting, 192 
page format, 191 
space boxes, 192 
tab deleting (M), 192 
tab stops, 191 
text aligning, 192 

s 
Scrapbook, 60, 120-127. 269 

advancing, I 24 
Clear command (M), 127 
close box, 122, 127 
copying, 127 
Cut commands (M), 127 
disk differentiation (M), I 22 
dragging, 121 
elevator. I 23 
how-to-use, 124-125 
inter-document transferring, 120· I 21 
item count indicator, I '2.2 
item placement (M), 125 
item type indicator, 123 
material retention, I 21 
obtaining, 121 
"Scrapbook Empty", I 22 
scrolling, 123 
"This Space for Rent," 122 
window adjustment, 121 

Screen, 2b3 
Scrolling, 74-7b, 2b9 

elevator, 75-76, 267 
mouse usage, 74 
scroll bars. 74, 270 
shaded scroll bars, 74 
windowiul scrolling (M), 7b 

Search menu, 203·205 
case sensitive (M). 205 
Changt• wmmand, 204-205 
Find command, 204 



Select All command (M), 92 
Serial communications, 239-240 
Set Startup command, 62, 11 5-117 

cancel setting (M), 117 
startup application (M), 117 

Shift key, 10 
Caps Lock key (M), 11 
functions, 10, 11 

Shortcuts, 60 
Software; See: Programs 
Speaker, 235, 240, 264 
Special characters, 10 

Key caps, 1 38-1 39 
Special menu, 112-117 

command summary, 251 
See also: specific commands 

Spread sheets, 25, 270 
See also: Multiplan 

Startup disk (M). 89, 248, 270 
Startup problems, 34-36 
Style menu, 167-169 

MacWrite, 201-203 
Sunlight, 31-32 
Symbols; See: Icons 
System disk, 38, 83 

icons, 43 
System file icon, 68 

Telephone lines, 8, 33 
Touch screens, 48-49 
Trash icon, 40, 65, 68 

closing 

T 

Empty Trash command, 62, 113 
file removal, 85 
opening, 84 

Type styles; See: Font menu 

u 
Unpacking, 29-32 

object clearance space, 31 
v 

View menu, 110-112 
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active window use, 112 
By Date command, 110, 111 
By Icon command, 110 
By Kind command, 110, 112 
By Name command, 110 
By Size command, 110, 111 
changing icons, 69 
command summary, 251 
functions, 61-62 

w 
Windows, 2, 13, 15-17, 72-81, 270 

active, 77-79, 265 
alert box, 72, 79-80 
close box, 77 
closing, 77 
dialog box, 72, 79, 80-81 
Close All command, 79 
dormant, 78-79 
dormant window movement (M), 79 
dual frame viewing, 16 
full-featured, 72-73 
limited, 72 
moving, 72-74 
number limit (M), 17 
Open command, 77 
outlined option, 80, 81 
resizing, 74 
Scrolling; See: Scrolling 
size and placement remembrance (M), 74 
size box, 74, 270 
stack repositioning (M), 79 
stacking, 79 

Word processing, 21-23 
icon usage, 21 
mouse usage, 21 
paragraph adjustment, 21 
print styles, 21 
pull-down menus usage, 21 
word wrap, 102 
SeC' a/so: MacWrite 

Write protected disks (M), Y I, 270 
file locking .(M), 96 
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